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СПИСОК СОКРАЩЕНИЙ 

3D – трехмерный 

SMD (Surface Mounted Device) – прибор, монтируемый на поверхность 

ВАХ – вольт-амперная характеристика 

ДЭП – дополнительный этап проектирования 

ЕСКД – единая система конструкторской документации 

КД – конструкторский документ 

КП – контактная площадка 

ЛКМ – левая кнопка мыши 

ОПП – односторонняя печатная плата 

ОС – операционная система 

ОЭП – основной этап проектирования 

ПИ – панель инструментов 

ПК – персональный компьютер 

ПКМ – правая кнопка мыши 

ПП – плата печатная 

ПЭ3 – перечень элементов к схеме Э3 

ТТ – технические требования 

УГО – условное графическое обозначение 

ЧПУ – числовое программное управление 

Э3 – схема электрическая принципиальная 
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1. ВВЕДЕНИЕ В ПРОЕКТИРОВАНИЕ 

1.1. Цели и задачи проектирования 

Основное назначение проектирования – получение практических навы-

ков по работе со следующим оборудованием: 

– со станком с ЧПУ для изготовления ОПП; 

– с паяльной станцией для лужения ОПП и монтажа как SMD, так и вы-

водных компонентов; 

– с мультиметром в режимах измерения токов, напряжений, сопротивле-

ний, прозвонки цепей и проверки диодов; 

– с цифровым осциллографом для наблюдения форм сигналов на кол-

лекторах транзисторов. 

Однако переход к использованию указанного оборудования невозможен 

без предварительного продумывания внешнего вида изделия и особенностей 

его функционирования, выбора и закупки необходимой комплектации, раз-

работки схемы Э3, создания файла трассировки ПП и подготовки необходи-

мых файлов для начала изготовления. 

Результатом проделанных действий будет полноценно функционирую-

щий экземпляр изделия. 

1.2. Варианты начала проектирования 

Разработка изделия по данному пособию может начаться по одному из 

следующих вариантов, выбираемых в основном в зависимости от доступного 

времени в семестре: 

1. Количество учебных недель в семестре не менее 9. 

Сначала выполняется не менее девяти первых ОЭП из [1]. По результату 

этой работы принимаются индивидуальные решения о готовности каждого 

студента к данной разработке, при этом должны быть выполнены следующие 

условия: 

– желание начать новую разработку во второй половине семестра в до-

статочно короткие сроки, но с получением опытного образца; 

– не менее четырех недель семестра, оставшихся до зачетной недели; 

– завершенный ОЭП № 9 (или № 12 на усмотрение преподавателя); 

– минимальный набранный балл после выполнения ОЭП № 9 – 1,8 (или 

2,4 после выполнения ОЭП № 12). Допускается выполнение ДЭП из [1] для 

повышения балла. 
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2. Количество учебных недель в семестре менее 9 или независимое вы-

полнение проектирования. 

В этом случае с первой недели семестра разработка начинается сразу по 

данному пособию. 

1.3. Организационные требования 

От студентов требуется сконцентрированность на выполняемых дей-

ствиях, их понимание (например, подготовка программы для фрезеровки) и 

погружение в проектирование, а при работе с оборудованием – еще и беспре-

кословное соблюдение техники безопасности и указаний преподавателя.  

Нарушение указанных требований (в том числе любой факт заимствова-

ния чужих результатов) приведет к завершению данной разработки с начис-

лением штрафных баллов и возвращению к проектированию по [1]. 

1.4. Принцип работы изделия 

Результатом проектирования является изделие на ОПП, в состав которо-

го входят следующие функциональные части: 

– транзисторный мультивибратор (генерация периодических сигналов); 

– светодиоды (индикация); 

– элемент питания (автономная работа). 

Принцип работы устройства состоит в том, что после установки бата-

рейки мультивибратор начинает генерировать противофазные сигналы пря-

моугольной формы, которыми управляются группы светодиодов: при нуле-

вом импульсе светятся светодиоды соответствующей группы. 
Рис. 1.1 

   
Рис. 1.1 
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Внешний вид варианта изделия в момент нулевого импульса у одного из 

сигналов показан на рис. 1.1. 

Примеры студенческих работ приведены в прил. И. 

1.5. Требования к изделию 

Основные требования, предъявляемые к изделию: 

– материал ПП – односторонний стеклотекстолит FR4 (общая толщина – 

1 или 1,5 мм, фольга – 18 или 35 мкм); 

– сложный внешний контур с габаритными размерами до 100 × 100 мм; 

– наличие трех указанных в 1.4 функциональных частей; 

– количество секций мультивибратора может быть увеличено по согла-

сованию с преподавателем; 

– количество светодиодов – не более 21 шт.; 

– допускается часть светодиодов не подключать к мультивибратору; 

– допускается использование отдельных самостоятельно мигающих све-

тодиодов (частота около 1,5 Гц) по согласованию с преподавателем; 

– конденсаторы, резисторы, светодиоды и транзисторы должны быть в 

SMD-исполнении; 

– типоразмеры светодиодов, резисторов, конденсаторов – 0603 или 0805; 

– стоимость комплектации – не более 700 руб. 

Материал и комплектация могут быть скорректированы преподавателем 

с учетом текущих проектов всех студентов. 

Ограничение на количество светодиодов в основном связано с времен-

ными затратами на монтаж, так как без учета перемычек количество точек 

пайки для обычного мультивибратора и разъема элемента питания составляет 

16 шт., а для такого числа светодиодов с токоограничивающими резистора-

ми – 84 шт. Также с увеличением числа потребителей уменьшается время ра-

боты изделия от одной батарейки. 

1.6. Последовательность проектирования 

Проектирование осуществляется в порядке следования разделов посо-

бия, каждый из которых содержит информацию по решению определенной 

задачи или группы задач (этап проектирования). 

Перечень всех этапов проектирования с краткими пояснениями и начис-

ляемыми баллами за их выполнение приведен в табл. 1.1 (максимальный 

суммарный балл за них составляет 3,0). 
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Таблица 1.1 

№ Этап Описание Балл 

1 Введение в 

проектирование 

Ознакомление с целями, задачами и процессом проектиро-

вания, а также получение общего представления о разраба-

тываемом изделии и предъявляемых к нему требованиям 

– 

2 Внешний контур и 

цветовая схема 

Создание внешнего контура ПП, а также продумывание 

количества светодиодов, их цвета свечения, простран-

ственного расположения и алгоритма работы 

0,2 

3 Транзисторный 

мультивибратор 

Изучение принципа работы мультивибратора на npn-

транзисторах 

0,1 

4 Комплектация Расчет номиналов резисторов и конденсаторов, а также 

поиск и выбор всех необходимых компонентов в продаже 

0,3 

5 Документация Создание соответствующих КД 0,4 

6 Печатная плата Компоновка и трассировка ПП 0,4 

7 Контуры Создание DXF-файла с контурами, необходимыми для из-

готовления ПП на фрезерном станке 

0,1 

8 Программа для 

фрезеровки 

Подготовка программы для изготовления ПП на станке с 

ЧПУ 

0,2 

9 Изготовление 

печатной платы 

Фрезеровка заготовки из одностороннего фольгированного 

стеклотекстолита.  

Продолжительность выполнения – не менее 1,5 ч 

0,3 

10 Монтаж 

компонентов 

Монтаж компонентов и необходимых перемычек на ПП в 

соответствии со схемой Э3. 

Продолжительность выполнения – не менее 6 ч 

0,8 

11 Включение изделия Проверка работоспособности изделия и устранение неис-

правностей (при наличии).  

Продолжительность выполнения – не менее 0,5 ч 

0,2 

Необходимо обратить внимание на два момента: 

– на получение компонентов после этапа № 4 требуется время до двух-

трех недель (в особенности при заказе из Китая), поэтому со списком необ-

ходимой комплектации следует определиться как можно раньше; 

– этапы № 9–11 выполняются с использованием оборудования, указан-

ного в 1.1, поэтому на них должно быть оставлено время не менее одной не-

дели. Кроме того, данные этапы требуют предварительной подготовки, ин-

формация о которой содержится в разделах «Подготовка к этапу», располо-

женных в конце соответствующих разделов. 

Кроме указанных 11 этапов предусмотрено 9 дополнительных заданий 

из прил. И, информация по которым представлена в табл. 1.2 (максимальный 

суммарный балл за них составляет 2,0). Каждое задание становится доступ-

ным к выполнению после завершения определенных этапов проектирования, 

о чем будет указано в тексте соответствующих разделов. 
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Таблица 1.2 

№ Задание Описание Балл 

1 Моделирование 

мультивибратора 

Моделирование работы светодиода и схемы транзисторно-

го мультивибратора в специализированной программе 

0,5 

2 Библиотека 

компонентов 

Дополнение исходной библиотеки в виде базы данных вы-

бранными компонентами 

0,1 

3 Обозначение 

изделия 

Выбор классификационной характеристики изделия по 

классификатору ЕСКД и составление его обозначения 

0,1 

4 3D-модель изделия Создание 3D-модели изделия и расчет его массы 0,1 

5 3D-pdf изделия Создание 3D-pdf изделия 0,1 

6 G-код Изучение общего вида G-кода (управление станком с ЧПУ) 

и некоторых используемых в нем команд  

0,1 

7 Чертеж печатной 

платы 

Создание чертежа разработанной ПП 0,4 

8 Спецификация Создание спецификации на изделие 0,2 

9 Сборочный чертеж Создание сборочного чертежа на изделие 0,4 

Дополнительные задания не являются обязательными при предвари-

тельном выполнении ОЭП из [1] (см. 1.2) и в этом случае могут использо-

ваться, например, для повышения общего балла. 

1.7. Программное обеспечение 

При проектировании предполагается использование следующего про-

граммного обеспечения: 

– Altium Designer – создание схемы Э3 и файла трассировки ПП; 

– G-Code Ripper – создание управляющей программы для сканирования 

поверхности и корректировки G-кода; 

– Mach3 – управление станком с ЧПУ (на рабочем месте); 

– Microsoft Access – корректировка базы данных для изменения библио-

теки (дополнительное задание № 2); 

– Microsoft Word – оформление отчета, создание перечня ПЭ3 и специ-

фикации изделия (дополнительное задание № 8); 

– Multisim – моделирование работы светодиода и схемы транзисторного 

мультивибратора (дополнительное задание № 1); 

– VisualCADCAM – создание управляющих программ для фрезеровки; 

– КОМПАС-3D – подготовка контуров для последующего создания 

управляющей программы, разработка чертежа ПП (дополнительное задание 

№ 7) и сборочного чертежа изделия (дополнительное задание № 9), получе-

ние модели изделия (дополнительное задание № 4). 
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1.8. Требования к отчету 

В процессе проектирования требуется кратко описывать полученные ре-

зультаты и заносить их в один общий отчет, который сдается на проверку в 

конце семестра. В случае независимого выполнения проектирования на про-

межуточный контроль также передаются полные результаты первых четырех 

этапов. Все сроки сдачи назначаются преподавателем. 

Требования к содержанию каждого этапа проектирования и дополни-

тельных заданий, доступных с соответствующих этапов, находятся в подраз-

делах «Результаты выполнения этапа» в конце каждого раздела. 

Общие требования к форме отчета: 

1. Соответствие требованиям оформления университета: 

– оформление разделов, подразделов и пунктов; 

– оформление основного текста (шрифт, его размер, межстрочный ин-

тервал, отступ в начале абзаца, размеры полей); 

– оформление ссылок на использованные источники и их списка; 

– оформление рисунков, таблиц и формул; 

– наличие нумерации страниц; 

– наличие титульного листа; 

– наличие раздела «Содержание», при этом разделы «Задание», «Анно-

тация», «Введение», «Заключение» могут отсутствовать. 

2. Соблюдение правил русской орфографии и пунктуации. 

3. Отчет передается на проверку и контроль только в формате PDF. 

4. КД оформляются отдельными файлами в формате PDF и объединяют-

ся с отчетом в одном архиве. 

5. Название файла отчета и архива должно быть построено по следую-

щей схеме: аббревиатура «ИДРЭС», дефис, номер группы, дефис, аббревиа-

тура «ТМ», дефис, фамилия студента, дефис, слово «Отчет». 

Например: ИДРЭС-0181-ТМ-Иванов-Отчет. 

1.9. Результаты выполнения этапа 

Результат этапа № 1 – ознакомление с информацией о процессе проек-

тирования и требованиями к разрабатываемому изделию. 

В отчете необходимо привести: 

1. Задачу проектирования. 

2. Принцип работы изделия. 

3. Требования к изделию. 
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2. ВНЕШНИЙ КОНТУР И ЦВЕТОВАЯ СХЕМА 

2.1. Общие замечания 

На данном этапе необходимо нарисовать внешний контур ПП и проду-

мать расположение светодиодов и их функционирование.  

Общие замечания: 

1. Минимальная ширина узких частей в контуре ПП, по которым будут 

проходить печатные проводники до светодиодов, должна обеспечивать про-

кладывание по ним дорожек шириной 0,25–0,3 мм с зазором 0,55 мм. 

На рис. 2.1 приведен фрагмент одной из выступающих частей контура 

ПП (луча) с четырьмя посадочными местами: вертикальные – для светодио-

дов, горизонтальное – для токоограничивающих резисторов. Для подключе-

ния светодиода требуется две дорожки. Каждый дополнительный светодиод, 

подключенный к общему сигналу (нижние КП светодиодов соединены с кол-

лектором одного транзистора) или одной линии питания, добавляет еще один 

печатный проводник. Поэтому в данном примере в самом широком месте на 

луче получилось три дорожки (и два зазора между ними). 
Рис. 2.1 

 
Рис. 2.1 

Зазор 0,55 мм в основном обусловлен диаметром рашпильной фрезы, ко-

торая есть в наличии (рис. 2.2). 
Рис. 2.2 

 
Рис. 2.2 

2. Ширину зазоров во внешнем контуре ПП желательно сделать не ме-

нее 1 мм для использования соответствующей фрезы. 

3. Должны быть оставлены места для размещения не только компонен-

тов SMD, но и посадочных мест под них. Габаритные размеры некоторых 

корпусов приведены в [1, табл. В.1, с. 699]. 
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4. Должно быть оставлено достаточно большое место для размещения 

батарейного отсека для батарейки CR2032 (у отсека с рис. 1.1 диаметр со-

ставляет 22,1 мм, а длина с выступом для защелки – 24,3 мм). 

В изделии можно предусмотреть движковый переключатель для управ-

ления подачей питания (например, как на рис. 2.3). Тогда необходимо допол-

нительно зарезервировать прямоугольную область примерно 9 × 5 мм. 
Рис. 2.3 

 
Рис. 2.3 

5. В соответствии с 1.5 не все светодиоды могут быть подключены к 

мультивибратору: часть может светиться постоянно или мигать независимо 

(мигающие светодиоды). 

6. Внешний контур ПП в КОМПАС-3D должен быть создан в документе 

Фрагмент с форматом FRW (команда Файл ⇒ Создать ⇒ Фрагмент) с 

началом координат в его центре, а затем сконвертирован в формат DXF. 

Перед экспортом в формат DXF необходимо обратить внимание на сле-

дующее: 

– слою с контуром необходимо присвоить имя «Board». Сделать это 

можно в окне Менеджер документа (пиктограмма Управление слоями на 

ПИ Текущее состояние – см. [1, рис. 6.8, с. 177]); 

– должна быть выполнена проверка на отсутствие наложений и замкну-

тость по [1, пп. 8.1 и 8.2, с. 184]; 

– экспорт выполняется командой Файл ⇒ Сохранить как (тип файла – 

AutoCAD DXF; параметры: версия формата – AutoCAD 2000). 

2.2. Основные команды для рисования в КОМПАС-3D 

Основные команды для рисования находятся на ПИ Геометрия (см. [1, 

рис. 6.11, с. 179]): вспомогательная прямая, отрезок, окружность, дуга скруг-

ление, фаска, прямоугольник (многоугольник). 

Для создания плавного контура следует использовать команду Сплайн 

по точкам (см. [1, рис. 7.15, с. 211]). В режиме редактирования можно ме-
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нять положения вершин сплайна, длины и углы наклона векторов производ-

ной (рис. 2.4). Однако при изменении положения характерных точек вне ре-

жима редактирования все настройки сбрасываются.  
Рис. 2.4 

 
Рис. 2.4 

Основные команды для редактирования находятся на ПИ Редактирова-

ние (см. [1, рис. 6.20, с. 183]): сдвиг, поворот, масштабирование, симметрия, 

усечь кривую и удлинить до ближайшего объекта. 
Рис. 2.5 

 
Рис. 2.5 

Отдельно на этой ПИ следует выделить команду Копия по окружности 

из группы Копия указанием (команда группы по умолчанию). На рис. 2.5 

показан результат ее работы (запускается после выделения требуемых объек-

тов) по созданию семи копий двух зеленых отрезков с включенным режимом 

Вдоль всей окружности. 

2.3. Способы создания внешнего контура ПП 

Внешний контур ПП можно получить несколькими способами: 

1. Придумать и нарисовать самостоятельно. 

2. Обрисовать рисунок, найденный в сети Интернет. 
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Добавление рисунка в КОМПАС-3D выполняется командой Вставка ⇒ 

Рисунок, а способы изменения его размеров описаны в [1, примеч. к п. 33, 

с. 469].  

Чтобы изображение не попадало под выделение при обрисовке, необхо-

димо перенести его на другой слой с включенной блокировкой:  

– нажать пиктограмму Управление слоями на ПИ Текущее состояние 

(см. [1, рис. 6.8, с. 177]); 

– в появившемся окне нажать пиктограмму Создать слой, на строке с 

новым слоем выполнить команду ПКМ ⇒ Фоновый (или нажать на пикто-

грамму замка) и применить изменения; 

– в рабочем поле выделить изображение и выполнить на нем команду 

ПКМ ⇒ Изменить слой. В появившемся окне выбрать созданный фоновый 

слой и применить изменения. 

Быстрое переключение между слоями и управлением ими осуществляет-

ся через выпадающее меню Текущий слой на ПИ Текущее состояние. 

3. Преобразовать рисунок, найденный в сети Интернет: 

– найти рисунок в сети Интернет (например, изображение для изделия с 

рис. 1.1 было найдено на сайте https://www.pngegg.com – рис. 2.6); 
Рис. 2.6 

 
Рис. 2.6 

– с помощью бесплатных онлайн-ресурсов преобразовать рисунок в 

формат DXF (например, DXF-файл для указанного изображения был скон-

вертирован на сайте https://imagetostl.com/ru/convert/file/png/to/dxf); 

– импортировать DXF-файл; 

https://www.pngegg.com/
https://imagetostl.com/ru/convert/file/png/to/dxf
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– смасштабировать контуры до требуемого размера и при необходимо-

сти отредактировать их (например, в полученном DXF-файле при использо-

вании команды Масштабирование были заданы масштабирующие коэффи-

циенты 0,13 по двум осям для получения габаритных размеров внешнего 

контура ПП около 88 × 88 мм, а также были удалены объекты из центра). 

Особенности данного способа: 

– не все онлайн-ресурсы выдают результат, который потом можно им-

портировать в Altium Designer (например, с сайта https://convertio.co файл 

DXF загрузить не получилось, хотя в КОМПАС-3D он открылся нормально); 

– импортируемый контур создается по очертанию изображения, поэтому 

он будет содержать достаточно много объектов; 

– цветное изображение необходимо предварительно преобразовать в 

черно-белое, что можно сделать в Paint.NET: сначала сбросить цвета коман-

дой Коррекция ⇒ Сделать черно-белым, а затем подобрать настройки ко-

мандой Коррекция ⇒ Уровни (сделать ступеньку снизу вверх в правой ча-

сти графика) или Коррекция ⇒ Кривые (например, сузить диапазон на ле-

вой гистограмме, передвинув ползунки к верхним значениям, и передвинуть 

центральный ползунок на правой гистограмме ближе к верхнему значению); 

– рекомендуется дополнительно проверить замкнутость контура, попро-

бовав создать с его помощью деталь. 

2.4. Результаты выполнения этапа 

Результат этапа № 2 – внешний контур ПП в файлах форматов FRW и 

DXF. 

В отчете необходимо привести: 

1. Рисунок внешнего контура ПП. 

2. Точки планируемого расположения светодиодов на ПП. 

3. Краткое описание алгоритма работы светодиодов в изделии (где будет 

постоянное свечение, где мигание под управлением мультивибратора и пр.) и 

выбранные цвета. 

Перед переходом к следующему этапу все указанные результаты долж-

ны быть обязательно согласованы с преподавателем. 

https://convertio.co/
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3. ТРАНЗИСТОРНЫЙ МУЛЬТИВИБРАТОР 

3.1. Общие сведения 

На данном этапе необходимо разобраться с принципом работы мульти-

вибратора и найти формулы для его расчета.  

Мультивибратор представляет собой генератор импульсов прямоуголь-

ной формы. Его схема на npn-транзисторах приведена на рис. 3.1 в двух ва-

риантах: слева – общепринятое изображение, справа – изображение, которое 

может оказаться удобнее для понимания принципа работы. 
Рис. 3.1 

 
Рис. 3.1 

Как видно из правого рисунка, это двухкаскадный усилитель, охвачен-

ный положительной обратной связью. Выходной сигнал каждого каскада 

(коллектор соответствующего транзистора) подается на вход следующего 

каскада (база соответствующего транзистора) через разделительный конден-

сатор (С1 и С2). R2 и R3 – резисторы смещения баз. R1 и R4 – резисторы 

нагрузки, вместо которых будут включены параллельные цепочки с двумя 

компонентами: светодиод и токоограничивающий резистор. 

Особенности выбора компонентов: 

– номиналы R1 и R4 должны быть меньше номиналов R2 и R3; 

– отношения резисторов R3 к R1 и R2 к R4 не должны быть больше ко-

эффициентов усиления транзисторов (обозначение: β, 21Эh  или FEh ); 

– постоянные времени, определяемые парами компонентов C1 и R2, C2 

и R3, задают длительности (могут быть разными) закрытых состояний тран-

зисторов VT2 и VT1 соответственно. 

В рабочем режиме транзисторы поочередно с заданной периодичностью 

открываются и закрываются, в результате чего через их нагрузки протекают 
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токи. В разрабатываемом изделии это будет означать включение и отключе-

ние соответствующих светодиодов. 

Подробнее прочитать о работе мультивибратора, а также найти формулы 

для расчета длительностей закрытых состояний транзисторов и периода его 

работы можно в литературе или в сети Интернет, например в [2]–[5]. 

3.2. Результаты выполнения этапа 

Результат этапа № 3 – понимание принципа работы транзисторного 

мультивибратора. 

В отчете необходимо привести: 

1. Рисунок схемы транзисторного мультивибратора. 

2. Краткое описание своими словами процессов, происходящих в тран-

зисторном мультивибраторе (принцип его работы) с указанием причины за-

крытия и открытия транзисторов. 

3. Формулы для расчета длительностей закрытых состояний транзисто-

ров и периода работы мультивибратора с расшифровкой переменных и еди-

ниц измерения. 
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4. КОМПЛЕКТАЦИЯ 

4.1. Общие замечания 

На данном этапе необходимо определиться со всеми компонентами раз-

рабатываемого изделия и найти их в продаже. 

Поиск и покупку компонентов для данной разработки следует осуще-

ствить в АО «ЧИП и ДИП» (https://www.chipdip.ru). Магазин дорогой, в том 

числе многие позиции поставляются путем перепродажи купленного в дру-

гих магазинах. Однако у них есть приличный сайт с поиском, для компонен-

тов указано доступное количество и реальный срок поставки, отсутствует 

минимальная сумма заказа, можно забрать заказ непосредственно из магази-

на без оплаты доставки (находится максимально близко к университету по 

адресу – пр. Медиков, 9 лит. Б), а также приобрести компоненты на месте 

(стоимость зачастую будет в разы больше, чем в интернет-магазине). 

При поиске компонентов необходимо учитывать следующее: 

1. Не у всех компонентов карточка товара заполнена полностью, поэто-

му зачастую имеет смысл записать запрос в строке поиска (например, «10 

кОм 0603» для резисторов типоразмера 0603 номиналом 10 кОм), а потом 

просмотреть результаты в группе товаров данного функционального назна-

чения (в примере – «Чип резисторы (SMD, для поверхностного монтажа») и в 

группе «Позиции на заказ», выбирая в обоих случаях сортировку «Дешевле». 

Пример выполненного запроса показан на рис. 4.1. 
Рис. 4.1 

 
Рис. 4.1 

https://www.chipdip.ru/
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Иногда может помочь изменение текста запроса (например, на «10k 

0603»). Обычно система хорошо справляется с автоматической заменой рус-

ских и английских названий единиц измерения, а также с наличием и отсут-

ствием пробелов, однако количество результатов в сравнении с рис. 4.1 в 

этом случае выросло в 1,5 раза (рис. 4.2). 
Рис. 4.2 

 
Рис. 4.2 

2. Срок поставки больше одной недели для данной разработки допуска-

ется лишь в исключительных случаях. 

Например, для первого резистора в списке с рис. 4.1 – 4–5 дней.  

3. Минимальное доступное количество должно быть не менее несколь-

ких десятков штук. 

Например, для первого резистора в списке с рис. 4.1 – 160 000 шт. 

4. Необходимо смотреть за минимальным количеством, доступным к за-

казу. Обычно – чем больше партия, тем меньше стоимость единицы товара. 

При низкой стоимости для данной разработки допускается до 100 шт. 

Например, первые резисторы на рис. 4.1 дешевые, но купить их можно 

только от 5 100 шт. На рис. 4.3 же показана подходящая позиция. 
Рис. 4.3 

 
Рис. 4.3 

5. Если запрос делается через поиск, то необходимо анализировать 

найденные результаты, так как в них будут и те позиции, в которых есть 

только часть текста запроса. 

Например, на рис. 4.4 в результатах рассматриваемого запроса оказался 

резистор номиналом 110 кОм. 

6. Следует обращать внимание на предлагаемые условия по каждой по-

зиции, которые указываются под запрашиваемым количеством. 
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Рис. 4.4 

 
Рис. 4.4 

Например, на рис. 4.5 показан разъем со стоимостью 98 руб./шт. (при 

минимальном заказе 2 шт. общая сумма составит 196 руб.). Хорошо видно, 

что примерно за такую же сумму можно купить как 5 шт., так и 10 шт. При 

заказе же от 100 шт. цена составит 4,86 руб./шт. (в 20 раз дешевле). 
Рис. 4.5 

 
Рис. 4.5 

4.2. Комментарии к выполнению этапа 

Для разработки потребуется следующая комплектация, которую необхо-

димо найти с учетом 1.5: 

1. Односторонний фольгированный диэлектрик. 

Из дешевых материалов основания зачастую встречаются FR1 (целлю-

лозная бумага, пропитанная смолой) и FR4 (тканное стекловолокно, пропи-

танное эпоксидной смолой). 

Предлагается использоваться FR4 как более прочный, хотя из-за стекло-

волокна фреза быстрее тупится. 

2. Дисковый (плоский) элемент питания. 

Предлагается использовать элемент питания в наиболее распространен-

ном типоразмере 2032 (диаметр – 20 мм, толщина – 3,2 мм) с примерной ем-

костью 210 мА · ч. Напряжение – 3 В. 

3. Батарейный отсек для элемента питания. 

Отсек в данной разработке должен обязательно иметь штыревые выво-

ды, так как он будет устанавливаться с обратной стороны ПП и запаиваться 

на стороне с проводящим рисунком. 

Внешний вид батарейного отсека для элемента питания 2032, использо-

ванного в примере с рис. 1.1, показан на рис. 4.6. 

4. Светодиоды. 

Светодиоды следует выбрать с относительно большим значением силы 

света (100–400 мкд). Чем больше этот параметр, тем ярче светится светодиод 
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при том же токе. Следовательно, можно поставить токоограничивающий ре-

зистор большего номинала и уменьшить общее потребление изделия. 

Подробнее о светодиодах – см. [1, прил. В.7, с. 717]. 
Рис. 4.6 

 
Рис. 4.6 

5. Токоограничивающие резисторы для светодиодов. 

Номиналы токоограничивающих резисторов следует примерно рассчи-

тать по [1, прил. В.7, с. 717] с учетом следующего: 

– необходимо получить силу света у светодиодов около 7 мкд; 

– зависимость силы света от прямого тока светодиода в основном ли-

нейна; 

– с уменьшением тока, протекающего через светодиод, уменьшается и 

падение напряжения на нем. 

Если в документации на светодиоды нет ВАХ, то предположить, что па-

дение напряжения уменьшится относительно номинального на 0,3–0,6 В. 

Следует также отметить, что на данном этапе расчет номиналов носит 

приблизительный характер, так как у светодиодов имеется достаточно боль-

шой разброс в значении номинальной силы света. Кроме того, потребуется 

еще и выровнять яркость свечения светодиодов разного цвета (при их ис-

пользовании), поэтому подбор и уточнение номиналов резисторов будет 

осуществляться в процессе монтажа компонентов на ПП в разд. 10. 

6. Транзисторы мультивибратора. 

Транзисторы следует выбрать в корпусе SOT-23-3 с относительно боль-

шим коэффициентом усиления β (минимальное значение не менее 250). При 

этом необходимо обратить внимание на их структуру. 

7. Конденсаторы и резисторы в базовых цепях мультивибратора. 

Номиналы элементов необходимо определить по формуле, которая была 

найдена в разд. 3, при этом период работы мультивибратора рекомендуется 
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выбрать из диапазона 0,5–2 с, а сам мультивибратор можно сделать несим-

метричным, то есть с разной длительностью закрытого состояния левого и 

правого транзисторов. 

Не следует сильно завышать номиналы резисторов – десятки килоом, но 

не более 100 кОм. Номинальное напряжение конденсатора должно быть не 

менее, чем 1,5 напряжения элемента питания, а его ТКЕ – X5R или X7R. 

8. Движковый переключатель. 

Компонент необязательный и служит для удобства включения и отклю-

чения изделия без извлечения элемента питания из батарейного отсека. 

Внешний вид возможного переключателя показан на рис. 2.3. 

4.3. Результаты выполнения этапа 

Результат этапа № 4 – перечень комплектации для закупки. 

На данном этапе также может быть выполнено дополнительное задание 

№ 1 (см. прил. И.1). 

В отчете необходимо привести: 

1. Расчет номиналов токоограничивающих резисторов для светодиодов. 

2. Расчет номиналов конденсаторов и резисторов в базовых цепях муль-

тивибратора с указанием длительностей открытых состояний транзисторов и 

периода работы мультивибратора. 

3. Расчет времени работы изделия от одного элемента питания. 

4. Список комплектации в виде таблицы с наименованием каждого ком-

понента (в том числе и его Part Number), номенклатурным номером, требуе-

мым количеством и фирмой. 

Также необходимо привести небольшие скриншоты (см. рис. 4.3–4.5) по 

каждой позиции с информацией о сроке поставки, доступном количестве, 

цене, минимальном количестве для заказа и предлагаемым условиям. 

5. Величину затрат на одно изделие. 

6. При выполнении дополнительного задания № 1:  

– рисунок схемы и результаты анализа DC Sweep светодиода в виде двух 

графиков и кратких пояснений к ним; 

– рисунок работающей схемы мультивибратора при анализе Interactive 

Simulation; 

– рисунок схемы мультивибратора с замкнутыми светодиодами, резуль-

таты анализа Transient для напряжений и токов в виде трех графиков и пояс-

нений к ним по п. 26 из прил. И.1; 
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– рисунок схемы мультивибратора с одним светодиодом, результаты 

анализа Transient для напряжений и токов в виде трех графиков и пояснений 

к ним по п. 30 из прил. И.1; 

– рисунок схемы мультивибратора с одним светодиодом и дополнитель-

ным резистором, результаты анализа Transient для напряжений и токов в виде 

трех графиков и пояснений к ним по п. 33 из прил. И.1. 

Перед переходом к следующему этапу все найденные позиции должны 

быть обязательно согласованы с преподавателем и переданы ему в виде от-

дельной таблицы с наименованием и Part Number каждого компонента, тре-

буемым количеством и ссылками. Кроме того, необходимо подтвердить вы-

бранные номиналы резисторов и конденсаторов расчетами. 
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5. ДОКУМЕНТАЦИЯ 

5.1. Схема Э3 

Первоочередным документом для продолжения разработки является схе-

ма Э3 изделия, содержащая информацию о всех необходимых компонентах и 

взаимосвязях между ними. Она позволяет не только получить полное пред-

ставление о работе изделия, но и безошибочно перенести все данные в файл 

трассировки ПП для последующей ее разработки. 

Комментарии к созданию схемы Э3: 

1. Правила оформления схемы Э3 приведены в [1, разд. 8.1, с. 220]. 

2. Общая последовательность действий: 

– определиться с наименованием изделия; 

– составить обозначение изделия; 

– выполнить подготовительные действия: создать проект ПП, создать 

файл схемы Э3, заполнить графы ее рамки, настроить проект, подключить 

библиотеку; 

– добавить на схему необходимые компоненты; 

– соединить выводы компонентов линями электрической связи; 

– выполнить перенумерацию компонентов. 

3. Изделию должно быть присвоено наименование, характеризующее 

его внешний вид и (или) функциональное назначение. 

4. Обозначение изделия задать по одному из двух вариантов: 

– по модифицированному объектно-ориентированному способу с кодом 

конечного изделия в виде буквы «Э» и двух последних цифр номера студен-

ческого билета (см. [1, рис. 2.3, с. 20]); 

– по обезличенному способу, что предполагает выполнение дополни-

тельного задания № 3 (см. прил. И.3). 

5. Подготовительные действия выполняются по [1, разд. 8.2, с. 225] со 

следующими особенностями: 

5.1. Проекту ПП можно присвоить любое имя. 

5.2. Изменения в заполнении граф рамки: 

– наименование изделия – по п. 3; 

– обозначение КД – по п. 4 с добавлением кода документа; 

– графа «Перв. примен.» – обозначение изделия по п. 4; 

– графу «Лит.» оставить пустой. 

5.3. Необходима только библиотека компонентов в виде базы данных. 
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6. Комментарии к размещению компонентов: 

6.1. Добавление компонентов на схему – по [1, прил. Г.28, с. 824]. 

6.2. Основные компоненты есть в библиотеке в виде заготовок, парамет-

ры которых необходимо заполнять уже на схеме по результатам разд. 4, в том 

числе и для составления перечня ПЭ3. Однако можно это не делать для каж-

дого элемента на схеме, а предварительно дополнить базу данных требуемы-

ми компонентами по дополнительному заданию № 2 (см. прил. И.2). 

В библиотеке есть следующие заготовки компонентов: 

– конденсаторы – C0603, C0805 (библиотека C); 

– резисторы – R0603, R0805 (библиотека R); 

– светодиоды – LED0603, LED0805 (библиотека VD); 

– транзисторы – NPN_SOT-23-3 (библиотека VT); 

– батарейный отсек – BATX_2032 (библиотека X); 

– переключатель – SW_SPDT и SW_SPDT_GND (библиотека S). 

Обязательные параметры для заполнения: 

– CI_BOM – Part Number и расшифровка (графа «Наименование» в пе-

речне ПЭ3); 

– CI_Manufacturer – производитель; 

– CI_Value – номинал (для конденсаторов и резисторов) или Part Number 

(для светодиодов, транзисторов и батарейного отсека). 

6.3. У батарейного отсека и переключателя требуется проверить теку-

щие посадочные места. При необходимости их можно изменить, выбрав под-

ходящие в свойствах компонентов (столбец Name в группе Models). 

6.4. Добавление символа земли – по [1, п. 12, с. 73]. 

6.5. Выравнивание объектов – по [1, прил. Г.30, с. 827]. 

7. Работа с линями электрической связи – по [1, прил. Г.25, с. 807]. 

8. Пример перенумерации компонентов – по [1, п. 9.7, с. 268] без учета 

блокировки позиционного обозначения компонента W1. 

9. Пример схемы Э3 для изделия с рис. 1.1 показан на рис. К.1. Другие 

примеры этого документа приведены на [1, с. 273, 908, 909]. 

5.2. Перечень ПЭ3 

Неотъемлемым спутником схемы Э3 является перечень ПЭ3, так как 

именно в нем содержится полная информация об использованных в ней ком-

понентах. 

Комментарии к созданию перечня ПЭ3: 
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1. Правила оформления перечня ПЭ3 приведены в [1, разд. 9.1, с. 280]. 

2. Перечень ПЭ3 создается по [1, разд. 9.2, с. 283], при этом графы рамки 

заполняются по схеме Э3 (см. п. 5.2 из 5.1). 

Необходимо особо обратить внимание на следующее: 

– в перечне ПЭ3 не может быть разделов с подчеркиванием (за исклю-

чением записи функциональных групп); 

– запись компонентов выполняется в порядке возрастания их позицион-

ных обозначений (см. [1, п. 5, с. 281]), при этом допускается объединять в 

одну строку (см. [1, п. 7, с. 281]) только соседние строки с компонентами од-

ного типа с одинаковыми параметрами;  

– общее наименование в отдельной строке (см. [1, п. 8, с. 281, 283]) мо-

жет быть записано только для группы элементов, занимающих в таблице две 

и более строки. В противном случае наименование указывается в строке 

компонента. 

3. Пример перечня ПЭ3 для изделия с рис. 1.1 показан на рис. К.2. Дру-

гие примеры этого документа приведены на [1, с. 289, 290, 913, 914]. 

5.3. Результаты выполнения этапа 

Результаты этапа № 5 – схема Э3 и перечень ПЭ3. 

На данном этапе также могут быть выполнены дополнительные задания 

№ 2 и 3 (см. прил. И.2 и И.3 соответственно). 

В отчете необходимо привести: 

1. При выполнении дополнительного задания № 2 – рисунки созданных 

библиотечных компонентов из панели Libraries, при этом: 

– для каждого компонента – рисунок части панели Libraries с данным 

компонентом и столбцами PartNumber, CI_Value, PI_Package, CI_Manufac-

turer (добавление столбцов – команда ПКМ ⇒ Select Columns). На одном ри-

сунке может быть несколько компонентов; 

– для каждой группы компонентов одного функционального назначе-

ния – рисунок панели Libraries с изображениями УГО и текущего посадочно-

го места, а также списком посадочных мест. 

2. При выполнении дополнительного задания № 3: 

– обозначение изделия; 

– подробная расшифровка кода классификационной характеристики; 

– пояснение кода организации-разработчика; 

– пояснение порядкового регистрационного номера. 
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3. Краткое описание использованной структуры обозначений примени-

тельно к разрабатываемому изделию и его двум КД. 

4. Схему Э3 в виде отдельного файла. 

5. Перечень ПЭ3 в виде отдельного файла. 

Перед переходом к следующему этапу схема Э3 должна быть обязатель-

но согласована с преподавателем. 
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6. ПЕЧАТНАЯ ПЛАТА 

6.1. Комментарии к выполнению этапа 

На данном этапе выполняются действия по созданию ПП: 

1. Файл трассировки ПП необходимо разрабатывать в составе проекта со 

схемой Э3 из разд. 5. 

2. Общая последовательность действий: 

– создать и настроить файл трассировки ПП; 

– создать контур ПП; 

– выполнить компоновку; 

– выполнить трассировку. 

3. Общее описание компоновки и трассировки – по [1, разд. 12.2, с. 309]. 

4. Комментарии к настройке файла трассировки ПП: 

4.1. Если за основу была взята заготовка в виде файла трассировки ПП 

из основного проектирования по [1], то в ней необходимо удалить все объек-

ты (см. [1, примеч. к п. 1, с. 900]).  

Если файл ПП создается заново, то выполняются подготовительные дей-

ствия из [1, разд. 12.1, с. 300]. 

4.2. Изменения в структуре ПП (см. [1, п. 5, с. 300]): 

– толщину металлизации задать равной сумме толщины фольги и фи-

нишного покрытия HASL (см. [1, п. 1, с. 678]); 

– изменить название диэлектрика, его относительную диэлектрическую 

проницаемость и толщину (в заказе с сайта АО «ЧИП и ДИП» для материала 

указана суммарная толщина с фольгой); 

– структуру ПП оставить с двумя проводящими слоями, слои шелкогра-

фии и маски на верхней стороне ПП можно удалить. 

4.3. Изменения в правилах проектирования (см. [1, п. 10, с. 305] и [1, 

табл. Г.7, с. 745]): 

– в заготовке файла ПП в группах Clearance и Short-Circuit (раздел Elec-

trical) оставить только правила C и ShortCircuit соответственно. Также необ-

ходимо удалить правила из групп SMT ⇒ SMD Neck-Down, SMT ⇒ SMD En-

try и High Speed ⇒ Length; 

– все зазоры в правиле C – 0,55 мм; 

– минимальная ширина в правиле W – 0,3 мм; 

– отключить или удалить правило RVS; 

– минимальные диаметры в правилах HS_UP и HS_P – 0,51 мм; 
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– все зазоры в правиле BOC – 0 мм; 

– в правиле PL дополнительно разрешить слой Bottom Layer. Можно от-

ключить или удалить правило. 

Отключение правил проектирования осуществляется в соответствии с 

примером из [1, п. 5.3, с. 370]. 

4.4. Изменения в способах проверки правил проектирования ПП: 

– в заготовке файла ПП отключить Length в категории High Speed; 

– в настройках с [1, рис. 12.7, с. 307] отключить Routing Via Style, Silk To 

Solder Mask Clearance, Minimum Solder Mask Sliver и Permitted Layers. 

5. Комментарии к получению контура ПП: 

5.1. Порядок получения формы ПП: 

– импортировать внешний контур ПП из DXF-файла, созданного в разд. 

2, в начало координат сразу на слой M1 Board по [1, п. 8, с. 326]. Слой с кон-

туром в DXF-файле будет иметь название Board (см. п. 6 из 2.1); 

– изменить форму ПП в соответствии с импортированным контуром по 

[1, п. 2, с. 865]. При появлении информационного сообщения об обнаруже-

нии проблем согласиться с попыткой автоматического исправления. 

5.2. Способы создания внутренних вырезов в ПП (при необходимости их 

использования) описаны в [1, прил. Г.40, с. 867]. Слой – M2 Inner Line. 

6. Комментарии к этапу компоновки: 

6.1. Перенос информации из схемы Э3 – по [1, п. 6, с. 323]. 

6.2. Особенности расстановки посадочных мест – по [1, п. 11, с. 332]. 

6.3. Добавление переходных отверстий – по [1, прил. Г.21, с. 795]. 

6.4. Добавление КП – по [1, прил. Г.17, с. 786]. 

6.5. Изменение шага сетки – по [1, п. 4, с. 137]. 

6.6. Батарейный отсек и выводной переключатель (при наличии) должны 

находиться с нижней стороны ПП (изменение слоя компонента – клавиша L). 

6.7. Если использован батарейный отсек с плоским основанием (см. рис. 

4.6), а под ним расположены перемычки, то поднять модель отсека над ниж-

ней поверхностью ПП на диаметр проволоки перемычек (0,7 мм): 

– перейти в 3D-режим просмотра; 

– дважды щелкнуть ЛКМ по 3D-модели отсека; 

– в появившемся окне для параметра Standoff Height задать 0.7mm; 

– закрыть окно кнопкой OK. 

6.8. У батарейного отсека можно включить вариант посадочного места с 

установленной батарейкой.  
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Для этого необходимо перейти в схему, в свойствах компонента выбрать 

второй вариант посадочного места, сохранить схему, а затем передать изме-

нения обратно в файл ПП. 

7. Комментарии к этапу трассировки: 

7.1. Выбор текущего слоя – по [1, п. 3, с. 145]. 

7.2. Общие настройки привязок – по [1, п. 3.1, с. 361]. 

Информация о привязках – см. [1, прил. Г.36, с. 846]. Следует обратить 

внимание на комбинацию клавиш Shift+E (см. [1, примеч. к п. 2, с. 851]). 

7.3. Возможности интерактивной трассировки – по [1, прил. Г.42, с. 869]. 

7.4. Режимы соединения сегментов трассы – по [1, п. 5.2, с. 804]. 

7.5. Примеры создания трасс – по [1, п. 4.1, с. 364] и [1, п. 4.2, с. 365]. 

7.6. Все проводники и КП должны быть только на слое Top Layer, так 

как используется ОПП. 

7.7. Земляные полигоны добавлять не нужно, так как фрезеровка для 

экономии времени будет выполняться только по контуру печатных провод-

ников и КП. Все остальное останется в виде металлизации без подключения к 

какой-либо цепи. 

6.2. Пример результата трассировки ПП 

Результат трассировки ПП для изделия с рис. 1.1 показан на рис. 6.1 со 

следующими цветовыми обозначениями: 

– черная область с пунктирным контуром – форма ПП; 

– синие «звездочки» – фигурные отверстия; 

– синие круги с цветной окантовкой – отверстий в КП; 

– белые тонкие контуры – корпуса компонентов на верхней стороне ПП 

(слой M3 Top Assy); 

– закрашенные области внутри некоторых белых тонких контуров – сто-

роны расположения катодов светодиодов; 

– синий тонкий контур – корпус батарейного отсека на нижней стороне 

ПП (слой M4 Bottom Assy), расположенный в центре ПП; 

– розовые кривые – проводники питания; 

– желтые линии – проводники цепи GND; 

– голубые кривые – проводники коллекторной цепи левого транзистора 

мультивибратора; 

– зеленые кривые – проводники коллекторной цепи правого транзистора 

мультивибратора; 
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– красные линии – проводники цепей между светодиодами и их токо-

ограничивающими резисторами. 
Рис. 6.1 

 
Рис. 6.1 

Комментарии к приведенному примеру: 

1. Так как трассировку в одном слое выполнить невозможно, то были 

добавлены пары переходов в виде КП с отверстиями c120h60 (расшифровка 

шаблона приведена в [1, прил. Г.22, с. 797]): по три пары для зеленой и голу-

бой цепи и одна пара для розовой цепи (один переход у положительного вы-

вода батарейного отсека и один в центре ПП). Связь отдельных участков це-

пей будет обеспечена проволочными перемычками через нижний слой ПП. 
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Межслойные переходы выполнены с помощью КП для последующего 

отображения отверстий в 3D-модели ПП (дополнительное задание № 4). Ис-

пользование переходных отверстий не приведет к негативным последствиям. 

2. Пара переходов справа внизу на зеленой цепи добавлена для равно-

мерности перемычек под батарейном отсеком. В этом месте можно было 

провести проводник. 

3. Дуги в центре платы (розовая, голубая и зеленая) добавлены командой 

Place ⇒ Full Circle (создание окружности) с последующей настройкой их 

свойств (геометрия, название цепи, слой) – см. [1, рис. 5.28, б, с. 150]. 

4. Каждое фигурное отверстие образовано тремя КП. Каждая такая КП – 

неметаллизированное отверстие с формой Slot (см. [1, п. 2, с. 788] и [1, прил. 

Г.19, с. 794]).  

Также их можно оформить как внутренние вырезы в ПП. 

5. Способы получения копий топологии на лучах ПП описаны в прил. А. 

6.3. Результаты выполнения этапа 

Результат этапа № 6 – файл трассировки ПП. 

На данном этапе также могут быть выполнены дополнительные задания 

№ 4 и 5 (см. прил. И.4 и И.5 соответственно). 

В отчете необходимо привести: 

1. Результаты трассировки ПП в виде следующих рисунков: 

– в 2D-режиме просмотра отдельно для слоев Top Layer, M3 Top Assy, 

M4 Bottom Assy; 

– таблицу со слоя Drill Drawing по [1, п. 20, с. 394]; 

– в 3D-режиме просмотра с видами на верхнюю и нижнюю стороны ПП. 

2. При выполнении дополнительного задания № 4: 

– два рисунка модели, полученные из КОМПАС-3D; 

– рисунок измерения площади ПП; 

– расчет массы ПП; 

– рисунок списка компонентов из правой части окна Bill of Materials; 

– расчет массы печатного узла (с батарейкой и без). 

3. При выполнении дополнительного задания № 5 – изображения моде-

ли, полученные из 3D-pdf, в виде трех рисунков. 

Перед переходом к следующему этапу разработанная ПП должна быть 

обязательно согласована с преподавателем. 
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7. КОНТУРЫ 

7.1. Последовательность действий 

На данном этапе необходимо создать DXF-файл со всеми контурами ПП 

(внешний контур ПП, контуры проводящего рисунка, контуры отверстий), 

необходимыми для ее изготовления на фрезерном станке. 

Основной задачей является получение контуров проводящего рисунка. 

Это можно сделать следующими способами: 

– из Gerber-файла через программу ViewMate или с помощью макроса 

через программу CAM350; 

– из модели проводящего слоя, экспортированного из Altium Designer. 

Первый способ дольше и требует работы в еще одной программе, однако 

проводящий рисунок получается в точности таким, каким он был в файле 

трассировки. Второй способ быстрее, но ширина дорожек получается плава-

ющей с увеличением до 0,03 мм. Так как в данной разработке такая погреш-

ность ни на что не влияет, то будет использоваться последний способ. 

Следует также упомянуть программу GGEasy, позволяющую напрямую 

получить G-код для фрезеровки ПП из файлов Gerber и Excellon.  

Последовательность действий по выполнению этапа следующая: 

1. Выполнить экспорт проводящего рисунка в файл формата X_T ко-

мандой File ⇒ Export ⇒ PARASOLID и обязательно в отдельную папку. 

В окне с настройками включить опцию Export By Layer (с выбором слоя 

Top Layer). Остальные опции можно оставить без изменений. 

1. Выполнить импорт X_T-файла в КОМПАС-3D, например его перетас-

киванием в рабочее поле. 

2. В КОМПАС-3D создать новый чертеж (см. [1, с. 202]). 

3. Добавить в чертеж вид с импортированной модели проводящего ри-

сунка по [1, п. 6, с. 206], при этом: 

– достаточно только вида спереди; 

– масштаб может быть любым (например, 1:1). 

4. В чертеже разрушить добавленный вид по [1, п. 9, с. 208]. 

5. В КОМПАС-3D открыть FRW-файл из разд. 2 и создать в нем слои с 

именами TopLayer и Holes (пиктограмма Управление слоями на ПИ Теку-

щее состояние – см. [1, рис. 6.8, с. 177]). 

6. Перейти на вкладку с чертежом, выделить все отверстия в ПП и выре-

зать их (Ctrl+X), указав в качестве базовой точки начало координат.  
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Выделение выполнить командой Выделить ⇒ По свойствам (в по-

явившемся окне выбрать только объект Окружности в группе Геометрия). 

7. Перейти на вкладку с FRW-файлом, сделать текущим слой Holes (см. 

[1, рис. 6.8, с. 177]) и вставить (Ctrl+V) вырезанные ранее объекты в начало 

координат. 

8. Перейти на вкладку с чертежом, выделить все оставшиеся объекты 

(Ctrl+A) и вырезать их (Ctrl+X), указав в качестве базовой точки начало ко-

ординат.  

9. Перейти на вкладку с FRW-файлом, сделать текущим слой TopLayer и 

вставить (Ctrl+V) вырезанные ранее объекты в начало координат. 

10. Если в файле трассировки в ПП были сделаны внутренние вырезы, 

то необходимо проделать следующее: 

– по [1, п. 2.3, с. 416] осуществить экспорт файла трассировки в формат 

IDF (в настройках секций оставить только Board Outline); 

– по [1, пп. 3.1 и 3.2, с. 418] импортировать созданные файлы IDF (в 

настройках ничего не менять, оставить все по умолчанию, а при импорте в 

появившемся окне с компонентами нажать OK); 

– в Дереве модели зайти в режим редактирования эскиза ПП и скопиро-

вать внутренние вырезы, указав в качестве базовой точки начало координат; 

– перейти на вкладку с FRW-файлом, сделать текущим слой Holes и 

вставить (Ctrl+V) вырезанные ранее объекты в начало координат. 

11. Получить очертания фигурных (слотовых) отверстий на ПП можно 

из STEP-файла (см. прил. И.4). 

12. Экспортировать FRW-файл в формат DXF (см. п. 6 из 2.1). 

13. Сделать изображение по 7.2 и закрыть FRW-файл с сохранением из-

менений. Остальные вкладки можно закрыть без сохранения изменений. 

7.2. Результаты выполнения этапа 

Результат этапа № 7 – DXF-файл со всеми контурами ПП. 

В отчете необходимо привести рисунок рабочего поля FRW-файла: 

– развернуть окно КОМПАС-3D на весь экран; 

– выполнить команду Вид ⇒ Масштаб ⇒ Показать все; 

– сделать текущим слой TopLayer; 

– развернуть список со слоями файла и навести курсор на слой Holes. 

В результате этого внешний контур ПП будет показан черным цветом, 

проводящий рисунок – синим цветом, а отверстия – красным цветом. 
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8. ПРОГРАММА ДЛЯ ФРЕЗЕРОВКИ 

8.1. Главное окно VisualCADCAM 

На данном этапе в VisualCADCAM необходимо подготовить программу 

для изготовления ПП на фрезерном станке. 

Главное окно VisualCADCAM (рис. 8.1) состоит из следующих частей: 

– лента с командами (вкладки Home, Display и др.); 

– поле для системных сообщений и строка для ввода команд (Command); 

– основные панели «VisualCAM - Machining Browser», «VisualCAM - 

Machining Objects» и «Layers», сгруппированные в левой части; 

– рабочее поле; 

– строка состояния с текущими координатами курсора, единицами изме-

рения, пиктограммами привязок и некоторыми дополнительными командами, 

пиктограммой панели свойств (Properties), пиктограммой панели слоев (Layer 

Manger), пиктограммой окна с системными настройками (Options). 
Рис. 8.1 

 
Рис. 8.1 

Основные панели могут быть зафиксированы (отображаются постоянно) 

или скрыты (автоматически сворачиваются после использования) с помощью 

пиктограммы булавки в их заголовке. 

Для перемещения панели необходимо предварительно ее зафиксировать, 

после чего потянуть за название вкладки (если в группе есть еще панели) или 
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за название панели (если панель одна) зажатой ЛКМ. При перемещении па-

нели в главном окне появляются дополнительные пиктограммы, при наведе-

нии на которые будет отображаться место ее будущего размещения. 

Первые две основные панели после их случайного закрытия могут быть 

открыты командой Home ⇒ Plugins ⇒ VisualCAM 2022 ⇒ MILL, а панель 

Layers – пиктограммой в виде цветного сектора в строке состояний. 

Рекомендуется зафиксировать панели и расположить их как показано на 

рис. 8.1 (с левой стороны в одной группе в виде вкладок). 

8.2. Создание инструментов 

Под инструментом (Tool) понимается фреза, сверло и др. изделие, кото-

рым выполняется обработка материала. 

Как отмечалось ранее, ПП будет фрезероваться двумя рашпильными 

фрезами с диаметрами 0,5 мм (проводящий рисунок и отверстия) и 0,8 мм 

(внешний контур). Вторая фреза (см. рис. 2.2), закрепленная в цанговом па-

троне с цангой ER11 (находится под гайкой), показана на рис. 8.2. 
Рис. 8.2 

 
Рис. 8.2 

Для создания и настройки инструментов предназначена вкладка Tools 

панели «VisualCAM - Machining Objects». 

Последовательность действий: 

1. Убедиться в том, что текущие единицы измерения – миллиметры. 
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Изменить параметр можно в строке состояния в поле Units, а также в 

окне настроек в разделе Tols. & Units. 

2. Перейти на вкладку Tools панели «VisualCAM - Machining Objects» и 

нажать пиктограмму Create/Edit Tools. 

3. В появившемся окне в верхней части выбрать тип Flat Mill и запол-

нить параметры для фрезы диаметром 0,5 мм в соответствии с рис. 8.3. 
Рис. 8.3 

    
Рис. 8.3 

Пояснения к части указанных параметров приведены в прил. Б.1–Б.3. 

Следует отметить, что указанные значения зависят от параметров фрезы 

и обрабатываемого материала. Их можно рассчитать, найти в справочниках, а 

также определить с помощью встроенного калькулятора, запускаемого кноп-

кой Load from File (итоговые значения в этом случае будут установлены в 

процентных соотношениях от параметра Cut, которые задаются в настройках 

«VisualCAM - Machining Objects» ⇒ Preferences ⇒ Feeds & Speeds). 

Также заданные значения будут значениями по умолчанию для данного 

инструмента, но их можно независимо изменить в каждой операции, в кото-

рой задействована данная фреза. 

4. Создать модель цангового патрона (Holder) диаметром 19 мм, высотой 

12,5 мм и именем Holder_19x12.5mm, для чего нажать на кнопку с тремя точ-

ками около соответствующей надписи. 
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Пояснения к параметрам приведены в прил. Б.4. 

Модель может состоять из нескольких сегментов цилиндрической и 

(или) конусной формы. Например, на рис. 8.4 было добавлено два сегмента 

(для нижнего сегмента задан угол наклона 45° при диаметре 16 мм и высоте 

1,5 мм). 
Рис. 8.4 

 
Рис. 8.4 

После создания модели нажать кнопку Save as New Holder и закрыть те-

кущее окно. 

5. В окне Create/Select Tool выбрать модель патрона и сохранить настро-

енную фрезу диаметром 0,5 мм кнопкой Save as New Tool. 

Модель цангового патрона и параметры хвостовика фрезы используются 

для контроля отсутствия касаний ими частей материала при выполнении си-

муляции программы. 

6. Создать фрезу диаметром 0,8 мм: 

– в списке с фрезами выбрать созданную фрезу диаметром 0,5 мм; 

– изменить размеры фрезы, ее название и свойства (параметры на вклад-

ке Feeds & Speeds оставить без изменений) в соответствии с рис. 8.5; 

– нажать кнопку Save as New Tool. 

7. Закрыть окно Create/Select Tool. 

8. На вкладке Tools панели «VisualCAM - Machining Objects» нажать 

пиктограмму Save Tool Library для сохранения созданных инструментов в 
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отдельную библиотеку, которую можно будет загружать при необходимости 

в другие проекты. 
Рис. 8.5 

    
Рис. 8.5 

9. На вкладке Tools панели «VisualCAM - Machining Objects» нажать 

пиктограмму List Tools и сохранить рисунок открывшейся таблицы. 

10. Сохранить проект командой Home ⇒ File ⇒ Save As. 

8.3. Импорт контуров ПП 

Для работы со слоями предназначена панель «Layers».  

Последовательность действий для добавления контуров ПП: 

1. Выполнить команду Home ⇒ File ⇒ Import. 

В появившемся окне выбрать тип файлов AutoCAD Files (*.dxf; *.dwg) 

или All Files (*.*) и открыть DXF-файл из разд. 7. 

2. Перейти в панель «Layers». 

3. Удалить слои с названиями в виде номеров (должны остаться слои 

Board, TopLayer, Holes и Default). 

Пиктограммы команд по работе со слоями расположены в верхней части 

панели: добавление нового слоя, удаление выделенного слоя, копирование 

выделенных слоев (в том числе и с объектами), изменение порядка слоев. 

4. Изменить толщину (Thickness) объектов в добавленных слоях на «1». 
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Рис. 8.6 

 
Рис. 8.6 

5. Задать объектам из добавленных слоев разные цвета (Color). 

Пример результата показан на рис. 8.6. 

6. Сохранить проект. 

8.4. Управление в рабочем поле 

Перед продолжением работы следует ознакомиться с возможностями 

управления отображения объектов в рабочем поле:  

1. Выделение объектов. 

Основной способ – перемещение мышки с зажатой ЛКМ: 

– слева направо – только полностью попавшие в контур выделения объ-

екты (границы области выделения отображаются сплошной линией); 

– справа налево – полностью и частично попавшие в контур выделения 

объекты (границы области выделения отображаются пунктирной линией).  

Способы быстрого выделения группы объектов находятся в группе 

Modeling Aids ⇒ Selections: 

– Select by Color (цветной круг) – по цвету. Цвет объектам по умолча-

нию задается по цвету слоя (см. рис. 8.6). Также он может быть изменен для 

любого объекта или группы объектов через окно его свойств (ПКМ ⇒ Proper-

ties) с предварительным отключением там опции Use Layer Color; 

– Select by Layer (цветной 3D-сектор) – по слою. 

2. Поворот изображения – перемещение мышки с зажатой ПКМ. 

3. Перемещение изображения – зажатая клавиша Shift и перемещение 

мышки с зажатой ПКМ. 

4. Изменение масштаба – колесико мышки или зажатая клавиша Ctrl и 

перемещение мышки с зажатой ПКМ. 
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5. Переключение между видами и отображением – через контекстное 

меню или с помощью пиктограмм в верхней части рабочего поля. 

Например, быстрый возврат к виду сверху (Top) удобнее осуществлять 

пиктограммой синего квадрата с белой точкой в углу. 

8.5. Настройка фрезеровки проводящего рисунка 

Проводящий рисунок будет получен обходом фрезы (диаметр 0,5 мм) по 

периметрам контуров из слоя TopLayer с их внешних сторон в один проход 

на глубину, несколько превышающую толщину медной фольги. 

Для создания и настройки операций обработки материала предназначена 

вкладка Program панели «VisualCAM - Machining Browser».  

Последовательность действий: 

1. Перейти на вкладку Program и запустить команду Machining Opera-

tions ⇒ 2 Axis ⇒ Profiling для создания соответствующей операции. 

2. Вкладка Control Geometry окна 2 1/2 Axis Profiling предназначена для 

указания объектов, с которыми будет осуществляться работа. 

Выполнить следующее: 

– сделать активной вкладку Part Regions; 

– нажать кнопку Select Curve/Edge Regions; 

– в рабочем поле выделить объекты со слоя TopLayer (или по цвету, или 

по слою – см. п. 1 из 8.4) и нажать клавишу Enter. 

Если были выделены неправильные объекты, то нажать кнопку Remove 

All и выполнить выделение заново. 

3. Вкладка Tool окна 2 1/2 Axis Profiling предназначена для выбора ин-

струмента, которым будет осуществляться обработка материала. 

В списке доступных инструментов выбрать ранее созданную фрезу диа-

метром 0,5 мм – FlatMill_0.5mm. 

4. Вкладка Feeds & Speeds окна 2 1/2 Axis Profiling предназначена для 

настройки управления инструментом. 

Так как настройки для инструмента были заданы при его создании в 8.2, 

то оставить все по умолчанию. Если параметры не соответствуют заданным 

для указанной фрезы, то их можно установить кнопкой Load from Tool. 

5. Вкладка Clearance Plane окна 2 1/2 Axis Profiling предназначена для 

указания безопасной высоты, на которой перемещается инструмент между 

разными областями обработки материала. 

Задать настройки в соответствии с рис. 8.7 (пояснения см. в прил. Б.5). 
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Рис. 8.7 

 
Рис. 8.7 

Рис. 8.8 

 
Рис. 8.8 
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6. Вкладка Cut Parameters окна 2 1/2 Axis Profiling предназначена для 

настройки параметров обработки материала. 

Задать настройки в соответствии с рис. 8.8 (пояснения см. в прил. Б.6). 

7. Вкладка Cut Levels окна 2 1/2 Axis Profiling предназначена для 

настройки глубины погружения инструмента в материал. 

Задать настройки в соответствии с рис. 8.9 (пояснения см. в прил. Б.7). 

Обратить внимание на то, что значения указаны для фольги 18 мкм. 
Рис. 8.9 

 
Рис. 8.9 

8. Вкладка Entry/Exit окна 2 1/2 Axis Profiling предназначена для 

настройки входа инструмента в материал и выхода из него. 

Выполнить следующее: 

– в группе Entry Motions включить опцию Along Path (траектория по-

гружения инструмента в первый слой), после чего задать для параметра 

Along Path Angle (A) значение 10 (угол наклона траектории 10°), а для Along 

Path Height (H) записать значение на 0,01 мм больше, чем общая глубина по-

гружения (например, для фольги 18 мкм – 0.04; это высота, с которой ин-

струмент будет погружаться до уровня первого слоя); 

– в группе Exit Motions включить опцию None (без дополнительной тра-

ектории выхода инструмента из материала). 
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9. Вкладка Advanced Cut Parameters окна 2 1/2 Axis Profiling предназна-

чена для управления дополнительными настройками. 

В разделе Cut Arc Fitting отключить опцию Perform Arc Fitting (аппрок-

симация дуг). 

Остальные настройки отключены по умолчанию. 

10. Вкладка Cornering Parameters окна 2 1/2 Axis Profiling предназначена 

для настройки вида траектории инструмента во внутренних и внешних углах 

контура. 

Оставить настройки по умолчанию: в группе External Corner Type – 

Round (Default); в группе Internal Corner Type – Sharp (Default). 

11. Вкладка Sorting окна 2 1/2 Axis Profiling предназначена для настрой-

ки траектории перемещения инструмента между различными областями об-

работки материала. 

Выбрать настройку Minimum Distance Sort (сортировка по минимально-

му расстоянию). 

12. Сгенерировать путь инструмента и закрыть окно 2 1/2 Axis Profiling 

кнопкой Generate. 

13. На вкладке Program панели «VisualCAM - Machining Browser» вы-

полнить команду Machining Operations ⇒ Other ⇒ MOp Set для добавления 

новой группы операций. 

После этого в дереве проекта проделать следующее: 

– присвоить созданной группе операций название (ПКМ ⇒ Rename) по 

использованному инструменту (например, «Flat Mill - 0.5 mm»); 

– операции по получению проводящего рисунка ПП присвоить название 

«Top Layer»; 

– переместить операцию «Тop Layer» в созданную группу операций; 

– объекту «Setup 1» присвоить название «PCB». 

Важно обратить внимание, что в названиях не следует использовать 

скобки и кириллицу. 

14. Убедиться в том, что настройки были заданы правильно: траектории 

движения инструмента (голубые и синие контуры) должны быть расположе-

ны с внешних сторон контуров проводящего рисунка (оранжевые контуры). 

Для этого выбрать созданную операцию и включить пиктограмму Tool-

path Visibility. Пример результата показан на рис. 8.10. Небольшой фиолето-

вый участок при переходе вертикальной желтой траектории в голубую гори-

зонтальную – это заданный путь вхождения инструмента в материал. 
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Рис. 8.10 

 
Рис. 8.10 

15. Сохранить изображение с фрагментом проводящего рисунка и сгене-

рированными траекториями перемещения инструмента. 

16. Сохранить проект. 

8.6. Настройка фрезеровки отверстий 

Фрезеровка отверстий будет осуществляться фрезой диаметром 0,5 мм 

на суммарную глубину, несколько превышающую толщину заготовки. В за-

висимости от вида отверстий может быть применена одна из двух операций: 

– если среди отверстий есть некруглые (например, фигурные с рис. 6.1), 

то для простоты будет использоваться операция Profiling. В этом случае все 

отверстия получаются обходом фрезы по периметрам контуров из слоя Holes 

с их внутренних сторон в несколько проходов; 

– если все отверстий круглые, то для ускорения процесса фрезеровки 

будет использоваться операция Hole Profiling. В этом случае фреза погружа-

ется в материал по спиральной траектории без подъемов инструмента после 

завершения каждого слоя как в первой операции. 

Последовательность настройки: 

1. Операция Profiling. 

Так как тип операции совпадает с использованной для получения прово-

дящего рисунка, то все действия будут выполняться в ее копии: 

1.1. В дереве проекта выбрать операцию «Top Layer» и в контекстном 

меню выполнить команду Clone. 

Появившейся ниже копии присвоить имя «Holes». 

1.2. Зайти в режим редактирования операции «Holes». 

Для этого или дважды щелкнуть по ней ЛКМ, или в контекстном меню 

запустить команду Edit. 
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1.3. На вкладке Control Geometry окна 2 1/2 Axis Profiling перейти на 

вкладку Part Regions, где сначала удалить все объекты, а затем добавить объ-

екты со слоя Holes (или по цвету, или по слою – см. п. 1 из 8.4). 

1.4. Настройки на вкладках Tool, Feeds & Speeds и Clearance Plane окна 2 

1/2 Axis Profiling оставить без изменений. 

1.5. На вкладке Cut Parameters окна 2 1/2 Axis Profiling в группе Cutting 

Side для опции Use Outside/Inside for Closed Curve выбрать Inside (пояснение 

см. в прил. Б.6). 

Остальные настройки оставить без изменений. 

1.6. На вкладке Cut Levels окна 2 1/2 Axis Profiling: 

– в группе Cut Depth Control для параметров Total Cut Depth и Rough 

Depth записать значение суммарной толщины заготовки с добавкой 0,08 мм 

(например, для заготовки 1 мм записать 1.08); 

– для параметра Rough Depth/Cut задать значение 0.2. 

Пояснения параметров приведены в прил. Б.7. 

1.7. На вкладке Entry/Exit окна 2 1/2 Axis Profiling: 

– в группе Entry Motions для параметра Along Path Height (H) задать зна-

чение 0.21 (несколько больше значения из п. 1.6). 

– включить опцию Apply entry/exit at each cut level (настройки групп En-

try Motions и Exit Motions применяются к каждому слою снятия материала). 

1.8. Настройки на вкладках Advanced Cut Parameters, Cornering Parame-

ters и Sorting окна 2 1/2 Axis Profiling оставить без изменений. 

1.9. Сгенерировать путь инструмента и закрыть окно 2 1/2 Axis Profiling 

кнопкой Generate. 

1.10. Убедиться в том, что настройки были заданы правильно: траекто-

рии движения инструмента (голубые и синие контуры) должны быть распо-

ложены с внутренних сторон контуров отверстий (оранжевые контуры), при 

этом в каждом отверстии таких траекторий будет несколько друг под другом 

(послойная фрезеровка). 

Пример результата показан на рис. 8.11. Фиолетовая спиральная траек-

тория – это заданный путь вхождения инструмента в материал. Он повторя-

ется для каждого слоя. 

2. Операция Hole Profiling: 

2.1. Перейти на вкладку Program, в дереве проекта выбрать группу опе-

раций «Flat Mill - 0.5 mm» и запустить команду Machining Operations ⇒ 2 Ax-

is ⇒ Hole Profiling для создания соответствующей операции. 
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Рис. 8.11 

 
Рис. 8.11 

2.2. На вкладке Control Geometry окна Hole Profiling добавить объекты 

со слоя Holes (или по цвету, или по слою – см. п. 1 из 8.4). 

2.3. На вкладке Tool окна Hole Profiling в списке доступных инструмен-

тов выбрать фрезу диаметром 0,5 мм – FlatMill_0.5mm. 

2.4. Настройки на вкладке Feeds & Speeds окна Hole Profiling оставить 

без изменений. 

2.5. На вкладке Clearance Plane окна Hole Profiling задать настройки в 

соответствии с рис. 8.7. 
Рис. 8.12 

 
Рис. 8.12 

2.6. На вкладке Cut Parameters окна Hole Profiling задать настройки в со-

ответствии с рис. 8.12, обратив внимание на значение в группе Hole Depth 
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(H), которое необходимо указать как суммарную толщину заготовки с добав-

кой 0,08 мм (на рисунке для заготовки 1 мм записано 1.08). 

Пояснения параметров приведены в прил. Б.6. 

2.7. На вкладке Entry/Exit окна Hole Profiling выполнить следующее: 

– в группе Entry Motions включить опцию Along Path, после чего задать 

для параметра Along Path Angle (A) значение 10, а для Along Path Height (H) 

записать значение 0.2 (на 0,1 мм больше, чем шаг спирали); 

– в группе Exit Motions включить опцию None. 

2.8. На вкладке Sorting окна Hole Profiling выбрать настройку Minimum 

Distance Sort. 

2.9. Сгенерировать путь инструмента и закрыть окно Hole Profiling 

кнопкой Generate. 

2.10. В дереве проекта созданной операции присвоить название «Holes». 

2.11. Убедиться в том, что настройки были заданы правильно: траекто-

рии движения инструмента (голубые спирали) должны быть расположены с 

внутренних сторон контуров отверстий (оранжевые контуры). 

Пример результата показан на рис. 8.13. 
Рис. 8.13 

 
Рис. 8.13 

3. Сохранить изображение с несколькими отверстиями и сгенерирован-

ными траекториями перемещения инструмента. 

4. Сохранить проект. 

8.7. Настройка фрезеровки внешнего контура ПП 

Внешний контур будет выполняться фрезой диаметром 0,8 мм с внеш-

ней стороны периметра соответствующего контура на суммарную глубину, 

несколько превышающую толщину заготовки. 
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За основу удобнее было бы взять операцию Profiling из 8.6, но так как 

для отверстий могла быть использована операция Hole Profiling, то для опре-

деленности все настройки будут осуществляться в копии операции Profiling 

из 8.5: 

1. На вкладке Program панели «VisualCAM - Machining Browser» выпол-

нить команду Machining Operations ⇒ Other ⇒ MOp Set для добавления новой 

группы операций. 

После этого в дереве проекта проделать следующее: 

– выбрать операцию «Top Layer» и в контекстном меню выполнить ко-

манду Clone, после чего присвоить появившейся копии имя «Board»; 

– присвоить созданной группе операции имя по второму инструменту 

(например, «Flat Mill - 0.8 mm»); 

– перетащить операцию «Board» в созданную группу; 

– поместить первую группу операций над созданной (сначала будут вы-

полняться операции с фрезой диаметром 0,5 мм). 

2. Зайти в режим редактирования операции «Board» (см. п. 1.2 из 8.6). 

3. На вкладке Control Geometry окна 2 1/2 Axis Profiling перейти на 

вкладку Part Regions, где сначала удалить все объекты, а затем добавить объ-

екты со слоя Board (или по цвету, или по слою – см. п. 1 из 8.4). 

4. На вкладке Tool окна 2 1/2 Axis Profiling в списке доступных инстру-

ментов выбрать ранее созданную фрезу диаметром 0,8 мм – FlatMill_0.8mm. 

5. Настройки на вкладках Feeds & Speeds, Clearance Plane и Cut Parame-

ters окна 2 1/2 Axis Profiling оставить без изменений. 

6. На вкладке Cut Levels окна 2 1/2 Axis Profiling: 

– в группе Cut Depth Control для параметров Total Cut Depth и Rough 

Depth записать значение суммарной толщины заготовки с добавкой 0,08 мм 

(например, для заготовки 1 мм записать 1.08); 

– для параметра Rough Depth/Cut задать значение 0.3. 

Пояснения параметров приведены в прил. Б.7. 

7. На вкладке Entry/Exit окна 2 1/2 Axis Profiling: 

– в группе Entry Motions для параметра Along Path Height (H) задать зна-

чение 0.31; 

– включить опцию Apply entry/exit at each cut level (см. п. 1.7 из 8.6). 

Остальные настройки оставить без изменений. 

8. На вкладке Advanced Cut Parameters окна 2 1/2 Axis Profiling в группе 

Bridges/Tabs (параметры перемычек) выполнить следующее: 



49 

– выбрать опцию Triangular (треугольная форма); 

– в поле Bridge Height (H) задать значение 0.3 (высота – 0,3 мм); 

– в поле Bridge Length (L) задать значение 2 (длина – 2 мм); 

– включить опцию Reduce feed on descending motion (уменьшение пода-

чи при погружении инструмента в материал); 

– в поле Number of Bridges задать значение не менее 3 (количество пере-

мычек). 

Перемычки будут удерживать ПП в заготовке после последнего прохода 

инструмента по ее контуру. 

9. Настройки на вкладках Cornering Parameters и Sorting окна 2 1/2 Axis 

Profiling оставить без изменений. 

10. Сгенерировать путь инструмента и закрыть окно 2 1/2 Axis Profiling 

кнопкой Generate. 

11. Убедиться в том, что настройки были заданы правильно: траектории 

движения инструмента (голубые и синие контуры) должны быть расположе-

ны с внешней стороны контура ПП (оранжевый контур) друг под другом. 

Пример результата показан на рис. 8.14. Слева посередине пунктирным 

овалом отмечена одна треугольная перемычка. 
Рис. 8.14 

 
Рис. 8.14 

Если перемычки оказались в неудобных местах (например, в углах) или 

их мало (много), то в настройках можно изменить количество или расстояние 

между ними. 

12. Сохранить изображение с фрагментом внешнего контура ПП и сге-

нерированной траекторий перемещения инструмента, при этом должна быть 

видна хотя бы одна перемычка. 

13. Сохранить проект. 
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8.8. Визуализация фрезеровки 

Для визуализации операций обработки материала предназначена вклад-

ка Simulate панели «VisualCAM - Machining Browser».  

Последовательность действий: 

1. Создать заготовку материала (выбранный ранее односторонний фоль-

гированный диэлектрик) и расположить ее в рабочем поле так, чтобы верхняя 

грань находилась в плоскости X0Y и полностью охватывала контуры ПП. 

Положение заготовки не повлияет на итоговую программу.  

Для этого в дереве проекта дважды щелкнуть ЛКМ по объекту 

«Stock…» (см. рис. 8.1) и в появившемся окне задать следующие значения: 

– в группе Dimensions – размеры заготовки (L – длина, W – ширина; H –

 толщина). 

– в группе Corner Coordinates – положение заготовки относительно вер-

шины, отмеченной на рисунке в этом окне (Xc, Yc, Zc – смещение по оси X, 

Y и Z соответственно). При необходимости можно поменять вершину. 

Пример результата показан на рис. 8.15. 
Рис. 8.15 

 
Рис. 8.15 

Следует обратить внимание на то, что при указанном способе редакти-

рования заготовки будет осуществлен автоматический переход на вкладку 

Program с отображением в рабочем поле как контуров ПП, так и заготовки. 

Чтобы заготовка всегда отображалась при активной вкладке Program, после 

выхода из режима редактирования необходимо нажать на пиктограмму Stock 

Visibility в нижней части панели. 

2. Перейти на вкладку Simulate и в нижней части панели включить сле-

дующие настройки (рис. 8.16): 

– Stock Visibility (отображение заготовки); 
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– Toolpath Visibility (отображение пути следования инструмента); 

– Tool Visibility (отображение инструмента); 

– Holder Visibility (отображение цангового патрона); 

– Follow Toolpath Display (путь следования инструмента отображается 

по мере его перемещения, не сразу весь). 
Рис. 8.16 

 
Рис. 8.16 

Последнюю настройку можно заменить на Trace Toolpath Display (отоб-

ражение всего пути следования инструмента сразу) или на Segment Toolpath 

Display (отображение только той части пути следования инструмента, на ко-

торой он сейчас находится). 

3. На вкладке Simulate запустить команду Options ⇒ Preferences и в по-

явившемся окне в разделе Simulation задать настройки в соответствии с рис. 

8.17 (пояснения см. в прил. Б.8). 
Рис. 8.17 

 
Рис. 8.17 

4. Обратить внимание на настройки управления на вкладке Simulate: 

– Play – запуск симуляции; 

– Step – симуляция по шагам (только внутри одной операции); 

– Pause – пауза в симуляции; 

– Stop – остановка симуляции; 
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– To End – переход к концу симуляции без отображения перемещения 

инструмента (для быстрого завершения следует изменить режим на Simulate 

by Moves и увеличить скорость); 

– ползунок Simulation Speed – изменение скорости симуляции; 

– Simulate by Moves – смена режима симуляции. 

5. В дереве проекта выбрать объект «PCB» и запустить симуляцию (си-

муляцию также можно запускать отдельно для каждой операции). 
Рис. 8.18 

 
Рис. 8.18 

Сохранить два рисунка: 

– в процессе симуляции в любом месте нахождения инструмента; 

– после завершения симуляции при текущем виде сверху (см. п. 5 из 8.4) 

в области, в которой будут видны края ПП, элементы проводящего рисунка, 

хотя бы одно отверстие и перемычка. Отображение инструмента и цангового 

патрона можно отключить. Пример результата показан на рис. 8.18. 

6. Сохранить проект. 

8.9. Создание программы фрезеровки 

После создания операций и генерирования траекторий перемещения ин-

струментов необходимо сделать постпроцессорную обработку – преобразо-

вать их в управляющую программу для станка с ЧПУ (G-код). 

Последовательность действий: 

1. Задать постпроцессор для программы Mach3 в метрической системе.  

Если он еще не был назначен, то в дереве проекта дважды щелкнуть 

ЛКМ по объекту «Post…», после чего в появившемся окне в группе Post-

Processor Type выбрать опцию Use Legacy Post и в группе Select Post Proces-

sor в выпадающем списке выбрать Mach3-MM. 
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На рис. 8.1 указанный постпроцессор уже был выбран. 

2. Рекомендуется изменить настройку параметров для команды построе-

ния дуг в постпроцессоре по прил. Б.9. 

3. Если с настройками операций выполнялись какие-то действия, то в 

дереве проекта выбрать объект «PCB» и из контекстного меню запустить ко-

манду Regenerate для обновления траекторий перемещения инструментов. 

4. Создать по одной программе фрезеровки для каждой группы опера-

ций (в группах используются разные инструменты, которые надо будет ме-

нять при работе на станке): 

– выбрать соответствующую группу в дереве проекта; 

– из контекстного меню запустить команду Post; 

– сохранить NC-файл в удобное место; 

– дождаться появления программы в блокноте и закрыть его. 

5. Сохранить проект. 

8.10. Результаты выполнения этапа 

Результаты этапа № 8 – VCP-файл проекта и два NC-файла с програм-

мой фрезеровки.  

На данном этапе также могут быть выполнены дополнительные задания 

№ 6 и 7 (см. прил. И.6 и И.7). 

В отчете необходимо привести: 

1. Рисунок таблицы с инструментами. 

2. Результаты настройки фрезеровки в виде трех рисунков: 

– для фрагмента проводящего рисунка; 

– для нескольких отверстий; 

– для внешнего контура ПП хотя бы с одной перемычкой. 

3. Результаты симуляции фрезеровки в виде двух рисунков: 

– в момент выполнения симуляции; 

– после завершения симуляции. 

4. При выполнении дополнительного задания № 6 – первые 13 строк из 

любого полученного NC-файла с подробными комментариями. 

5. При выполнении дополнительного задания № 7: 

– выбранное обозначение ПП с подробной расшифровкой кода класси-

фикационной характеристики и пояснениями кода организации-разработчика 

и порядкового регистрационного номера. 

– чертеж ПП в виде отдельного файла; 
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– удостоверяющий лист для данных проектирования в виде отдельного 

файла. 

Перед переходом к следующему этапу с преподавателем должны быть 

обязательно согласованы рисунок таблицы с инструментами и результат ви-

зуализации фрезеровки для всей ПП при текущем виде сверху. 

8.11. Подготовка к этапу № 9 

Последующие этапы выполняются на рабочем месте с использованием 

оборудования, указанного в 1.1, поэтому следует уделять внимание некото-

рым подготовительным действиям. 

Перед началом этапа № 9 необходимо: 

– уточнить у преподавателя наличие выбранного одностороннего фоль-

гированного диэлектрика; 

– согласовать с преподавателем дату и время работы на станке с ЧПУ 

(обратить внимание на минимальное время выполнения этапа по табл. 1.1);  

– ознакомиться с последовательностью действий на этапе № 9; 

– взять с собой на USB-накопителе результаты работы по этапу № 8, при 

этом не только NC-файлы с программой фрезеровки, но и VCP-файл проекта 

для возможности внесения изменений. 
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9. ИЗГОТОВЛЕНИЕ ПЕЧАТНОЙ ПЛАТЫ 

9.1. Последовательность действий 

На данном этапе необходимо выполнить фрезеровку фольгированного 

стеклотекстолита в соответствии с ранее полученными NC-файлами. 

Рабочее место (рис. 9.1) состоит из ПК с ОС Windows XP и установлен-

ной программой Mach3, которая взаимодействует с блоком управления стан-

ка с ЧПУ (CNC-3040) через LPT-порт.  
Рис. 9.1 

 
Рис. 9.1 

План действий: 

1. Прослушать правила безопасности по использованию оборудования, 

располагающегося на рабочем месте. 

2. Включить ПК и запустить программу Mach3 (Mach3Mill). Главное ок-

но программы с активной вкладкой Program Run показано на рис. 9.2. 

3. Включить блок управления станка кнопкой POWER. 

4. Обратить внимание на расположение осей координат в рабочем про-

странстве станка: 

– ось X с положительным направлением вправо; 

– ось Y с положительным направлением от оператора; 

– ось Z с положительным направлением вверх. 
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Рис. 9.2 

 
Рис. 9.2 

Ноль по каждой оси может быть установлен оператором в любой точке 

рабочего пространства станка кнопками Zero X, Zero Y и Zero Z, которые 

располагаются рядом с текущими координатами инструмента в верхней 

средней части окна программы. 

Для автоматического возврата в нули служит кнопка GOTO ZERO, при-

чем сначала это происходит в горизонтальной плоскости, а затем по оси Z. 

5. Ознакомиться со способами ручного управления положением инстру-

мента в рабочем пространстве станка: из панели управления и с клавиатуры. 

Инструмент можно перемещать в одном из двух режимов: непрерывный 

или дискретный (с заданным шагом). 

Панель управления открывается клавишей Tab (ее фрагмент показан на 

рис. 9.3). Органы управления: 

– область Button Jog с кнопками перемещения по осям. Они дублируют-

ся клавишами на клавиатуре: Right – «X+», Left – «X-», Up – «Y+», Down – 

«Y-», PgUp – «Z+», PgDn – «Z-»; 

– область Slow Jog Rate – скорость перемещения инструмента в непре-

рывном режиме относительно максимального значения. Настройка действует 

при нажатии на кнопки перемещения как в панели, так и на клавиатуре. Од-
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нако при работе с клавиатуры доступно ускоренное перемещение с зажатой 

клавишей Shift (без учета заданного здесь значения); 
Рис. 9.3 

 
Рис. 9.3 

– кнопка Jog Mode – переключение режима перемещения (Cont – непре-

рывный, Step – дискретный); 

– поле около кнопки Cycle Jog Step – шаг в дискретном режиме. При ра-

боте с клавиатуры перемещать инструмент дискретно можно с зажатой кла-

вишей Ctrl. 

После ввода значений необходимо нажимать клавишу Enter. 

Управление с клавиатуры разрешается кнопкой Jog ON/OFF (вкладки 

Program Run, MDI, Offsets, Diagnostics). 

6. Получить доступ к управлению станком. 

Для этого в программе Mach3 отжать красную мигающую кнопку RE-

SET (программная экстренная остановка станка). 

7. Переместить инструмент в положение, которое не будет мешать раз-

мещению заготовки из фольгированного диэлектрика. 

Необходимо следить за объектами, располагающимися в рабочем про-

странстве станка, чтобы при перемещении инструмента не сломать его. 

8. Заготовку одностороннего фольгированного диэлектрика выровнять 

(проводящий слой должен быть сверху) и закрепить на рабочем столе станка 

с помощью кусочков двухстороннего скотча. 

Обратить внимание, что заготовка будет располагаться на листе гети-

накса (фальшстол или «жертвенный стол»), который препятствует поврежде-
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нию основного стола станка, выполненного из алюминиевого профиля, и 

быстрому износу и (или) поломке инструмента при погружении последнего 

на глубину, превышающую толщину заготовки. 

9. Зажать фрезу диаметром 0,5 мм в цанговом патроне. 

Диаметр хвостовика у данной фрезы 3 мм, поэтому необходимо исполь-

зовать соответствующую цангу – ER11-3. 

10. Убедиться в отсутствии биения инструмента: 

– на блоке управления включить кнопку SPINDLE (разрешение на рабо-

ту шпинделя – вращающегося вала); 

– в Mach3 на вкладке Program Run в группе Spindle Speed в одноимен-

ном поле записать количество оборотов 3000 и нажать клавишу Enter; 

– надеть защитные очки; 

– нажать клавишу F5 (или кнопку Spindle CW F5 в группе Spindle Speed) 

для включения шпинделя; 

– посмотреть на кончик инструмента и остановить шпиндель клавишей 

F5. Можно запустить и остановить шпиндель несколько раз; 

– убедиться, что шпиндель остановлен (не вращается); 

– если биения нет, то отключить кнопку SPINDLE (для дальнейших дей-

ствий требуется исключить случайный запуск шпинделя) и снять защитные 

очки. В противном случае переустановить инструмент и повторить проверку. 

11. Определить нули по осям X и Y: 

– переместить инструмент в горизонтальной плоскости в точку, в кото-

рой будет начало координат (совпадает с началом координат в VCP-файле, 

полученном в разд. 8); 

– убедиться в том, что будущая ПП будет полностью размещена на заго-

товке, и обнулить координаты X и Y. 

12. Ознакомиться с датчиком касания (рис. 9.4): пластиковая подставка с 

металлическим цилиндром и двумя выводами с зажимами типа «крокодил». 

Вывод с желтым проводом и сам цилиндр – земля. Вывод с голубым прово-

дом – сигнальный. Датчик подключается в разъем Probe блока управления. 

При наличии проводящей поверхности один из выводов крепится к ней, 

а другой – к инструменту. Нулевая координата по оси Z определяется по по-

явлению логического ноля на сигнальном выводе (момент касания инстру-

мента поверхности). Проводящей поверхностью также может служить торец 

цилиндра, только в этом случае из получившейся координаты Z потребуется 

вычесть известную толщину подставки с цилиндром. 
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Рис. 9.4 

 
Рис. 9.4 

13. Проверить наличие контакта между выводами датчика касания: 

– в Mach3 перейти на вкладку Diagnostics; 

– убедиться в отсутствии индикации у параметра Digitize; 

– коснуться выводами датчика друг друга; 

– убедиться в наличии индикации у параметра Digitize. 

14. Аккуратно подключить вывод датчика с длинным проводом к ин-

струменту, а с коротким – к заготовке. 

15. Определить ноль по оси Z: 

– опустить инструмент по оси Z, оставив небольшой зазор до заготовки; 

– уменьшить скорость перемещения инструмента до 1 %; 

– аккуратно продолжить опускать его до появления устойчивой индика-

ции у параметра Digitize; 

– на вкладке Program Run обнулить координату Z; 

– увеличить скорость перемещения инструмента до 50 %; 

– поднять инструмент по оси Z на высоту 2–3 мм. 

16. Получить карту высот и скорректировать NC-файл с проводящим 

рисунком и отверстиями, созданным в разд. 8 (см. прил. Г.2). 

Корректировка NC-файла с внешним контуром ПП не требуется (в соот-

ветствующей операции в VisualCADCAM был предусмотрен достаточный 

запас на глубину погружения), однако при желании это можно сделать по 

информации из прил. Г.3 с первым способом сканирования поверхности. 

17. Отсоединить выводы датчика касания от инструмента и ПП. 

18. На блоке управления включить кнопку SPINDLE. 

19. Загрузить скорректированный G-код для фрезеровки проводящего 

рисунка и отверстий командой File ⇒ Load G-Code или соответствующей 

кнопкой на вкладке Program Run. 
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Убедиться, что после загрузки первая строка программы находится на 

белом фоне, а в окне отображения траекторий перемещения инструмента по-

явилось ожидаемое изображение (рис. 9.5). 
Рис. 9.5 

 
Рис. 9.5 

Если это не так, то выполнить следующее: 

– выгрузить текущий NC-файл (команда File ⇒ Close File(s) или кнопка 

Close G-Code на вкладке Program Run); 

– изменить настройки постпроцессора в VisualCADCAM (см. прил. Б.9); 

– заново сгенерировать NC-файл и скорректировать его с использовани-

ем созданного ранее файла с данными поверхности; 

– загрузить новый NC-файл в Mach3. 

20. Запустить выполнение программы: 

– перейти на вкладку Tool Path и нажать кнопку Simulate Program Run; 

– дождаться выполнения симуляции и сохранить время в отчет; 

– на вкладке Program Run в группе Spindle Speed нажать кнопку Reset 

для сброса скорости вращения шпинделя в 100 %; 

– надеть защитные очки и маску; 

– обратить внимание на расположение на блоке управления большой 

красной кнопки для экстренной остановки станка – EMERGENCY STOP (при 

нажатии произойдет полная остановка станка, в том числе и шпинделя); 

– запустить фрезеровку кнопкой Cycle Start; 

– сфотографировать процесс фрезеровки. 

Особенности управления выполнением программы описаны в прил. В.3. 

21. Дождаться окончания фрезеровки, почистить заготовку с помощью 

пылесоса и снять защитные очки и маску. 

22. Заменить фрезу в цанговом патроне на фрезу диаметром 0,8 мм. 

Диаметр хвостовика у данной фрезы такой же, поэтому цангу менять не 

требуется. 
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23. По п. 10 убедиться в отсутствии биения (кнопку SPINDLE отключать 

не требуется). 

24. Определить ноль по оси Z или по п. 15 (обратить внимание на то, что 

фреза должна коснуться участка металлизации, имеющего непосредственный 

контакт со вторым выводом датчика касания), или с помощью листа бумаги. 

В последнем случае выполняется следующее: 

– штангенциркулем измеряется толщина листа; 

– инструмент медленно опускается до тех пор, пока лист не перестанет 

свободно перемещаться; 

– обнуляется координата Z; 

– на вкладке MDI в поле Input вводится команда G01 Z-H (H – толщина 

листа в миллиметрах) и нажимается клавиша Enter; 

– обнуляется координата Z.  

25. Поднять инструмент по оси Z на высоту 2–3 мм. 

26. Убедиться, что кнопка SPINDLE на блоке управления включена. 

27. Загрузить и запустить выполнение программы фрезеровки внешнего 

контура (см. пп. 19 и 20), также сохранив в отчет время ее выполнения. 

28. Дождаться окончания фрезеровки, почистить заготовку с помощью 

пылесоса и снять защитные очки. 

29. Демонтировать заготовку и извлечь из нее ПП.  

30. Почистить контур ПП от прилипших остатков скотча и стеклотек-

столита (рис. 9.6) и надфилем удалить остатки перемычек. 
Рис. 9.6 

 
Рис. 9.6 

31. Мелкой наждачной бумагой аккуратно зачистить медную поверх-

ность ПП от заусенцев, образовавшихся в процессе фрезеровки. 

32. Снять защитную маску. 

33. Сфотографировать ПП. 

34. Взвесить ПП и сохранить результат в отчет. 
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9.2. Результаты выполнения этапа 

Результат выполнения этапа № 9 – ПП. 

На данном этапе также могут быть выполнены дополнительные задания 

№ 8 и 9 (см. прил. И.8 и И.9). 

В отчете необходимо привести: 

1. Время выполнения процессов фрезеровки: 

– проводящего рисунка и отверстий; 

– внешнего контура ПП. 

2. Фотографию процесса фрезеровки. 

3. Фотографию ПП. 

4. Массу ПП. 

При выполнении дополнительного задания № 3 сравнить результаты. 

5. При выполнении дополнительного задания № 8: 

– расчет длины проволоки для перемычек; 

– спецификацию на изделие в виде отдельного файла. 

6. При выполнении дополнительного задания № 9 – сборочный чертеж 

изделия в виде отдельного файла. 

9.3. Подготовка к этапу № 10 

Перед началом этапа № 10 необходимо: 

– уточнить у преподавателя наличие выбранной комплектации; 

– согласовать с преподавателем дату и время работы с паяльником (об-

ратить внимание на минимальное время выполнения этапа по табл. 1.1);  

– ознакомиться с возможностями мультиметра по прил. Д.1; 

– ознакомиться с особенностями пайки по прил. Е; 

– ознакомиться с последовательностью действий на этапе № 10; 

– распечатать и взять с собой результаты дополнительных заданий № 8 и 

9. Если задания не выполнялись, то следует использовать печатные версии 

как минимум перечня ПЭ3 (см. разд. 5.3) и рисунка слоя M3 Top Assy в хо-

рошем качестве (см. разд. 6.3). 
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10. МОНТАЖ КОМПОНЕНТОВ 

10.1. Последовательность действий 

На данном этапе необходимо выполнить сборку печатного узла: устано-

вить все компоненты со схемы Э3 и соединить разделенные участки одина-

ковых цепей перемычками с обратной стороны ПП. Кроме того, в процессе 

сборки потребуется проверить номиналы токоограничивающих резисторов и 

при необходимости скорректировать их значения для выравнивания свечения 

светодиодов. 

Последовательность действий по выполнению этапа следующая: 

1. Прослушать правила безопасности по использованию паяльного обо-

рудования, располагающегося на рабочем месте. 

Пример рабочего места приведен на рис. 10.1. 
Рис. 10.1 

 
Рис. 10.1 

На рисунке показаны:  

– паяльная станция: блок управления, паяльник, подставка, целлюлозная 

губка для влажной чистки жала (в подставке), сменные жала (в подставке); 

– вата; 
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– изопропиловый спирт во флаконе с распылителем; 

– кусачки; 

– металлические губки в виде стружки для механической чистки жала; 

– термостойкий силиконовый коврик; 

– припой ПОС-61 в катушке; 

– флюс ER-700 Pro в шприце; 

– зубочистки; 

– медная оплетка; 

– пинцеты; 

– ватные палочки; 

– лабораторный блок питания. 

2. Убедиться, что губка для влажной чистки жала паяльника смочена. 

3. Ознакомиться с особенностями пайки по прил. Е. 

4. Залудить проводящую поверхность ПП: 

– нанести кисточкой на медную поверхность ПП флюс ЛТИ-120, после 

чего обязательно закрыть флакон во избежание выливания содержимого; 

– взять на плоское жало паяльника припой (рекомендуется использовать 

цилиндрическое жало диаметром около 4 мм со скосом); 

– коснуться жалом паяльника с припоем проводящей поверхности; 

– после прогрева и смачивания припоем проводящей поверхности в ме-

сте касания жала аккуратно без нажима перемещать его, не отрывая от меди 

и покрывая ее тонким слоем припоя; 

– если на жале закончился припой, то взять еще и продолжить лужение; 

– если видно, что припой не прилипает к меди, то установить паяльник в 

подставку, нанести на медь еще флюс, после чего продолжить лужение. 

После окончания лужения вся медная поверхность должна быть покрыта 

припоем. Допускается наличие небольших бугорков припоя – «наплывов». 

На рис. 10.2 слева показан пример ПП до лужения, а справа – после. 
Рис. 10.2 

   
Рис. 10.2 
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5. Отмыть плату от флюса: 

– взять небольшой кусок ваты; 

– смочить спиртом; 

– протереть в одном направлении залуженную поверхность или ее часть; 

– сложить вату грязной стороной внутрь и снова протереть поверхность; 

– выкинуть использованный кусок ваты; 

– повторить действия выше до полной очистки поверхности. 

При необходимости в конце можно почистить плату зубной щеткой под 

горячей водой. 

6. Взвесить ПП и сохранить результат в отчет. 

7. При отсутствии навыков пайки потренироваться на макетной плате в 

монтаже компонента (например, резистора) наименьшего типоразмера из ис-

пользованных в разработанном изделии. 

8. Установить на посадочные места светодиоды. 

Особое внимание при монтаже обратить на ориентацию этих компонен-

тов на каждом посадочном месте. Катод на корпусе может быть обозначен 

зеленой маркировкой как сверху, так и снизу. Однако бывают случаи (осо-

бенно в маленьких корпусах), когда маркировки нет, а катод обозначается 

особой формой КП (отличной от прямоугольной). При любых сомнениях 

следует обратиться к документации на конкретные светодиоды. 

Примеры обозначений на корпусах светодиодов показаны на рис. 10.3. 
Рис. 10.3 

 
Рис. 10.3 

9. Подобрать номиналы токоограничивающих резисторов для светодио-

дов так, чтобы яркость свечения последних была одинаковой. 

Действия будут осуществляться с каждым типом светодиода (по цвету 

свечения) в соответствии со схемой, показанной на рис. 10.4, где RP1 – это 

потенциометр R-0901N-A10K фирмы Song Huei (рис. 10.5) с возможным из-

менением сопротивления от 0 до 10 кОм. Соединения выполнены проводом 

МГТФ 0,12 ТУ 16-505.185-71. 

Анод 

Катод 
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 Рис. 10.4 Рис. 10.5 

   
 Рис. 10.4 Рис. 10.5 

– подготовить отрезки провода длиной примерно по 150 мм из расчёта 

3 шт. на каждый тип светодиода (по цвету свечения). Для этого необходимо 

нарезать отрезки провода нужной дины, у каждого отрезка зачистить концы 

на 2–3 мм и залудить жилы. Зачистка концов провода может выполняться 

специальным инструментом – стриппером (см. рис. 10.6); 
Рис. 10.6 

 
Рис. 10.6 

– подготовить потенциометры из расчета 1 шт. на каждый тип светодио-

да (по цвету свечения); 

– подпаять к среднему и правому (при виде на ручку) выводам каждого 

потенциометра по одному отрезку провода (выводы № 2 и 3 на рис. 10.4); 

– поворотом ручки до упора против часовой стрелки на каждом потен-

циометре между выводами с подпаянными проводами выставить максималь-

ное сопротивление; 

– проконтролировать сопротивление на потенциометрах мультиметром в 

режиме измерения сопротивления (см. прил. Д.1); 

– аккуратно подпаять провода к светодиодам разных типов (желательно, 

чтобы компоненты располагались на ПП близко друг к другу для последую-

щей оценки их яркости свечения): к анодам – от выводов № 3 потенциомет-

ров, к катодам – оставшиеся свободные провода; 

– убедиться, что жилы не замыкают соседние печатные проводники. 

Дергать или отгибать запаянные провода категорически запрещается, так как 

можно оторвать печатные проводники; 
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– включить лабораторный источник питания и установить на нем напря-

жение 3 В. Результат проконтролировать мультиметром в режиме измерения 

постоянного напряжения (см. прил. Д.1); 

– отрицательный вывод источника питания подключить ко всем катодам 

светодиодов (точка № 2 на рис. 10.4), а положительный вывод – ко всем по-

тенциометрам (точка № 1 на рис. 10.4); 

– поворотом ручек потенциометров добиться одинаковой яркости свето-

диодов; 

– отключить положительный вывод источника питания от светодиодов; 

– мультиметром в режиме измерения сопротивления измерить сопро-

тивления между выводами № 2 и 3 каждого потенциометра; 

– убедиться, что все значения принадлежат ряду E24 (см. [1, табл. В.2, 

с. 700]), и записать их. Если получены значение находятся вне ряда, то по-

вторить корректировку яркости; 

– снова подключить положительный вывод источника питания ко всем 

потенциометрам (точка № 1 на рис. 10.4); 

– мультиметром в режиме измерения постоянного напряжения (см. прил. 

Д.1) измерить падения напряжения на каждом светодиоде, участвующем в 

настройке, и записать значения; 

– отключить положительный вывод источника питания от светодиодов; 

– перевести мультиметр в режим измерения постоянного тока (см. прил. 

Д.1) и, последовательно подключая его в разрыв между точкой № 1 с рис. 

10.4 и положительным выводом источника питания, определить и записать 

значения токов, протекающих через компоненты; 

– выключить мультиметр; 

– отключить выводы источника питания; 

– аккуратно отпаять провода от светодиодов. Обратить внимание на то, 

что отсоединять жилы от выводов компонентов можно только после перехо-

да припоя в жидкое состояние. Дергать провода категорически запрещается.  

10. Установить все остальные компоненты с верхней стороны ПП. 

11. С нижней стороны ПП установить проволочные перемычки для со-

единения отдельных частей печатных проводников, принадлежащих к одина-

ковым цепям. 

Особенности установки: 

– каждую перемычку предварительно изгибать в виде буквы «П» по не-

обходимому расстоянию между отверстиями; 
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– после вставки в отверстия перемычку плотно прижать к нижней сто-

роне ПП и удерживать так (например, зубочисткой) все время пайки; 

– после монтажа не откусывать все концы перемычек с верхней стороны 

ПП, а оставить по одному для каждой цепи коллектора транзистора и цепи 

земли (если такой конец есть) для последующего подключения к ним щупов 

осциллографа. 

12. Установить батарейный отсек. 

13. Аккуратно почистить печатный узел от флюса (см. п. 5).  

10.2. Результаты выполнения этапа 

Результат выполнения этапа № 10 – печатный узел. 

В отчете необходимо привести: 

1. Массу ПП после лужения. 

При выполнении дополнительного задания № 7 обновить массу в основ-

ной надписи чертежа ПП. 

2. Результаты выбора токоограничивающего резистора для каждого типа 

светодиода (по цвету свечения): 

– измеренное значение прямого тока; 

– измеренное значение прямого напряжения; 

– номинал токоограничивающего резистора; 

– сравнение с расчетными значениями. 

10.3. Подготовка к этапу № 11 

Перед началом этапа № 11 необходимо: 

– согласовать с преподавателем дату и время работы (обратить внимание 

на минимальное время выполнения этапа по табл. 1.1);  

– ознакомиться с основными органами управления осциллографа и при 

желании потренироваться в работе на его виртуальной модели по прил. Д.2; 

– ознакомиться с возможными причинами неправильной работы изделия 

и способами их устранения по прил. Ж; 

– ознакомиться с последовательностью действий на этапе № 11. 
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11. ВКЛЮЧЕНИЕ ИЗДЕЛИЯ 

11.1. Последовательность действий 

На данном этапе необходимо убедиться в работоспособности изделия и 

получить осциллограммы сигналов на коллекторах транзисторов. 

Последовательность действий по выполнению этапа следующая: 

1. Визуально проконтролировать отсутствие лишних электрических со-

единений, которые могли появиться между элементами разных электриче-

ских цепей в процессе лужения ПП и монтажа компонентов. 

При обнаружении подобных дефектов удалить их паяльником, предва-

рительно нанеся на эти области флюс. 

2. С помощью мультиметра в режиме прозвонки цепей (см. прил. Д.1) 

или в режиме измерения сопротивления убедиться в отсутствии короткого 

замыкания между выводами батарейного отсека. 

Если обнаружено замыкание, то еще раз выполнить п. 1, а также прове-

рить правильность установки компонентов на их посадочные места. Только 

после исправления этого дефекта можно переходить к следующему пункту. 

3. Установить батарейку в батарейный отсек и убедиться в полной рабо-

тоспособности изделия. 

Если что-то не работает или работает неправильно, то разобраться в 

причинах и устранить их (см. прил. Ж). 

4. Получить осциллограммы процессов, происходящих на коллекторах 

транзисторов: 

– включить осциллограф (см. прил. Д.2);  

– подключить щупы осциллографа к концам перемычек, запаянных к 

цепям коллекторов транзисторов; 

– подключить землю любого щупа к отрицательному выводу батарейно-

го отсека; 

– выставить масштабирующие коэффициенты по амплитуде для каждого 

канала и подобрать положение осциллограмм так, чтобы на экране осцилло-

графа сигналы не пересекались друг с другом;  

– выставить масштабирующий коэффициент по времени так, чтобы на 

экране осциллографа поместилось 1,5–3 периода работы мультивибратора; 

– сфотографировать результат; 

– отсоединить щупы осциллографа от изделия; 

– выключить осциллограф. 
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5. Откусить оставшиеся концы перемычек. 

6. Взвесить изделие с батарейкой и сохранить результат в отчет. 

7. Сфотографировать работающее изделие с верхней и нижней стороны. 

8. Извлечь батарейку из батарейного отсека, взвесить изделие и сохра-

нить результат в отчет. 

9. Измерить общее потребление изделия: 

– включить лабораторный источник питания и установить на нем напря-

жение 3 В. Результат проконтролировать мультиметром в режиме измерения 

постоянного напряжения; 

– отрицательный вывод источника питания подключить к соответству-

ющему выводу батарейного отсека; 

– перевести мультиметр в режим измерения постоянного тока; 

– подключить мультиметр в разрыв между положительным выводом ис-

точника питания и соответствующим выводом батарейного отсека; 

– записать значение тока. 

11.2. Результаты выполнения этапа 

Результат выполнения этапа № 11 – функционирующее изделие.  

В отчете необходимо привести: 

1. Описание ошибок, обнаруженных при включении изделия, и способов 

их устранения (при наличии). 

2. Ток потребления изделия и ожидаемое время работы от одной бата-

рейки. Результаты сравнить с рассчитанными в разд. 4. 

3. Осциллограммы процессов на коллекторах транзисторов. 

При выполнении дополнительного задания № 1 сравнить результаты. 

Если указанное задание не выполнялось, то проделать следующее: 

– пояснить причину наличия пологих передних фронтов у импульсов; 

– определить время открытого состояния каждого транзистора и период 

работы мультивибратора (данные сравнить с расчетными). 

4. Массу печатного узла с батарейкой и без нее. 

При выполнении дополнительного задания № 4 сравнить результаты. 

При выполнении дополнительного задания № 9 обновить массу в основ-

ной надписи сборочного чертежа. 

5. Фотографии работающего изделия (с верхней и нижней стороны). 
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ПРИЛОЖЕНИЯ 

А. Копирование фрагмента топологии 

А.1. Команда Paste Special 

В данном приложении описан способ копирования проводящего рисунка 

(печатные проводники, посадочные места и переходы) с помощью команды 

Paste Special на примере ПП с рис. 6.1, где требуется повторить топологию с 

одного луча на всех остальных (массив по окружности). Данный способ с 

точки зрения правильности проектирования является плохим, но в случае не-

большого числа компонентов и копий может оказаться весьма быстрым. 

Последовательность действий: 

1. На любом удобном луче (исходный луч) расставляются компоненты и 

выполняется трассировка. 

Действия можно выполнить на повернутой до удобного положения ко-

пии луча с последующим поворотом и возвратом объектов на исходный луч.  

2. Из файла трассировки удаляются (клавиша Delete) все компоненты, 

которые должны быть размещены на лучах, куда планируется сделать копии. 

3. На исходном луче выделяются все объекты, которые будут копиро-

ваться, и вырезаются (Ctrl+X) относительно центра ПП. 

4. Запускается команда Edit ⇒ Paste Special, в появившемся окне отклю-

чаются все опции и нажимается кнопка Paste Array. 

В следующем окне задаются следующие настройки:  

– в поле Item Count – число элементов в массиве (по числу лучей); 

– в группе Array Type выбирается опция Circular (по окружности); 

– включается опция Rotate Item to Match (каждая копия будет повернута 

на указанный угол); 

– в поле Spacing (degrees) задается шаг угла поворота копий. 

На рис. А.1 приведены настройки для примера ПП с рис. 6.1. 

После этого в рабочем поле щелчками ЛКМ указываются две точки в 

центре ПП: центр массива и положение первого элемента массива. 

Комментарии к результату выполненной команды: 

– элементы топологии на всех лучах теряют принадлежность к электри-

ческим цепям, за исключением тех элементов, которые при вставке будут 

иметь контакт с ранее размещенными и подключенными объектами; 

– компоненты на исходном луче останутся со своими позиционными 

обозначениями, которые были у них до вырезания; 
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Рис. А.1 

 
Рис. А.1 

– компоненты на всех лучах, кроме исходного, получат позиционные 

обозначения аналогичных компонентов с исходного луча, но с постфиксом в 

виде нижнего подчеркивания и порядкового номера, который увеличивается 

в направлении против часовой стрелки («_1», «_2» и т. д.). 

5. Для компонентов на лучах, кроме исходного, записывается соответ-

ствие их позиционных обозначений (с постфиксами) указанным на схеме. 

6. Данные из п. 5 записываются в проект с помощью команды Project ⇒ 

Component Links.  

В появившемся окне кнопкой «>» каждая пара позиционных обозначе-

ний перемещается из левой половины появившегося окна в правую, после че-

го нажимается кнопка Perform Update. 

7. Выполняется восстановление цепей и позиционных обозначений на 

ПП, для чего переносятся изменения со схемы (например, при текущей 

вкладке с файлом ПП командой Design ⇒ Import Changes From).  

При наличии цветовых настроек в файле ПП отключить в появившемся 

окне Engineering Change Order изменения в группе Change Net Colors. 

8. Если в копируемых с исходного луча объектах были переходы, то для 

их быстрого подключения к соответствующим цепям служит команда 

Design ⇒ Netlist ⇒ Update Free Primitives From Component Pads. 

А.2. Объекты Room 

В данном приложении описан способ копирования проводящего рисунка 

с помощью объектов Room (комната) и характерен для иерархических мно-

гоканальных проектов (см. [1, с. 820]). Способ можно использовать и в обыч-

ных (плоских) проектах, но с предварительным созданием классов, комнат, 

канала (каналов) и указанием одинаковых компонентов в этих классах из со-

става канала (каналов). 
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Как и в прил. А.1 здесь рассматриваются действия на примере ПП с рис. 

6.1, где требуется повторить топологию с одного луча на всех остальных. 

Подготовительные действия по настройке проекта: 

1. В настройках проекта по [1, пп. 7.1 и 7.2, с. 229]: 

– отключается создание классов и комнат для листа (листов); 

– включается создание пользовательских классов (Generate Component 

Classes) и комнат для них (Generate Rooms for Component Class). 

2. В схеме каждая группа компонентов, которая будет находиться на от-

дельном луче, объединяется в уникальный класс по [1, п. 9.4, с. 266].  

Пример названия – LEDN, где «N» – номер группы (луча). 

3. Изменения переносятся из схемы в файл ПП (например, при текущей 

вкладке со схемой командой Design ⇒ Update PCB Document). 

При наличии цветовых настроек в файле ПП отключить в появившемся 

окне Engineering Change Order изменения в группе Change Net Colors. 

4. При активной вкладке с ПП выполняется команда Design ⇒ Classes. 

В левой части открывшегося окна в группе Design Channel Classes созда-

ется новый класс канала (например, с именем RAY), после чего в правой ча-

сти окна в него добавляются все созданные классы LEDN. 

5. Одинаковым компонентам в классах LEDN назначаются одинаковые 

значения параметра Channel Offset одним из двух способов: 

5.1. Если на схеме у таких компонентов беспорядочные позиционные 

обозначения, то для каждой группы выполняется следующее: 

– они выделяются на схеме (ЛКМ+Shift); 

– в панели PCB Inspector (вкладка с ПП) осуществляется щелчок ЛКМ 

по значению параметра с последующим нажатием клавиши Enter. 

5.2. Если на схеме у таких компонентов позиционные обозначения име-

ют определенный порядок, то выполняется следующее: 

– в панели PCB Filter создается заготовка запроса для выделения компо-

нентов класса по примеру IsComponent and InComponentClass('LED1'); 

– запросом выделяются компоненты любого класса; 

– открывается панель PCB List и в верхней части включается режим Edit 

для объектов selected objects; 

– обращается внимание на порядок записи позиционных обозначений в 

столбце Name (например, от большего к меньшему), после чего выполняется 

копирование всех значений из столбца Channel Offset; 

– панель PCB List оставляется открытой; 
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– в панели PCB Filter в запросе меняется название класса на следующий 

и выделяются его компоненты; 

– в панели PCB List для такого же порядка позиционных обозначений 

вставляются значения из буфера в столбец Channel Offset; 

– повторяются последние три действия для оставшихся классов компо-

нентов, после чего панель PCB List закрывается. 

На этом предварительную настройку проекта можно считать завершен-

ной. Теперь система каждый класс компонентов LEDN воспринимает как 

один канал RAY, повторяющийся «N» раз, а одинаковые компоненты в клас-

сах определяет по одинаковому значению параметра Channel Offset. 

Также следует отметить, что описанные действия со схемой – наиболее 

быстрый способ создания классов компонентов и соответствующих комнат 

для них. В файле ПП на это потребовалось бы гораздо больше времени. 

Последовательность действий по созданию копий топологии: 

1. На любом удобном луче (исходный луч) расставляются компоненты и 

выполняется трассировка. 

Действия можно выполнить на повернутой до удобного положения ко-

пии луча с последующим поворотом и возвратом объектов на исходный луч. 

2. На добавленных комнатах (левый нижний угол рабочего поля) выпол-

няется команда ПКМ ⇒ Room Actions ⇒ Wrap Rectangular Room Around 

Components и осуществляются последовательные щелчки ЛКМ по ним. 

В результате каждая комната будет отрисована вокруг компонентов того 

класса, к которому она назначена. 

3. Размеры комнаты (исходная комната), в которой находятся компонен-

ты того класса, для которых была выполнена трассировка, изменяются так, 

чтобы вся топология полностью попала в ее очертания. 

Комната выделяется ЛКМ+Shift. При необходимости редактирования 

вершин комнаты (как у полигона) запускается команда ПКМ ⇒ Room Actions 

⇒ Edit Polygonal Room Vertices. 

4. Комнаты с остальными классами на следующем шаге примут форму и 

размеры исходной комнаты, поэтому они расставляются за пределами ПП с 

достаточным интервалом, чтобы не налезть друг на друга. 

Перемещение комнаты – зажатая ЛКМ. 

5. Выполняется команда Design ⇒ Rooms ⇒ Copy Room Formats, после 

чего в рабочем поле ЛКМ сначала указывается исходная комната, а затем 

комната, в которую будет скопирована топология. 
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В появившемся окне в группе Channel to Channel Component Matching 

проверяется опция Match Components By Channel Offsets. 

Остальные настройки оставляются по умолчанию. 

Следует обратить внимание, что для копирования переходов необходи-

мо в группе Touching Objects Options включить опцию Copy All Objects 

Touching the Room, но в результате все проводники, связанные с ними, будут 

подключены к цепям, которые были у них в исходной комнате. Проблема 

решается после выполнения следующего пункта по п. 8 из прил. А.1. 

6. Нажимается кнопка OK и в появляющихся информационных окнах 

также нажимаются кнопки с утвердительными ответами. 

После этого без отмены команды ЛКМ указывается следующая комната, 

в которую будет скопирована топология, и описанные действия из данного 

пункта повторяются для оставшихся комнат. 

7. Выполняется подготовка к повороту комнат с топологиями: 

– определяется расстояние от центра ПП до любой характерной точки в 

топологии исходной комнаты, располагающейся на вертикальной или гори-

зонтальной оси; 

– выполняется команда G ⇒ M; 

– в появившемся окне создается полярная сетка (ПКМ ⇒ Add Polar Grid) 

и включается опция Non Comp;  

– осуществляется переход в свойства созданной сетки, где задаются сле-

дующие параметры (см. [1, с. 849 и 850]): шаг по углу – половина угла между 

лучами; шаг по радиусу – определенное ранее расстояние; диапазон углов – 

от 0 до 360; диапазон изменения радиуса – от 0 до 1,5–2 от определенного 

ранее расстояния; 

– применяются все изменения. 

8. Массовым выделением мышкой выделяется комната со всей тополо-

гией для поворота и перемещения на выбранный луч, при этом необходимо 

обратить внимание на цветовую схему размещения светодиодов на лучах и 

их подключение к мультивибратору. 

После этого выполняется команда E ⇒ M ⇒ O (Edit ⇒ Move ⇒ Rotate Se-

lection) с вводом угла поворота и последующим указанием в выделенных 

объектах характерной точки, до которой в исходной комнате определялось 

расстояние. 

Затем выполняется команда E ⇒ M ⇒ S (Edit ⇒ Move ⇒ Selection) и вы-

деленные объекты перемещаются за ту же характерную точку до срабатыва-
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ния привязки на пересечении соответствующего полярного радиуса и угла в 

полярной сетке около выбранного луча. 

9. Оставшиеся комнаты с топологиями поворачиваются и перемещаются 

в соответствии с предыдущим пунктом. 

10. Выполняется команда G ⇒ M и в появившемся окне удаляется (или у 

нее отключается опция Non Comp) созданная полярная сетка. 
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Б. Настройки в VisualCADCAM  

Б.1. Настройки геометрии фрезы 

Назначение параметров в геометрии фрезы: 

– Shank Dia. – диаметр хвостовика; 

– Tool Len. – длина фрезы, выступающей из цангового патрона; 

– Flute Len. – длина режущей части фрезы; 

– Tool Dia. – диаметр режущей части фрезы; 

– Shoulder Len. – длина от вершины фрезы до хвостовика; 

– Name – название инструмента в списке (может быть любым). 

Б.2. Настройки свойств фрезы 

Назначение отдельных параметров в свойствах фрезы: 

– Material – материал фрезы (HSS – быстрорежущая сталь); 

– Number of Flutes – количество режущих кромок; 

– Tool Number – порядковый номер инструмента. 

Б.3. Настройки управления фрезой 

Назначение отдельных параметров в настройках управления фрезой: 

– Speed – скорость вращения (количество оборотов в минуту); 

– Direction – направление вращения (CW – по часовой стрелке, CCW – 

против часовой стрелки); 

– Feed Rates – скорость подачи на разных этапах фрезеровки (скорость 

перемещения, миллиметры в минуту); 

– Plunge – подача при подходе фрезы к материалу по вертикальной тра-

ектории до касания; 

– Approach – подача при подходе фрезы к материалу до касания (тип 

траектории зависит от настроек, этап может отсутствовать); 

– Engage – подача при погружении фрезы в материал; 

– Cut – подача при обработке материала; 

– Retract – подача при выходе фрезы из материала; 

– Departure – подача при отводе фрезы от материала (тип траектории за-

висит от настроек, этап может отсутствовать); 

– Transfer – подача при перемещении фрезы над поверхностью материа-

ла (Use Rapid – использование максимальной скорости подачи двигателя); 

– Feed Rate Reduction Factors – уменьшение скорости подачи в процен-

тах от параметра Cut; 
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– Plunge between levels – уменьшение скорости подачи при погружении 

фрезы в следующий слой материала; 

– First XY Pass – уменьшение скорости подачи при движении в горизон-

тальной плоскости, когда ширина реза совпадает с диаметром фрезы; 

– Bottom Z Level – уменьшение скорости подачи при движении фрезы по 

нижнему слою. 

Б.4. Настройки цангового патрона 

Назначение параметров при настройке цангового патрона: 

– Diameter – диаметр цилиндра; 

– Length – высота цилиндра; 

– Taper – угол наклона. 

Назначение кнопок: 

– Add as New – добавление нового сегмента; 

– Save to Active – сохранение настроек для выделенного сегмента; 

– Move Up и Move Down – изменение положения сегментов по вертика-

ли (вверх и вниз соответственно); 

– Remove All и Remove Active – удаление всех сегментов и только ак-

тивного соответственно. 

Б.5. Настройки вкладки Clearance Plane 

Группа Clearance Plane Definition предназначена для определения поло-

жения плоскости безопасного перемещения инструмента. Заданное на рис. 

8.7 значение для параметра Absolute Z Value означает, что эта плоскость бу-

дет располагаться на высоте 4 мм (по оси Z) от начала координат. Изменения 

в этой группе сразу же отображаются в рабочем поле. 

В текущей разработке были загружены только контуры, поэтому верх-

ней поверхностью заготовки (Stock Max Z) и модели (Part Max Z) также счи-

тается плоскость X0Y, в которой они расположены. 

Опция Clearance Plane в группе Cut Transfer Method означает, что ин-

струмент поднимается до указанной плоскости, а затем перемещается в сле-

дующую область обработки. 

Б.6. Настройки вкладки Cut Parameters 

Вид вкладки Cut Parameters в использованных в данном пособии опера-

циях различается: 

1. Комментарии к настройкам с рис. 8.8 (операция Profiling): 
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1.1. Параметр Tolerance в группе Global Parameters – точность, допусти-

мое отклонение от идеальной криволинейной траектории (задано 0,01 мм). 

1.2. Параметр Stock в группе Global Parameters – толщина слоя, который 

останется на поверхности детали после завершения перемещения инструмен-

та (задано 0 мм). 

Значение этого параметра используется для разных этапов обработки 

(черновая – оставляется небольшой слой, чистовая – оставшийся слой полно-

стью снимается). Однако здесь можно указать не только положительное чис-

ло, но и отрицательное (снимается дополнительный слой материала), что 

подходит для компенсации диаметра инструмента. 

1.3. В группе Cut Direction задается направление резания: 

– Climb (Down Cut) – попутное фрезерование (фрезерование по пода-

че) – в месте контакта с заготовкой направление вращения фрезы противопо-

ложно перемещению последней (рис. Б.1). Толщина среза в этом случае ме-

няется от максимального значения (подача на зуб) при входе зуба в заготовку 

до нуля при выходе зуба из контакта. Стружка удаляется за зубом, поэтому 

вероятность повторного резания уже срезанного материала снижается. Из-за 

больших усилий, возникающих в начале каждого прохода (фактически удар), 

станки и шпиндели должны быть более жесткими. Кроме того, необходимо 

контролировать люфт инструмента, чтобы не допустить резкое увеличение 

подачи на зуб. Обычно используется при чистовой обработке и при обработ-

ке поверхностей тонких деталей. Нельзя использовать, например, по окалине, 

так как инструмент быстро тупится; 
 Рис. Б.1  Рис. Б.2 

   

 Рис. Б.1 Рис. Б.2 

– Conventional (Up Cut) – встречное фрезерование (фрезерование против 

подачи) – в месте контакта с заготовкой направление вращения фрезы совпа-

дает с перемещением последней (рис. Б.2). Толщина среза в этом случае ме-

няется от нуля при входе зуба в заготовку до максимального значения при 

выходе зуба из контакта (подача на зуб). Стружка выбрасывается вверх перед 

зубом, поэтому может произойти повторное врезание в нее, что приводит к 

более грубой обработке поверхности. Возникает более быстрое изнашивание 
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инструмента из-за повышенного трения (и нагрева), так как зуб перед нача-

лом реза некоторое время скользит по поверхности, обработанной предыду-

щим зубом. Обычно используется при черновой обработке, на старых стан-

ках и обработке материалов с шероховатой или закаленной поверхностью; 

– Mixed – комбинация попутного и встречного фрезерований. Обычно 

используется при чистовой обработке, когда удаляются небольшие объемы 

материала. Позволяет уменьшить количество промежуточных перемещений 

инструмента и уменьшить время обработки. 

1.4. Настройка опции Use Outside/Inside for Closed Curve из группы Cut-

ting Side определяет сторону замкнутого контура, с которой перемещается 

инструмент: Outside – снаружи, Inside – внутри. 

Так как все контуры являются замкнутыми, то настройка параметров 

Right of Curves и Left of Curves (справа и слева от контура соответственно) ни 

на что не влияет. 

Опция Alternate using Nesting позволяет определить сторону обработки 

во вложенных замкнутых контурах (снаружи и внутри; внутри и снаружи). 

1.5. Настройки в группе Stepover Control определяют ширину и шаг зоны 

обработки. 

1.6. Опция Perform Corner Cleanup позволяет создать дополнительную 

траекторию для конечного прохода инструмента и удаления необработанных 

областей, которые могут остаться после основных проходов. 

2. Комментарии к настройкам с рис. 8.12 (операция Hole Profiling): 

2.1. Параметр Tolerance в группе Global Parameters – см. п. 1.1. 

2.2. Группа Location of Cut Geometry – см. п. 1 из Б.7. 

2.3. Значение в группе Hole Depth (H) – глубина погружения инструмен-

та. Здесь можно записать как заранее известное число, так и определить его 

прямо по модели (с соответствующими привязками). 

Для гарантированного прохода через весь материал значение задано с 

небольшой добавкой. 

2.4. Опция For arcs, use arc diameter в группе Hole Diameter (D) автома-

тически устанавливает значения диаметров отверстий по диаметрам конту-

ров (для всех точек будет одинаковый диаметр из поля For points). 

2.5. Группа Cut Direction – см. п. 1.3. 

2.6. Группа Helix Pitch – параметры спиральной траектории, по которой 

инструмент погружается в материал: Height (h) – шаг, Angle (A) – угол. 

В примере задан шаг 0,1 мм для уменьшения нагрузки на фрезу. 
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Б.7. Настройки вкладки Cut Levels 

Комментарии к настройкам с рис. 8.9: 

1. Назначение настроек группы Location of Cut Geometry (расположение 

поверхности для начала реза): 

– At Top – поверхность начала реза проходит через верхнюю кромку за-

готовки, инструмент будет погружаться от этой точки по оси Z на заданную 

глубину (параметр Total Cut Depth); 

– At Bottom – поверхность начала реза находится в точке нижней кромки 

заготовки, инструмент начнет погружение с заданного расстояния над этой 

поверхностью (параметр Total Cut Depth); 

– Pick Top – поверхность начала реза проходит через заданную в сосед-

нем поле абсолютную координату Z. Поведение инструмента аналогично оп-

ции At Top. Значение координаты можно не только записать вручную, но и 

указать ее прямо на модели (с соответствующими привязками). 

2. Назначение настроек группы Cut Depth Control (управление глубиной 

погружения инструмента): 

– Total Cut Depth – суммарное заглубление; 

– Rough Depth и Rough Depth/Cut – суммарная глубина черновой обра-

ботки и шаг послойного погружения соответственно; 

– Finish Depth и Finish Depth/Cut – суммарная глубина чистовой обра-

ботки и шаг послойного погружения соответственно. 

В поле параметра Total Cut Depth можно записать значение не только в 

виде заранее известного числа, но и определить его прямо по модели (с соот-

ветствующими привязками). 

Для гарантированного снятия слоя материала для фольги 18 мкм в Total 

Cut Depth записано значение на 0,01 мм больше, чем ее толщина. По анало-

гичной причине заданы значения для отверстий и внешнего контура ПП. 

Последние четыре параметра позволяют управлять перемещением ин-

струмента при обработке по вертикали. Шаг погружения обычно не должен 

превышать половины диаметра инструмента (зависит от материала) для 

предотвращения поломки последнего, поэтому шаг для фрезы диаметром 

0,5 мм был задан равным 0,2 мм, а для фрезы диаметром 0,8 мм – 0,3 мм. 

3. Настройки в группе Cut Levels Ordering задают порядок снятия слоев 

материала: Depth First – переход к следующей полости только после полного 

завершения текущей, Level First – переход к следующему слою только после 

прохода всех полостей. 
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Б.8. Настройки раздела Simulation окна Preferences 

Опция Polygonal Model из группы Simulation Model – высококачествен-

ная модель моделирования. 

В группе Simulation Mode доступны следующие настройки: 

– Simulate by Distance – плавное движение по сегментам траектории; 

– Simulate by Moves – режим движения инструмента рывками от начала 

сегмента к концу; 

– ползунок – скорость перемещения инструмента от Min до Max; 

– Maximum Display Interval – шаг между двумя соседними положениями 

инструмента при перемещении (чем меньше, тем медленнее движется ин-

струмент; можно задавать дробные значения, в том числе и менее единицы). 

В группе Simulation Accuracy ползунком можно менять точность симу-

ляции (Standard – обычная, Medium – средняя, Fine – отличная). 

В группе Stock Model Simulation Display Transparency ползунком можно 

менять прозрачность заготовки от Opaque (непрозрачная) до Transparent 

(прозрачная). 

Б.9. Настройки постпроцессора 

В подавляющем большинстве случаев настройки выбранного постпро-

цессора (см. 8.9) менять не требуется, однако все же может возникнуть ситу-

ация, при которой сгенерированный G-код воспринимается программой, 

управляющей станком с ЧПУ, с ошибкой. 

Примером подобной ошибки является чтение параметров команды по-

строения дуг (G02 или G03). Изменить их можно следующим образом: 

– в дереве проекта дважды щелкнуть ЛКМ по объекту «Post…»; 

– в появившемся окне в группе Select Post Processor рядом с выбранным 

постпроцессором Mach3-MM нажать кнопку Edit (при появлении окна с пре-

дупреждением нажать кнопку OK); 

– в настройках постпроцессора перейти в раздел Circle и в группе Output 

Format выбрать опцию Radius only; 

– сохранить изменения кнопкой Save. 

После выполнения изменений в настройках постпроцессора необходимо 

обновить траектории перемещения инструментов (команда Regenerate) и пе-

ресоздать программы для всех операций (команда Post). 
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В. Особенности работы в Mach3 

В.1. Загрузка NC-файла 

Загрузка NC-файла осуществляется кнопкой Load G-Code (или командой 

File ⇒ Load G-Code). После этого G-код появляется в соответствующей обла-

сти, и Mach3 автоматически проверяет его на наличие ошибок. Если есть 

ошибка, то загрузка остановится на проблемной строке.  

Текущая строка всегда находится на белом фоне, а ее номер отображает-

ся в поле Line. Кроме того, двойное нажатие ЛКМ по области с текстом про-

граммы позволяет показать (и скрыть) номера строк, что может оказаться 

удобным при остановке и перезапуске программы. 

По загруженному тексту программы можно перемещаться с помощью 

ползунка или колесика мышки, при этом текущая операция отображается в 

области просмотра. 

Дополнительные кнопки по работе с NC-файлом: 

– Edit G-Code – редактирование загруженного файла; 

– Close G-Code (или команда File ⇒ Close File(s)) – закрытие файла; 

– Recent Files – список ранее загруженных файлов; 

– G-Codes – подробное описание G-команд; 

– M-Codes – описание M-команд. 

В.2. Область просмотра 

При успешной загрузке NC-файла все траектории инструмента отобра-

жаются в области просмотра, которая в больших размерах представлена так-

же на вкладках MDI и Tool Path. 

С правой стороны этой области находится шкала, представляющая со-

бой ось Z с нулем в месте расположения горизонтальной красной черты. Зе-

леная стрелка – вершина инструмента. Она перемещается по шкале в процес-

се выполнения программы и показывает текущее положение инструмента. 

Например, на рис. 9.5 в данный момент конец инструмента находится на 

плоскости X0Y. 

Управление областью просмотра: 

– перемещение мышки с зажатой ПКМ – перемещение изображения; 

– перемещение мышки с зажатой ЛКМ – переход в 3D-отображение тра-

екторий и поворот изображения; 

– двойной щелчок ЛКМ – переход от вида сверху к изометрическому и 

наоборот; 
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– колесико мышки – изменение масштаба изображения; 

– кнопка Jog Follow – при запущенном выполнении программы инстру-

мент располагается в центре области просмотра, а перемещается изображе-

ние. 

В.3. Управление выполнением NC-файла 

Запуск выполнения G-кода осуществляется кнопкой Cycle Start. В боль-

шинстве случаев до окончания работы станка больше ничего делать не тре-

буется (если только в программе не предусмотрена смена инструмента). 

Однако бывают ситуации, требующие вмешательства оператора: 

1. Кнопка Feed Hold – приостановка (пауза). Инструмент прекращает пе-

ремещаться, но шпиндель продолжает работать (при необходимости его 

можно отключить вручную клавишей F5 или кнопкой Spindle CW F5). 

Возобновление выполнения программы – кнопка Cycle Start. При этом 

крайне важно предварительно убедиться в том, что шпиндель работает (вра-

щается), иначе инструмент в большинстве случаев можно сломать.  

2. Кнопка Stop – остановка. Инструмент моментально прекращает пере-

мещаться, шпиндель останавливается. 

Возобновление программы – по описанию к кнопке Feed Hold. 

3. Кнопка Rewind – возврат в начало программы. Следующий запуск бу-

дет осуществляться с нулевой строки. 

Действие может быть выполнено после остановки (или приостановки) 

выполнения программы. 

4. Кнопка Single BLK – построчное выполнение программы. После акти-

вации данной команды каждое нажатие кнопки Cycle Start приводит к вы-

полнению только одной строки программы. 

Действие может быть выполнено либо перед первым запуском програм-

мы, либо только после ее остановки. 

5. Кнопка Set Next Line – выполнение программы с указанной строки без 

учета всех предыдущих строк.  

Последовательность действий: 

– ввести номер строки в поле Line и нажать клавишу Enter; 

– нажать кнопку Set Next Line;  

– запустить выполнение программы кнопкой Cycle Start. 

6. Кнопка Run From Here – выполнение программы с указанной строки c 

учетом всех предыдущих строк. 
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Последовательность действий: 

– ввести номер строки в поле Line и нажать клавишу Enter; 

– нажать кнопку Run From Here;  

– кнопкой Cycle Start запустить просчет программы и определение 

начальных координат инструмента; 

– в появившемся окне (пример показан на рис. В.1) проверить начальные 

координаты, с которых начнется выполнение программы; задать высоту без-

опасного перемещения инструмента (инструмент сначала совершит переме-

щение по оси Z до указанного значения, потом переедет в точку с координа-

тами X и Y, а уже после этого опустится до указанной координаты Z); прове-

рить включение шпинделя (Start Spindle) и нажать OK; 
Рис. В.1 

 
Рис. В.1 

– запустить выполнение программы кнопкой Cycle Start. 

7. Кнопка On/Off со значением в поле Z inhibit – инструмент не сможет 

опуститься ниже указанного значения. 

Действие может быть выполнено после остановки (или приостановки) 

выполнения программы. 
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Г. Сканирование поверхности и корректировка NC-файлов 

Г.1. Общие сведения 

Сканирование поверхности (создание карты высот) может использовать-

ся не только для получения ее 3D-модели, но и для корректировки положе-

ния инструмента по вертикали при фрезеровке: верхняя поверхность заготов-

ки не соответствует идеальной горизонтальной плоскости по причине неров-

ной поверхности рабочего стола станка (или его фальшстола), деформаций в 

исходной заготовке, перекоса заготовки после ее крепления. В случае работы 

с небольшими погружениями инструмента в материал, как при фрезеровке 

проводящего рисунка, даже небольшие неровности могут привести к тому, 

что слой меди в отдельных местах снят не будет (инструмент или только по-

царапает поверхность, или вообще пройдет над ней). 

Сканирование поверхности будет выполняться в программе Mach3 по 

специально генерируемому G-коду, а корректировка NC-файлов по получен-

ным данным – в программе G-Code Ripper.  

Г.2. Корректировка одного NC-файла 

При необходимости корректировки только одного NC-файла предлага-

ется следующая последовательность действий: 

1. Открыть G-Code Ripper. 

2. Убедиться, что в настройках (команда Settings ⇒ General Settings) те-

кущие единицы измерения – миллиметры (mm).  

Если потребовалось изменение, то нажать кнопку Save (сохраняет 

настройки программы, в том числе и заданные в главном окне) и закрыть ок-

но кнопкой Close. 

3. В группе G-Code Operations выбрать опцию Auto Probe. 

4. Загрузить NC-файл с проводящим рисунком и отверстиями командой 

File ⇒ Open G-Code File. 

5. В группе Auto-Probe Properties задать следующие настройки: 

– Probe Z Safe – «1» (высота безопасного перемещения инструмента); 

– Probe Depth – «–0.3» (максимальное погружение инструмента); 

– Probe Feed – «100» (скорость погружения инструмента; обычно чем 

ниже скорость, тем выше точность результата); 

– X Points и Y Points – 9 (количество точек сканирования поверхности по 

осям X и Y соответственно; отображаются в виде белых крестов); 

– Controller – MACH3 (управляющая программа). 
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Величины параметров Probe Z Safe и Probe Depth зависят от неровностей 

и наклона сканируемой поверхности, но так как ПП достаточно плоская и 

находится на условно горизонтальной поверхности, то перепады ожидаются 

до десятой доли миллиметра. 

Пример результата на данном этапе показан на рис. Г.1. 
Рис. Г.1 

 
Рис. Г.1 

6. Нажать кнопку «Save G-Code File - Probe Only» и сохранить програм-

му для сканирования с именем Probe и расширением «.nc». 

7. Открыть Mach3 и загрузить созданный файл Probe.nc командой File ⇒ 

Load G-Code. 

8. Убедиться в следующем: 

– инструмент должен находиться в нулевых координатах по трем осям 

(по оси Z он должен касаться ПП), а эта точка соответствовать началу коор-

динат в VCP-файле; 

– выводы датчика касания должны быть подключены к ПП и инструмен-

ту, а в Mach3 на вкладке Diagnostics у параметра Digitize должна быть вклю-

ченная индикация. 
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9. В Mach3 на вкладке Program Run запустить сканирование кнопкой 

Cycle Start с сохранением результирующего файла с именем ProbeResult.txt. 

10. После сканирования в G-Code Ripper выполнить следующее: 

– загрузить созданный файл (карту высот) кнопкой Read Probe Data File 

(после этого белые кресты станут черными); 

– скорректировать значения кнопкой Recalculate; 

– сохранить результат кнопкой «Save G-Code File - Adjusted» с добавле-

нием к имени исходного NC-файла символов «_adj» и расширением «.nc». 

Г.3. Корректировка нескольких NC-файлов 

При необходимости корректировки только одного NC-файла предлага-

ется следующая последовательность действий: 

1. Сгенерировать управляющую программу для сканирования общей для 

всех NC-файлов рабочей поверхности заготовки (см. Г.4). 

2. Открыть Mach3 и загрузить созданный файл с программой для скани-

рования поверхности командой File ⇒ Load G-Code. 

При первом способе из Г.4 программа уже будет загружена. 

3. Убедиться в выполнении условий п. 8 из Г.2. 

4. Запустить сканирование по п. 9 из Г.2. 

5. После сканирования в G-Code Ripper выполнить следующее: 

– при использовании первого способа из Г.4 запустить G-Code Ripper и 

выполнить настройку (см. пп. 1–3 из Г.2). Кроме того, в группе Auto-Probe 

Properties для опции Controller выбрать MACH3; 

– загрузить созданный файл (карту высот) кнопкой Read Probe Data File; 

– загрузить первый NC-файл командой File ⇒ Open G-Code File; 

– сохранить результат кнопкой «Save G-Code File - Adjusted» с добавле-

нием к имени исходного NC-файла символов «_adj» и расширением «.nc»; 

– по аналогии с предыдущими двумя действиями поочередно загружать 

следующие NC-файлы и сохранять результаты. 

Г.4. Сканирование заданной области 

При необходимости сканирования произвольной области поверхности 

управляющую программу можно получить одним из двух способов: 

1. Первый способ быстрый, но позволяет отсканировать область только 

в одном из квадрантов с вершиной в начале координат. 

Выполняется он в Mach3 с помощью надстройки Digitize Wizard (коман-

да Wizards ⇒ Pick Wizard) со следующими настройками: 
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– Width (X) of digitizing area – длина сканируемой области по оси X; 

– Height (Y) of digitizing area – длина сканируемой области по оси Y; 

– Z axis travel height – высота безопасного перемещения инструмента; 

– Z axis Probe Depth – максимальное погружение инструмента;  

– X Stepover – шаг сканирования по оси X; 

– Y Stepover – шаг сканирования по оси Y; 

– Feedrate – скорость подачи; 

– кнопка Check File Size – количество строк в генерируемой программе 

(для справки); 

– кнопка Create and Load G-Code – создание и загрузка в Mach3 управ-

ляющей программы; 

– кнопка Return to main screens – возврат в Mach3 (отмена создания 

управляющей программы). 

Пример настройки для заготовки размерами 100 × 100 мм с шагом по 

5 мм и параметрами перемещения инструмента из Г.2 показан на рис. Г.2. 
Рис. Г.2 

 
Рис. Г.2 

2. Второй способ дольше, но позволяет отсканировать область в любом 

месте заготовки. Для получения G-кода необходимы две программы. 

Сначала в VisualCADCAM создается NC-файл для фрезеровки контура: 

– в проекте с изделием добавляется новый слой и в нем рисуется прямо-

угольный контур (команда Curve Modeling ⇒ Curves ⇒ Rectangle); 
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– создается операция Engraving для обхода инструмента по линии кон-

тура (команда Machining Operations ⇒ 2 Axis ⇒ Engraving); 

– в свойствах операции выбирается контур из созданного слоя, любая 

фреза, задается погружение на любую глубину (например, на 1 мм), отклю-

чаются настройки входа инструмента в материал и выхода из него; 

– для созданной операции выполняется команда Post. 

Затем в G-Code Ripper по пп. 1–6 из Г.2 создается программа для скани-

рования. 
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Д. Приборы для измерений 

Д.1. Мультиметр 

Мультиметр предназначен для выполнения измерений различных вели-

чин, основными из которых являются сопротивление, напряжение и ток. Есть 

модели, которые позволяют измерять емкость, частоту и другие параметры. 

На рис. Д.1 показан прибор MAS830L фирмы IEK.  
Рис. Д.1 

 
Рис. Д.1 

У данного мультиметра есть три гнезда: 

– COM (общий) – для черного щупа; 

– VΩmA – для красного щупа при измерениях напряжения, сопротивле-

ния и тока до 200 мА; 

– 10ADC – для красного щупа при измерении тока от 200 мА до 10 А. 

В центре располагается переключатель режимов работы и пределов из-

мерения (цифра показывает максимальное значение параметра, которое мож-

но измерить в данном режиме, при этом с уменьшением предела увеличива-

ется разрешение): 

– выключение прибора – красный индикатор OFF сверху; 

– измерение постоянного напряжения – белые индикаторы слева вверху 

с пределами от 200 мВ до 600 В; 

– измерение сопротивления – зеленые индикаторы слева внизу с преде-

лами от 200 Ом до 2 МОм; 
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– проверка диодов – белый индикатор со значком диода внизу; 

– прозвонка цепей – красный индикатор внизу; 

– определение коэффициента усиления транзисторов – белый индикатор 

hFE справа внизу; 

– измерение постоянного тока – зеленые индикаторы справа с пределами 

от 200 мкА до 10 А; 

– измерение переменного напряжения – белые индикаторы справа ввер-

ху с пределами 200 и 600 В. 

Д.2. Осциллограф 

Осциллограф предназначен для наблюдения и измерения амплитудных и 

временных параметров электрических сигналов, подаваемых на его входы. 

На рис. Д.2 показан цифровой осциллограф TDS 2014C фирмы Tektronix 

с четырьмя каналами. 
Рис. Д.2 

 
Рис. Д.2 

К основным органам управления данного осциллографа относятся: 

– кнопка питания (находится сверху слева над дисплеем); 

– пять прямоугольных кнопок по вертикали справа от дисплея – мно-

гофункциональные кнопки для выбора действий, которые отображаются на 

дисплее рядом с ними (например, при настройке параметров каналов); 

– цветные кнопки с номерами – вывод на дисплей меню для соответ-

ствующего канала, а также включение и отключение отображения сигнала на 

нем (цвет осциллограммы канала совпадает с цветом кнопки); 
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– ручки «Масштаб» в группе «ВЕРТИК.» – изменение масштаба по оси 

Y отдельно для каждого канала (выставленное для одной клетки значение 

отображается в нижней части дисплея с цветом канала); 

– ручки «Положение» в группе «ВЕРТИК.» – изменение положения ос-

циллограмм по оси Y отдельно для каждого канала; 

– ручка «Масштаб» в группе «ГОРИЗОНТ.» – изменение масштаба по 

оси X (выставленное для одной клетки значение отображается в нижней ча-

сти дисплея); 

– кнопка Horiz в группе «ГОРИЗОНТ.» – вывод на дисплей меню гори-

зонтальной оси; 

– ручка «Положение» в группе «ГОРИЗОНТ.» – изменение положения 

осциллограмм по оси X; 

– кнопка Set to Zero в группе «ГОРИЗОНТ.» – установка нулевого поло-

жения по горизонтали в середину дисплея; 

– кнопка Trig Menu в группе «ЗАПУСК» – вывод на дисплей меню син-

хронизации; 

– ручка «УРОВЕНЬ» в группе «ЗАПУСК» – установка уровня амплиту-

ды для синхронизации по выбранному источнику сигнала; 

– кнопка Auto Set – автоматическая установка параметров для отобра-

жения текущих сигналов; 

– кнопка Run/Stop – непрерывное считывание сигналов и остановка сбо-

ра данных;  

– кнопка «ОДИНОЧН ЗАПУСК» – считывается только часть сигнала, 

которая попала во временной диапазон по оси X, после чего сбор данных 

останавливается. 
Рис. Д.3 

 
Рис. Д.3 
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На рис. Д.3 показан один из щупов осциллографа. С одной стороны он 

имеет соединитель типа BNC для подключения ко входу канала, а с другой 

стороны – ответвление с зажимом типа «крокодил» (для заземления) и шты-

ревой контакт для снятия сигнала. На часть щупа со штыревым контактом 

может устанавливаться насадка с зацепом. 

Поупражняться в работе с осциллографом похожей модели (TDS2024) 

можно в программе Multisim (см. прил. И.1). Добавление инструмента осу-

ществляется командой Simulate ⇒ Instruments ⇒ Tektronix oscilloscope. 
Рис. Д.4 

 
Рис. Д.4 

На рис. Д.4 показан пример подключения осциллографа и его окно 

свойств (двойной щелчок ЛКМ по УГО) с сигналами на коллекторах транзи-

сторов при интерактивной симуляции. Режим отображения результатов из-

мерений в правой части дисплея включается кнопкой «MEASURE». 
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Е. Особенности пайки 

Е.1. Подготовка посадочного места 

Перед монтажом компонентов необходимо убедиться в том, что КП по-

садочного места плоские и на них нет бугорков припоя. 

Пример существенных излишков припоя на КП показан на рис. Е.1: 

скругленный бугорок на правой верхней КП получен при предварительном 

покрытии ее флюсом, а вытянутый бугор на правой средней КП – без флюса. 

Кроме того, в левой части рисунка видно, что некоторые излишки припоя 

есть и на печатных проводниках, а при лужении произошло замыкание до-

рожки на полигон. 
Рис. Е.1 

 
Рис. Е.1 

Следует сделать оговорку, что в некоторых случаях наличие бугорка 

припоя на одной из КП посадочного места может использоваться как воз-

можный вариант монтажа компонента (см. Е.2). 

Если есть излишки припоя, то можно воспользоваться одним из следу-

ющих способов: 

1. Убрать излишки припоя паяльником: 

– нанести на КП немного флюса; 

– чистым жалом паяльника (температура здесь и далее, если не сказано 

иное, – порядка 290 °С) докоснуться до КП, в результате чего часть припоя 

перетечет на жало; 

– вытереть жало о влажную губку; 

– при необходимости повторить процедуру несколько раз; 

– почистить жало и установить паяльник в подставку. 

2. Убрать излишки припоя медной оплеткой: 

– нанести на КП (одну или несколько) немного флюса; 

– разместить на поверх КП оплетку; 

– прижать оплетку жалом паяльника; 

– подождать расплавления припоя и перетекания его в оплетку; 
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– убедиться, что оплетка не припаялась к поверхности, и или ее убрать, 

или аккуратно и медленно протянуть по поверхности ПП по другим КП, с ко-

торых необходимо убрать излишки припоя (паяльник при этом должен быть 

постоянно приложен к оплетке); 

– почистить жало и установить паяльник в подставку. 
Рис. Е.2 

 
Рис. Е.2 

Пример удаления лишнего припоя показан на рис. Е.2. 

При использовании оплетки имеет смысл увеличить температуру жала 

паяльника (например, до 340 °С). 

Е.2. Процесс монтажа 

Необходимо особо обратить внимание на то, что существуют компонен-

ты, отдельные части которых (например, линзы светодиодов и пластиковые 

корпуса некоторых разъемов) нельзя подвергать нагреву из-за возможности 

их разрушения. 

Монтировать компоненты можно одним из двух способов: 

1. Паяльником. 

Последовательность действий: 

– подготовить посадочное место (см. Е.1); 

– нанести на КП посадочного места немного флюса (рис. Е.3); 
Рис. Е.3 

 
Рис. Е.3 
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– одной рукой взять компонент пинцетом и, не отпуская его, аккуратно 

разместить на посадочном месте (рис. Е.4). Постараться это сделать без пере-

косов как в горизонтальной, так и вертикальной плоскостях. При необходи-

мости можно помочь себе вторым пинцетом или зубочисткой; 
Рис. Е.4 

 
Рис. Е.4 

– второй рукой взять на жало паяльника припой; 

– поднести паяльник с припоем к предполагаемому месту пайки; 

– убедиться в том, что компонент никуда не съехал, и поместить припой 

в точку пайки; 

– жало паяльника будет нагревать и КП посадочного места, и вывод 

компонента, в результате чего припой смочит спаиваемые поверхности; 

– убрать жало паяльника из зоны пайки (обычно небольшим рывком); 

– отпустить компонент; 

– запаять второй вывод компонента, при необходимости взяв на жало 

паяльника еще немного припоя; 

– почистить жало и установить паяльник в подставку. 

Многовыводные компоненты паяются с помощью паяльника аналогич-

ным образом. В случае монтажа микросхем имеет смысл сначала припаять 

несколько выводов, находящихся в противоположных углах корпуса (для его 

фиксации), а уже после этого паять все остальные. 

Первую часть описанного способа можно выполнять несколько иначе: 

– на одну из КП посадочного места наносится флюс, после чего – при-

пой для образования небольшого бугорка; 

– компонент подносится к посадочному месту; 

– жалом разогревается КП с припоем; 

– компонент вдвигается в расплавленный припой и позиционируется. 
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2. Паяльным феном. 

Последовательность действий: 

– на КП посадочного места наносится флюс, после чего – припой для 

образования небольших бугорков; 

– наносится новый флюс (старый можно отмыть); 

– компонент позиционируется на посадочном месте; 

– фен включается на температуру порядка 360 °С; 

– осуществляется нагрев всей области с компонентом; 

– после расплавления припоя компонент можно подправить кончиком 

пинцета; 

– фен ставится на подставку; 

– печатный узел забирается только после остывания. 

Е.3. Процесс демонтажа 

Если компонент был припаян неправильно, то его можно демонтировать 

одним из двух способов: 

1. Паяльным феном: 

– в точки пайки наносится небольшое количество флюса; 

– фен включается на температуру порядка 360 °С; 

– осуществляется нагрев места расположения компонента; 

– после того, как припой перешел в жидкое состояние, компонент де-

монтируется пинцетом; 

– фен ставится на подставку; 

– компонент и ПП забираются только после остывания. 

2. Двумя паяльниками: 

– в каждую руку берется по паяльнику; 

– жала паяльников ставятся в точки пайки; 

– после перехода припоя в жидкое состояние компонент аккуратно сни-

мается с посадочного места; 

– жала чистятся и паяльники возвращаются в подставки. 

Способ может потребовать второго человека для удаления компонента 

пинцетом (например, при демонтаже светодиода, чтобы не зацепить линзу). 

Е.4. Проблемы при монтаже 

При монтаже компонентов могут возникать разные проблемы (напри-

мер, на рис. Е.5 из четырех установленных резисторов только правый запаян 

хорошо). Их следует не бояться, а научиться устранять: 
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Рис. Е.5 

 

 
Рис. Е.5 

1. Вывод не припаялся (левые выводы резисторов 68 кОм и 240 Ом на 

рис. Е.5).  

Причины:  

– недостаточный прогрев спаиваемых поверхностей (например, пайка 

осуществляется к большому металлическому полигону); 

– наличие на спаиваемых поверхностях оксидной пленки (недостаточное 

количество или быстрое испарение флюса); 

– недостаточное количество припоя на жале паяльника; 

– расположение припоя на жале паяльника не в точке пайки (припой в 

момент пайки является хорошей средой для эффективной передачи тепла от 

жала к спаиваемым поверхностям, так как в этом месте отсутствует воздуш-

ная прослойка, а общая площадь контакта резко увеличивается по сравнению 

с чистым жалом); 

– большой воздушный зазор между КП и выводом компонента; 

– забывчивость. 

Способы решения: 

– добавить флюс; 

– взять немного больше припоя и убедиться, что он действительно попа-

дает в зону пайки; 

– в момент пайки аккуратно без сильного нажима совершать возвратно-

поступательные движения жалом; 

– увеличить температуру жала (например, до 340 °С) и подольше подер-

жать его в точке пайки (при наличии больших металлических полигонов); 

– выровнять компонент в горизонтальной плоскости при наличии пере-

коса по вертикали для устранения воздушного зазора (может понадобиться 

паяльный фен, если речь идет о многовыводных компонентах). 
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2. Первый вывод припаялся, но компонент встал криво в горизонтальной 

плоскости (резистор 240 Ом на рис. Е.5). 

Последовательность действий: 

– взять компонент пинцетом; 

– поднести жало паяльника в точку пайки и расплавить припой; 

– удерживая жало паяльника в точке пайки, аккуратно скорректировать 

положение компонента; 

– убрать жало паяльника из зоны пайки и через некоторое время отпу-

стить компонент; 

– почистить жало и установить паяльник в подставку. 

3. Первый вывод припаялся, но компонент встал криво в вертикальной 

плоскости (резистор 68 кОм на рис. Е.5). 

Последовательность действий: 

– аккуратно поместить кончик пинцета или зубочистки на верхнюю по-

верхность компонента, но сильно не нажимать, так как можно отломать вы-

вод (или повредить мягкую часть, например линзу); 

– поднести жало паяльника в точку пайки и расплавить припой, в ре-

зультате чего под действием давления от пинцета (зубочистки) компонент 

примет горизонтальное положение; 

– убрать жало паяльника из зоны пайки и через некоторое время отпу-

стить компонент; 

– почистить жало и установить паяльник в подставку. 

4. Нанесено слишком много припоя (резистор 120 кОм на рис. Е.5). 

Если образовался бугорок припоя, то излишки убираются паяльником 

(см. Е.1). Оплеткой в этом случае пользоваться не стоит, так как она может 

забрать его на себя весь (придется добавлять припой заново).  

Если припой замкнул несколько выводов микросхемы, то убрать излиш-

ки можно любым способом из Е.1 (оплетку следует прикладывать к выводам 

над местами пайки, а не на КП, чтобы не забрать весь припой).  

5. Форма припоя в месте пайки не гладкая, а бугристая (правый вывод 

резистора 120 кОм на рис. Е.5). 

Особенно опасны тонкие отростки, которые могут отвалиться при от-

мывке печатного узла от флюса или уже в процессе работы и замкнуть про-

водники разных цепей. 

Последовательность действий: 

– добавить флюс; 
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– поднести жало паяльника в точку пайки и расплавить припой; 

– почистить жало и установить паяльник в подставку. 

6. Требуется сделать перемычку из припоя между двумя компонентами 

или близко расположенными КП (участок в правом верхнем углу ПП на рис. 

Е.4). 

Последовательность действий: 

– удалить флюс из зоны пайки; 

– сформировать на жале относительно большую каплю припоя; 

– поднести жало к одной КП и убедиться, что припой смочил поверх-

ность; 

– попытаться протянуть припой ко второй КП; 

– почистить жало и установить паяльник в подставку. 
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Ж. Поиск причин неправильной работы изделия 

Ж.1. Отсутствие свечения отдельного светодиода 

Если не светится отдельный светодиод, то это означает, что через него 

не протекает ток по следующим возможным причинам: 

– плохой монтаж светодиода; 

– плохой монтаж токоограничивающего резистора; 

– неправильная установка светодиода; 

– наличие короткого замыкания (например, перемычка из припоя между 

рядом проложенными печатными проводниками – см. рис. Е.4); 

– плохой монтаж перемычек; 

– неправильный номинал резистора; 

Поиск дефекта (при отключенном питании): 

– визуальный осмотр области ПП с проблемным светодиодом; 

– проверка светодиода мультиметром в режиме проверки диодов (см. 

прил. Д.1) с подключением щупов к его контактам (плюс – анод, минус – ка-

тод), что позволит определить правильность установки компонента; 

– проверка светодиода мультиметром в режиме проверки диодов с под-

ключением щупов к печатным проводникам, подходящим к КП его посадоч-

ного места (плюс – анод, минус – катод), что позволит определить качество 

монтажа компонента; 

– проверка резистора мультиметром в соответствующем режиме с под-

ключением щупов к печатным проводникам, подходящим к КП его посадоч-

ного места, что позволит определить как качество монтажа компонента, так и 

его номинал; 

– проверка монтажа перемычек мультиметром в режиме прозвонки це-

пей (см. прил. Д.1) с подключением щупов к печатным проводникам. 

Ж.2. Отсутствие свечения группы светодиодов 

Если не светятся все светодиоды, подключенные к одному из транзисто-

ров, то это может означать следующее: 

– данный транзистор постоянно закрыт с наиболее вероятной причиной 

в его плохом монтаже; 

– наличие проблемы в проводящем рисунке ПП (например, ошибка при 

подготовке траекторий перемещения фрезы, в результате которой на этапе 

изготовления ПП были перерезаны отдельные печатные проводники). 

Поиск дефекта (при отключенном питании): 
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– визуальный осмотр проводящего рисунка ПП; 

– визуальный осмотр соответствующих мест пайки; 

– контроль расположения транзистора на посадочном месте; 

– проверка наличия электрического контакта каждого вывода транзисто-

ра с соответствующим печатным проводником с помощью мультиметра в 

режиме прозвонки цепей. Щуп к выводу компонента следует подносить сбо-

ку, а не сверху, чтобы не прижимать вывод к КП, если между ними действи-

тельно нет соединения. 

Ж.3. Отсутствие мигания светодиодов 

Если все светодиоды светятся, но не мигают, то это означает, что оба 

транзистора в мультивибраторе открыты по причине плохого монтажа кон-

денсаторов. 

Поиск дефекта (при отключенном питании): 

– визуальный осмотр соответствующих мест пайки; 

– измерение емкости конденсатора мультиметром в соответствующем 

режиме с подключением щупов к печатным проводникам, подходящим к КП 

его посадочного места.  

Ж.4. Неправильное мигание светодиодов 

Неправильное мигание светодиодов (например, с частотами, отличаю-

щимися от ожидаемой) возможно по следующим причинам: 

– неправильные номиналы конденсаторов и резисторов в базовых цепях 

транзисторов; 

– работа мультивибратора с нагрузкой в виде светодиодов. 

Поиск и устранение проблемы (при отключенном питании): 

– измерение номиналов резисторов и конденсаторов мультиметром в со-

ответствующих режимах; 

– установка между коллектором каждого транзистора и питанием по од-

ному дополнительному резистору номиналом 5–10 кОм. 

Влияние светодиодов и дополнительных резисторов на работу мульти-

вибратора исследуется в прил. И.1 и кратко объясняется следующим обра-

зом. После закрытия одного из транзисторов через его нагрузку начинает за-

ряжаться подключенный к коллектору конденсатор, ток через который со 

временем уменьшается. Это способствует увеличению сопротивления 

нагрузки за счет светодиода (его сопротивление растет при уменьшении пря-

мого тока) и уменьшению скорости заряда конденсатора (растет постоянная 
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времени RC-цепи). В результате за время закрытого состояния транзистора 

конденсатор заряжается до меньшего напряжения, что приводит к уменьше-

нию времени последующего закрытого состояния второго транзистора (кон-

денсатор быстрее перезаряжается до напряжения его открытия) – см. рис. И.7 

и И.9. Дополнительный резистор позволяет с определенного момента остано-

вить рост постоянной времени RC-цепи, так как конденсатор начинает заря-

жаться в основном через него (см. рис. И.10). 

Комментарии к выбору номинала дополнительного резистора: 

– уменьшение номинала будет приводить к увеличению тока через него, 

что негативно скажется на времени работы изделия от элемента питания; 

– сильное снижение номинала может привести к выходу транзистора из 

режима насыщения (рост напряжения на коллекторе), что повлечет за собой 

уменьшение тока через светодиоды (уменьшение яркости) и сокращение 

времени закрытого состояния второго транзистора; 

– увеличение номинала будет постепенно приводить к росту верхней 

границы постоянной времени RC-цепи и сокращению времени закрытого со-

стояния второго транзистора (в пределе – как без данного резистора).  
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И. Дополнительные задания 

И.1. Моделирование мультивибратора 

Дополнительное задание № 1 выполняется перед этапом создания схемы 

Э3 (см. разд. 5) и заключается в моделировании схемы транзисторного муль-

тивибратора. 

Требования к содержанию отчета указаны в 4.3. 

Моделирование будет производиться в программе NI Multisim, главное 

окно которой показано на рис. И.1, в два этапа: 

– тренировка в виде получения ВАХ светодиода и построения зависимо-

сти для величины, задаваемой выражением; 

– исследование работы мультивибратора. 
Рис. И.1 

 
Рис. И.1 

Последовательность действий: 

1. Если после запуска программы новый файл схемы не был создан ав-

томатически (в панели Design Toolbox ничего нет), то создать новый файл. 

Для этого запустить команду File ⇒ New (или нажать на пиктограмму 

New в панели Design Toolbox), после чего в появившемся окне в разделе 

Blank and recent выбрать Blank и нажать Create. 

2. Сохранить файл командой File ⇒ Save as. 

3. При необходимости изменить вид отрисовки УГО компонентов, для 

чего выполнить команду Options ⇒ Global options ⇒ Components ⇒ Symbol 

standard ⇒ IEC 60617. 
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4. Обратить внимание на управление изображением в рабочем поле: 

– изменение масштаба – поворот колесика мышки; 

– перемещение листа – перемещение мышки с зажатым колесиком. 

5. Из окна выбора компонентов (команда Place ⇒ Component или комби-

нация клавиш Ctrl+W) поочередно добавить в рабочее поле (после выбора 

компонента нажимается кнопка OK или клавиша Enter) компоненты, необхо-

димые для моделирования ВАХ светодиода: 

– светодиод с любым использованным в изделии цветом свечения, кроме 

синего (например, красный: Group – Diodes, Family – LED, Component – 

LED_red). Если задействован только синие светодиоды или светодиода с 

нужным цветом нет, то выбрать любой цвет, кроме синего; 

– источник постоянного напряжения (Group – Sources, Family – POW-

ER_SOURCES, Component – DC_POWER); 

– земля (Group – Sources, Family – POWER_SOURCES, Component – 

GROUND). 

6. Обратить внимание на основные действия с выделенными компонен-

тами в рабочем поле: 

– перемещение – зажатая ЛКМ; 

– поворот – комбинация клавиш Ctrl+R; 

– отражение по горизонтали – Alt+X; 

– отражение по вертикали – Alt+Y; 

– свойства – двойной щелчок ЛКМ (или команда ПКМ ⇒ Properties). 

7. Соединить компоненты линиями электрической связи в соответствии 

с рис. И.2. Следует отметить, что в реальности подключать светодиод напря-

мую к источнику питания можно только в том случае, когда напряжение по-

следнего не превышает значения, при котором будет достигнут максималь-

ный прямой ток через компонент. Для получения ВАХ в данном случае вели-

чина напряжения источника значения не имеет. 
Рис. И.2 

 
Рис. И.2 

Провести линию электрической можно без специальной команды, но 

либо от свободного вывода компонента, либо от точки электрического кон-
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такта (Junction). Для этого необходимо подвести курсор мышки к выводу 

компонента (он изменит вид на точку с небольшим перекрестием), щелкнуть 

ЛКМ и проложить связь до следующего свободного вывода или до объекта 

Junction, при этом можно фиксировать уже созданные сегменты однократным 

нажатием ЛКМ. Создание линии взаимосвязи можно остановить двойным 

щелчком ЛКМ, тогда в этом месте будет создан объект Junction. 

Принудительный запуск создания линии электрической связи выполня-

ется командой Place ⇒ Wire (комбинация клавиш Ctrl+Shift+W). 

Объект Junction автоматически устанавливается на ответвлениях линий 

взаимосвязи (например, над УГО земли на рис. И.2). Принудительно его 

можно добавить командой Place ⇒ Junction (комбинация клавиш Ctrl+J). 

8. Добавить измеритель тока (пробник) в цепь анода светодиода. 

Для этого на панели Place probe нажать пиктограмму Current (вторая на 

рис. И.3), после чего разместить объект на соответствующей линии электри-

ческой связи. 
Рис. И.3 

 
Рис. И.3 

Убедиться, что стрелка пробника направлена к аноду светодиода, иначе 

изменить ее направление командой ПКМ ⇒ Reverse probe direction. 

9. Уменьшить количество отображаемой информации у пробников, оста-

вив только мгновенные значения. 

Для этого на панели Place probe нажать пиктограмму Probe settings (пер-

вая справа на рис. И.3). После этого в появившемся окне на вкладке Parame-

ters выбрать опцию Instantaneous only и нажать OK. 

10. Запустить анализ DC Sweep (изменение параметров источников пи-

тания и расчет режима по постоянному току в каждой точке). 

Для открытия окна с вариантами анализа схемы на панели Simulation 

нажать крайнюю правую кнопку (рис. И.4). Ее название соответствует наиме-

нованию текущего анализа схемы. 
Рис. И.4 

 
Рис. И.4 

В открывшемся окне выбрать DC Sweep и выполнить следующее: 

– на вкладке Analysis parameters в группе первого источника (Source 1) 

задать для компонента V1 изменение напряжения от 1,5 до 2,2 В с шагом 

0,01 В (десятичный разделитель – точка); 
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– на вкладке Output убедиться, что в столбце справа указан пробник тока 

с заданным позиционным обозначением; 

– нажать кнопку Run. 

11. Если окно с графиком было случайно закрыто, то открыть его ко-

мандой View ⇒ Grapher (или пиктограммой Grapher на панели Main), после 

чего настроить внешний вид графика: 

11.1. Изменить фон графика на белый – пиктограмма Black background 

(или команда Graph ⇒ Black and white colors). 

11.2. Включить отображение сетки – пиктограмма Show grid (или соот-

ветствующая команда из меню Graph). 

11.3. При необходимости поменять название вкладки с графиком и заго-

ловок (первая строка в поле с графиком), для чего дважды щелкнуть ЛКМ по 

вкладке или запустить команду Edit ⇒ Page properties. 

11.4. При необходимости отключить видимость блока (легенды) с обо-

значениями трасс (пиктограмма Show legend или соответствующая команда в 

меню Legend) или поменять его положение (опции меню Legend ⇒ Position). 

11.5. Изменить диапазон значений по вертикальной оси так, чтобы мак-

симальное значения тока составило 40 мА. Соответствующим образом под-

строить диапазон по горизонтальной оси. 

Данные настройки находятся в окне свойств графика (двойной щелчок 

ЛКМ по графику или команда Graph ⇒ Properties) на вкладках для горизон-

тальной и вертикальной оси (Left axis и Right axis соответственно) в группах 

Range. Кроме того, следует обратить внимание на количество делений (Total 

ticks в группе Divisions), интервал отображаемых значений у штрихов (Minor 

ticks в группе Divisions; например, число 2 означает, что на шкале будет под-

писано каждое второе значение) и количество знаков после запятой у отоб-

ражаемых значений (Precision в группе Divisions). 

11.6. При необходимости изменить другие свойства графика: 

– на вкладке General: название графика (Title), отображение легенды 

(Legend on в группе Traces), отображение маркеров для выделенной трассы 

(Show select marks в группе Traces; имеет смысл включать при нескольких 

трассах на одном графике); 

– на вкладке Traces для выбранного номера трассы в поле Trace ID: 

название в легенде (Trace label), цвет (Color), толщину трассы (поле Width в 

группе Show traces lines), принадлежность к стороне расположения горизон-

тальной или вертикальной оси (группы X-horizontal axis и Y-vertical axis со-
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ответственно; имеет смысл при наличии нескольких трасс на одном графике 

с разными величинами или порядками значений); 

– на вкладках Left axis, Bottom axis, Right axis и Top axis (левая, нижняя, 

правая и верхняя оси соответственно): подпись (Label), отображение (опция 

Enabled в группе Axis), тип шкалы (Scale: Linear – линейная, Logarithmic – 

логарифмическая и др.). 

11.7. Добавить на график «координаты» точки трассы на пересечении с 

первой вертикальной линией сетки: 

– включить отображение курсоров – пиктограмма Show cursors (или со-

ответствующая команда в меню Cursor); 

– на любом из курсоров выполнить команду ПКМ ⇒ Set X value; 

– в появившемся окне записать требуемое значение по горизонтальной 

оси и нажать OK; 

– на текущем курсоре выполнить команду ПКМ ⇒ Add data label at cur-

sor (или соответствующую команду из меню Cursor); 

– отключить отображение курсоров; 

– при необходимости изменить положение значений. 

Пример результата на данном этапе показан на рис. И.5. 
Рис. И.5 

 
Рис. И.5 

12. Добавить на вкладку с ВАХ светодиода график для величины, зада-

ваемой выражением. 

Для этого в окне Grapher View нажать пиктограмму Add trace(s) from lat-

est simulation result (или запустить соответствующую команду в меню Graph) 

и в появившемся окне: 

– в списке Variables дважды щелкнуть ЛКМ по переменной vv1 (напря-

жение источника с позиционным обозначением V1); 
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– в списке Functions дважды щелкнуть ЛКМ по оператору деления; 

– в списке Variables дважды щелкнуть ЛКМ по пробнику тока с задан-

ным позиционным обозначение; 

– выбрать группу To new graph (в новый график); 

– в поле Page name выбрать единственную вкладку; 

– в поле Graph name записать осмысленное название графика по состав-

ленному выражению; 

– нажать кнопку Calculate. 

13. У добавленного графика: 

– изменить диапазон значений по вертикальной оси так, чтобы макси-

мальное значение составило не более 100 000; 

– добавить единицы измерения в подписи к вертикальной оси; 

– добавить «координаты» точки трассы на пересечении с предпоследней 

вертикальной линией сетки. 

14. Привести в соответствие диапазоны значений по горизонтальным 

осям у двух графиков. 

15. Сохранить рисунок схемы. 

16. Сохранить результаты моделирования светодиода и дать краткие по-

яснения к каждому графику. 

17. Закрыть окно Grapher View и сохранить изменения в файле схемы. 

18. Добавить в рабочее поле (см. п. 5) по одному компоненту для созда-

ния схемы мультивибратора: 

– источник постоянного напряжения; 

– земля; 

– резистор любого номинала (Group – Basic, Family – RESISTOR); 

– конденсатор любого номинала (Group – Basic, Family – CAPACITOR); 

– использованный в изделии транзистор (Group – Transistors, Family – 

BJT_NPN). Если требуемого компонента нет, то выбрать BC848. 

19. Расставить и соединить компоненты в соответствии с любым из 

изображений, показанным на рис. 3.1, при этом: 

– последовательно с резисторами в коллекторных цепях транзисторов 

добавить светодиоды, для которых выполнялось моделирование ВАХ; 

– копирование и вставка компонентов осуществляется комбинациями 

клавиш Ctrl+C и Ctrl+V соответственно; 

– необходимо оставить место для установки на цепях пробников тока и 

напряжения, поэтому компоненты не следует размещать вплотную; 
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– действия с компонентами описаны в п. 6; 

– добавление линий электрической связи описано в п. 7; 

– диагональный участок линии взаимосвязи можно получить уже после 

ее создания, потянув за характерную точку в месте излома. 

20. Внести изменения в свойства компонентов на вкладках Value: 

– для источника питания – напряжение 3 В (параметр Voltage); 

– для конденсаторов и резисторов в базах транзисторов – выбранные 

номиналы (параметры Capacitance и Resistance соответственно); 

– для токоограничивающих резисторов в коллекторах транзисторов – 

выбранный номинал для светодиода с использованным в изделии цветом 

свечения. Если моделирование ВАХ выполнялось для другого светодиода, то 

записать номинал 2 кОм; 

– для светодиодов – ток включения 5 мкА («5u» в параметре On current). 

Номинал резистора в омах записывается обычным числом, а в килоо-

мах – с английской буквой «k». Номинал конденсатора в микрофарадах ука-

зывается с английской буквой «u». 

21. Добавить следующие пробники из панели Place probe (см. рис. И.3): 

– Voltage (напряжение; первая пиктограмма) – в цепи коллекторов и баз 

транзисторов; 

– Current (ток) – в цепи резистора и конденсатора, подключенных к базе 

правого транзистора (стрелки пробников направить в точку электрического 

контакта – см. п. 8). 

Пример результата на данном этапе показан на рис. И.6. 
Рис. И.6 

 
Рис. И.6 
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22. Запустить анализ Interactive Simulation (интерактивная симуляция 

работы схемы). 

Для этого открыть окно с вариантами анализа схемы (см. п. 10), выбрать 

Interactive Simulation и на вкладке Analysis parameters выполнить следующее: 

– для опции Initial conditions выбрать Set to zero (нулевые начальные 

условия); 

– включить опции Initial time step и Maximum time step и задать одинако-

вые значения 0.005 (начальный и максимальный шаги по времени соответ-

ственно – 5 мс); 

– нажать кнопку Run. 

23. Убедиться в работоспособности модели: светодиоды должны мигать, 

а значения у пробников меняться. 

Сохранить рисунок работающей схемы, после чего остановить симуля-

цию пиктограммой Stop на панели Simulation (рис. И.4). 

24. Замкнуть каждый светодиод, то есть соединить линией электриче-

ской связи цепи анода и катода, и сохранить рисунок схемы. 

Для этого удобнее сначала добавить объект Junction на одну из цепей 

(см. п. 7), а потом провести от него линию взаимосвязи до второй цепи. 

25. Выполнить анализ Transient (анализ переходных процессов) для 

напряжений и токов добавленных пробников: 

25.1. Открыть окно с вариантами анализа схемы (см. п. 10) и выбрать 

Transient. 

25.2. На вкладке Analysis parameters задать следующие настройки: 

– для опции Initial conditions выбрать Set to zero; 

– в поле Start time (время начала анализа) записать 3 (с этого времени 

уже должна быть устойчивая работа мультивибратора); 

– в поле End time (время окончания анализа) записать 6; 

– включить опции Initial time step и Maximum time step и задать одинако-

вые значения 0.005. 

25.3. На вкладке Output в правом списке оставить только два пробника 

напряжения для левого конденсатора (по рис. И.6 – PR2 и PR4), а остальные 

выбрать с зажатой клавишей Ctrl и перенести с помощью кнопки Remove в 

левый список. В появившемся окне можно включить опцию Do not show this 

dialog again (не показывать окно снова) и нажать OK. 

25.4. Нажать кнопку Run. 

25.5. Настроить внешний вид графика (см. п. 11) и сохранить результат. 
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Обязательным является белый фон, видимость сетки, диапазон значений 

по вертикальной оси от минус 3 до 3 В. 

Пример графика на данном этапе показан на рис. И.7. 
Рис. И.7 

 
Рис. И.7 

25.6. В настройках анализа Transient на вкладке Output в правом списке с 

помощью кнопок Add и Remove оставить только два пробника напряжения 

для правого конденсатора (по рис. И.6 – PR3 и PR5).  

После этого нажать кнопку Run. 

25.7. Настроить внешний вид графика и сохранить результат. 

Обязательные требования – по п. 25.5. 

25.8. В настройках анализа Transient на вкладке Output в правом списке 

оставить только два пробника тока (по рис. И.6 – PR6 и PR7).  

После этого нажать кнопку Run. 

25.9. Настроить внешний вид графика и сохранить результат. 

В отличие от требований п. 25.5 диапазон значений по вертикальной оси 

задать таким, чтобы были хорошо видны скачки тока через резистор в базе. 

Пример графика на данном этапе показан на рис. И.8. 

26. Проанализировать полученные результаты: 

– определить время открытого состояния каждого транзистора и период 

работы мультивибратора (данные сравнить с расчетными); 

– определить падение напряжения между коллектором и эмиттером лю-

бого транзистора в открытом состоянии (обратить внимание на то, что дан-

ное значение справедливо для относительно малого тока коллектора); 

– определить напряжение на базе любого транзистора в открытом состо-

янии; 
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Рис. И.8 

 
Рис. И.8 

– пояснить причину пологих передних фронтов у импульсов на коллек-

торах транзисторов; 

– пояснить причину появления отрицательных напряжений на базах 

транзисторов и то, что максимальные их значения (определить по графику) 

по модулю меньше напряжения питания; 

– пояснить процессы, приводящие к резким положительным скачкам то-

ка через конденсатор, которые сменяются практически нулевыми значениями 

и последующими отрицательными скачками; 

– пояснить причины скачков тока через резистор в базе транзистора и 

интервалы с практически постоянным его значением; 

– определить максимальное значение тока через резистор в базе транзи-

стора и подтвердить результат расчетом; 

– определить ток через базу правого транзистора перед его закрытием и 

подтвердить результат расчетом; 

– определить ток через базу правого транзистора в закрытом состоянии. 

При работе с текущим курсором для поиска значений удобно пользо-

ваться командами из его контекстного меню (или из меню Cursor), например: 

«Set X value» установит указанное значение по оси X, а «Go to next Y MAX 

=>» выполнит переход к следующему максимальному значению по оси Y 

вправо относительно текущего положения курсора.  

Перед использованием данных команд следует выбрать текущую трассу, 

что осуществляется щелчком ЛКМ по названию трассы в легенде (отмечает-

ся красным треугольником) или по самой трассе на графике (отмечается мар-

керами). 
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27. Если в окне Grapher View были добавлены лишние вкладки, то уда-

лить их можно следующим образом: 

– щелчком ЛКМ сделать требуемую вкладку активной; 

– еще раз щелкнуть ЛКМ по названию вкладки, чтобы красный маркер 

выбранного объекта появился в строке вкладок; 

– нажать клавишу Delete. 

28. Убрать замыкание левого светодиода и сохранить рисунок схемы. 

29. Повторить анализ Transient для напряжений и токов всех пробников 

по пп. 25.1, 25.3–25.9. 

Пример графика для пробников PR2 и PR4 с рис. И.6 на данном этапе 

показан на рис. И.9. 
Рис. И.9 

 
Рис. И.9 

30. Проанализировать полученные в п. 29 результаты: 

– определить время открытого состояния каждого транзистора и период 

работы мультивибратора (данные сравнить с полученными в п. 26); 

– пояснить увеличение длительности пологих передних фронтов у им-

пульсов на коллекторе первого транзистора; 

– пояснить причину уменьшения амплитуды импульсов на коллекторе 

первого транзистора; 

– пояснить причину отсутствия изменений в длительности импульсов на 

коллекторе первого транзистора. 

Для понимания произошедших изменений пригодятся результаты, полу-

ченные при моделировании светодиода. 

31. Подключить коллектор левого транзистора через резистор номина-

лом 10 кОм к питанию и сохранить рисунок схемы. 
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32. Повторить анализ Transient для напряжений и токов всех пробников 

по пп. 25.1, 25.3–25.9. 

Пример графика для пробников PR2 и PR4 с рис. И.6 на данном этапе 

показан на рис. И.10. 
Рис. И.10 

 
Рис. И.10 

33. Проанализировать полученные в п. 32 результаты: 

– определить время открытого состояния каждого транзистора и период 

работы мультивибратора (данные сравнить с полученными в пп. 26 и 30). 

– пояснить различие в форме импульсов на коллекторе первого транзи-

стора в сравнении с результатами п. 29 (см. рис. И.9). 

И.2. Библиотека компонентов 

Дополнительное задание № 2 выполняется перед началом создания схе-

мы Э3 (см. разд. 5) и состоит в дополнении библиотеки в виде базы данных 

необходимыми компонентами, найденными в разд. 4. 

Требования к содержанию отчета указаны в 5.3. 

Комментарии по выполнению задания: 

1. Для работы необходим Microsoft Access. Файл базы данных со ссыл-

ками между таблицами в Altium Designer отредактировать не получится. 

2. Описание библиотеки в виде базы данных содержится в [1, прил. Г.34, 

с. 836], однако все действия будут осуществляться только с таблицами в 

файле базы данных (см. [1, п. 3.1, с. 839]). 

3. Для добавления нового компонента в файле базы данных (расширение 

«.mdb») необходимо открыть соответствующую таблицу (например, «Рези-

сторы») и заполнить поля в последней строке по образцу записанных компо-
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нентов (каждая строка – один компонент). Для ускорения можно выделить 

строку с похожим компонентом (заготовкой), скопировать ее и вставить в 

конец таблицы, после чего отредактировать требуемые параметры. 

4. Особенности заполнения столбцов: 

– Number – порядковый номер. Заполняется автоматически, является 

ключевым полем (уникальный идентификатор компонента, так как Part Num-

ber у разных фирм может совпадать); 

– Add – разрешение (знак «+») отображения компонента в библиотеке; 

– PartNumber – обозначение (название) компонента, присвоенное произ-

водителем и отображаемое в списке компонентов в панели Libraries; 

– Library Ref – название УГО из библиотеки; 

– Library Path – название библиотеки с указанным УГО; 

– Footprint Ref – название посадочного места из библиотеки; 

– Footprint Path – название библиотеки с указанным посадочным местом. 

В таблицах с диодами, индуктивностями, конденсаторами, микросхемами, 

резисторами и транзисторами столбец отсутствует, так как он содержится в 

таблице «_Корпуса», с которой осуществляется связь по названиям посадоч-

ных мест (в таблицах для данных групп компонентов и в указанной таблице 

они должны полностью совпадать); 

– Footprint Ref 2, Footprint Path 2, Description, столбцы с префиксами 

«PI_» и «CI_» (package и component information) – см. [1, с. 841]; 

– Type из таблицы «_Корпуса» – пользовательский параметр с названи-

ями функциональных групп, в которых используется посадочное место. 

5. Для конденсаторов в таблице «_Корпуса» находится несколько вари-

антов посадочных мест для типоразмеров 0603 и 0805, отличающихся высо-

той корпуса (например, высота корпуса для 0805-C-085 – 0,85 мм).  

6. После сохранения базы данных необходимо в Altium Designer в пане-

ли Libraries в области со списком компонентов для любой активной библио-

теки выполнить команду ПКМ ⇒ Refresh All (см. [1, п. 7, с. 765]). 

И.3. Обозначение изделия 

Дополнительное задание № 3 выполняется в процессе этапа создания 

схемы Э3 и перечня ПЭ3 (см. разд. 5) и заключается в выборе классификаци-

онной характеристики изделия с последующим составлением его обозначе-

ния для записи в рамки разрабатываемых КД. 

Требования к содержанию отчета указаны в 5.3. 
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Комментарии по выполнению задания: 

– информация по обезличенному способу обозначения изделий и КД со-

держится в [1, разд. 2.3, с. 16]; 

– классификатор ЕСКД можно найти как онлайн в сети Интернет 

(например, [6]), так и в виде файла формата CHM. Возможный класс – 33; 

– код организации-разработчика – «АБВГ». Допускается использование 

собственного кода, но с обязательным пояснением; 

– порядковый регистрационный номер – последние три цифры номера 

студенческого билета. 

И.4. 3D-модель изделия 

Дополнительное задание № 4 выполняется после этапа создания файла 

трассировки ПП (см. разд. 6) и заключается в получении из Altium Designer 

3D-модели печатного узла для MCAD-программ и расчете массы. 

Требования к содержанию отчета указаны в 6.3. 

Последовательность действий: 

1. Выполнить пп. 6.7 и 6.8 из 6.1, если они не были выполнены ранее. 

2. Осуществить экспорт печатного узла в файл формата STEP в отдель-

ную папку командой File ⇒ Export ⇒ STEP 3D. 

В окне с настройками отключить опции Export Folded Board (относится к 

гибким ПП) и Export As Single Part (с отключенной опцией каждый компо-

нент, в том числе и ПП, в MCAD-программе будет представлен отдельной 

моделью) и включить опции Export All (все компоненты с 3D-моделями, 

группа Components With 3D Bodies), Export both (все 3D-модели, группа 3D 

Bodies Export Options), Export All (отверстия во всех КП, группа Pad Holes) и 

None (без суффиксов в именах компонентов, группа Component Suffix). 

3. Выполнить импорт STEP-файла в КОМПАС-3D, например его пере-

таскиванием в рабочее поле. 

4. В открывшейся модели выполнить следующее: 

– скрыть начало координат по [1, п. 13, с. 185]; 

– на детали Board выполнить команду ПКМ ⇒ Редактировать в окне; 

– в модели ПП скрыть начало координат, а в свойствах единственной 

операции задать темно-желтый цвет по аналогии с [1, рис. 6.24, с. 186]); 

– сохранить модель ПП и закрыть ее вкладку; 

– сохранить модель изделия. 

5. Сохранить два изображения модели: с верхней и нижней стороны ПП. 
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6. Рассчитать массу ПП с учетом следующего: 

– плотность стеклотекстолита – 1,9 г/см3 (обычно – 2 ±0,15 г/см3); 

– плотность меди – 8,9 г/см3; 

– плотность припоя (покрытие HASL) – 8,5 г/см3; 

– металлизация полностью покрывает верхний слой ПП; 

– так как у ПП сложный внешний контур, то для определения площади 

использовать команду Площадь из ПИ Компактная панель ⇒ Измерения и 

диагностика (3D) как на рис. И.11. Результат измерения сохранить. 
Рис. И.11 

 
Рис. И.11 

7. Рассчитать массу печатного узла с батарейкой и без: 

– в Altium Designer запустить команду Reports ⇒ Bill of Materials (можно 

как при активной схеме, так и при активном файле трассировки); 

– в появившемся окне выполнить группировку информации по парамет-

ру PI_Weight (найти его в столбце All Columns, включить ему отображение и 

перетащить в столбец Grouped Columns); 

– сохранить рисунок таблицы с компонентами из правой части окна; 

– выполнить суммирование результатов произведения столбцов Quantity 

и PI_Weight для каждой строки. 

Масса батарейки типоразмера 2032 – примерно 3,1 г. 

И.5. 3D-pdf изделия 

Дополнительное задание № 5 выполняется после этапа создания файла 

трассировки ПП (см. разд. 6) и заключается в создании 3D-pdf печатного узла 

сразу из Altium Designer (в отличие от ОЭП № 24 на [1, с. 611]). 
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Требования к содержанию отчета указаны в 6.3. 

Последовательность действий: 

1. Выполнить пп. 6.7 и 6.8 из 6.1, если они не были выполнены ранее. 

2. Для получения неподключенной металлизации (см. п. 7.7 из 6.1): 

2.1. Добавить на верхний слой ПП полигон Polygon Pour: 

– запустить команду Tools ⇒ Polygon Pours ⇒ Polygon Manager; 

– в открывшемся окне Polygon Pour Manager в группе View/Edit нажать 

кнопку Create New Polygon from с опцией Board Outline; 

– в появившемся окне Polygon Pour в поле Name записать имя полигона 

TopPoly, в списке Layer выбрать слой Top Layer, отключить опцию Remove 

Dead Copper, в списке Connect To Net выбрать цепь No Net, после чего при-

менить изменения; 

– в окне Polygon Pour Manager нажать кнопку Apply и в открывшемся 

окне подтвердить изменения; 

– убедиться в успешности создания полигона и нажать кнопку OK; 

– в свойствах полигона на вкладке Graphical отключить опции Remove 

Islands Less Than (sq. mms) In Area и Remove Necks When Copper Width Less 

Than (см. [1, рис. Г.72, с. 816]). 

2.2. Чтобы полигон подходил вплотную к отверстиям без металлизации, 

создать правило с высшим приоритетом (см. [1, примеч. к п. 5.15, с. 375]) и 

нулевыми зазорами между объектами «InPolygon» и «IsPadHoleValid And 

(PadIsPlated = 'False')» (рис. И.12). 
Рис. И.12 

 
Рис. И.12 

2.3. Обновить заполнение полигона (см. [1, п. 3.4, с. 818]). 
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3. Перейти в 3D-режим просмотра и при необходимости настроить цвета 

ядра и металлизации (клавиша L) в соответствии с цветами на рис. 1.1. 

В отличии от предлагаемого в [1, п. 15, с. 308] цветового профиля можно 

затемнить ядро (вкладка Custom в окне настройки цвета ядра).  

Пример для изделия с рис. 1.1 с отключенными слоями защитной паяль-

ной маски и шелкографии, а также с отключенным отображением начала ко-

ординат показан на рис. И.13. 
Рис. И.13 

 
Рис. И.13 

4. Осуществить экспорт печатного узла в 3D-pdf с отключенными слоя-

ми маски и шелкографии командой File ⇒ Export ⇒ PDF3D (см. [1, примеч. к 

рис. 24.18, с. 626]). 

5. Открыть созданный 3D-pdf в Adobe Reader или Adobe Acrobat Pro и 

сохранить три изображения модели: с верхней стороны ПП, с нижней сторо-

ны ПП с батарейкой и без батарейки. 

Описание работы в этих программах приведено в [1, разд. 24.3, с. 627]. 

6. В Altium Designer перейти в 2D-режим просмотра и скрыть созданный 

полигон (см. [1, п. 3.4, с. 818]).  

7. Сохранить изменения в файле ПП. 
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И.6. G-код 

Дополнительное задание № 6 выполняется после этапа получения про-

граммы для управления станком с ЧПУ (см. разд. 8) и заключается в коммен-

тировании каждой из первых 13 строк в любом созданном NC-файле. 

Требования к содержанию отчета указаны в 8.10. 

Описание команд можно найти в сети Интернет, например в [7] и [8]. 

При комментировании обратить внимание на точку в числовом значении 

параметра команды G04. 

И.7. Чертеж печатной платы 

Дополнительное задание № 7 выполняется перед этапом изготовления 

ПП (см. разд. 9) и заключается в разработке КД – чертежа ПП. 

Требования к содержанию отчета указаны в 8.10. 

Задание выполняется по [1, разд. 17.2, с. 474] следующим образом: 

1. Если было сделано дополнительное задание № 3, то по информации 

из прил. И.3 составить обозначение ПП, при этом: 

– класс классификационной характеристики ОПП – 68; 

– код организации-разработчика – как и код для всего изделия;  

– порядковый регистрационный номер – последние три цифры номера 

студенческого билета, записанными в обратном порядке. 

Если данное задание не выполнялось, то обозначение ПП составить по 

модифицированному объектно-ориентированному способу (см. п. 4 из 5.1). 

2. Убедиться, что КОМПАС-3D был настроен по [1, разд. 6.2, с. 170]. 

3. Открыть 3D-модель ПП (Board.m3d) из дополнительного задания № 4. 

Если оно не выполнялось, то проделать пп. 2–4 из прил. И.4. 

4. Добавить новую ориентацию 3D-модели на поверхность с проводя-

щим рисунком по [1, п. 2, с. 474]. 

5. Создать новый чертеж и задать настройки по [1, п. 3, с. 474]. 

6. Сохранить чертеж (Ctrl+S) и проверить это по [1, п. 12, с. 185]. 

7. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

и включено ее отображение по [1, пп. 4 и 5, с. 178]. 

8. Добавить в чертеж два вида по [1, п. 6, с. 475], но в масштабе 1:1. 

9. Присвоить добавленным видам названия по [1, п. 7, с. 475]. 

10. Заполнить графы рамки по [1, п. 8, с. 475], при этом: 

– обозначение ПП записать по п. 1; 

– графу «Лит.» оставить пустой; 
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– в графу «Масса» внести результат расчета по п. 6 из И.4. Если допол-

нительное задание № 4 не выполнялось, то графу оставить пустой; 

– название материала указать в соответствии с выбранным в разд. 4 

(например, стеклотекстолит фольгированный FR4-1,0-18/0); 

– в графе «Перв. примен.» – обозначение, выбранное в п. 4 из 5.1. 

11. Отключить синхронизацию данных в основной надписи по [1, п. 9, 

с. 477]. 

12. Разрушить оба вида (команда ПКМ ⇒ Разрушить вид на требуемых 

видах в Дереве чертежа) и удалить с главного вида все отверстия. 

После этого необходимо следить за тем, чтобы оба вида находились на 

одной горизонтали. Если требуется подвинуть один из видов, то это следует 

делать в режиме ортогонального черчения (постоянное включение – клавиша 

F8, временное включение – зажатая клавиша Shift во время перетаскивания). 

13. Закрыть 3D-модель изделия без сохранения изменений. 

14. Добавить только два габаритных размера ПП (ширина и длина) по [1, 

пп. 16 и 17, с. 479]. 

15. Сохранить чертеж по [1, п. 22, с. 483]. 

16. Нарисовать структуру ПП по [1, п. 23, с. 483], при этом: 

– изобразить только диэлектрическое основание и металлизацию со сто-

роны верхнего слоя; 

– толщины диэлектрика и металлизации были определены в п. 4.2 из 6.1; 

– на изображении обозначить только слой «Top Layer». 

17. Сохранить чертеж (Ctrl+S). 

18. Добавить ТТ по [1, п. 25, с. 486] в соответствии с шаблоном, приве-

денным на рис. И.14. 

Содержание отмеченных нижним подчеркиванием мест: 

– перед кодом Д33 – обозначение ПП без пробела; 

– перед «.PcbDoc» – название файла трассировки ПП; 

– ширина печатного проводника и расстояние между проводниками – 

значения из файла трассировки ПП (см. [1, п. 30.2, с. 495]). 

19. Добавить на первый лист таблицу с параметрами отверстий по [1, 

п. 29, с. 493], при этом обратив внимание на то, что в изготовленной ПП у 

всех отверстий будет отсутствовать металлизация. 

20. Добавить ссылку на номер таблицы в ТТ по [1, п. 31, с. 499]. 

21. Сохранить чертеж (Ctrl+S). 

22. Сохранить чертеж в формате PDF по [1, разд. 17.3, с. 499]. 
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Рис. И.14 

 
Рис. И.14 

23. Создать удостоверяющий лист для данных проектирования по [1, 

разд. 12.6, с. 410] с учетом информации по заполнению граф рамки из п. 10. 

Примеры КД для изделия с рис. 1.1 показаны на рис. К.2 и К.3. Другие 

примеры этих документов приведены на [1, с. 414, 497, 498]. 

И.8. Спецификация 

Дополнительное задание № 8 выполняется перед этапом монтажа ком-

понентов на ПП (см. разд. 10) и заключается в разработке КД – специфика-

ции на изделие. 

Требования к содержанию отчета указаны в 9.2. 

Задание выполняется по [1, разд. 18.2, с. 507] со следующими особенно-

стями: 

1 Плату изготовить методом фрезеровки проводящего рисунка по его 

контуру фрезой диаметром 0,5 мм без удаления оставшейся металлизации.  

2 Плата должна соответствовать требованиям ГОСТ 23752-79, группа 

жесткости 1. 

3 Данные для изготовления содержатся в ______Д33 (______.PcbDoc). 

Формат файла проектирования - Altium Designer. Назначение 

задействованных слоев: 

- M1 Board - контур платы; 

- Top Layer - проводящий рисунок на верхней стороне платы. 

4 Предельные отклонения размеров и позиционные допуски 

расположения элементов конструкции печатной платы должны отвечать 

третьему классу точности по ГОСТ Р 53429-2009.  

Минимальные значения параметров: 

- ширина печатного проводника - ___ мм; 

- расстояние между проводниками - ___ мм.  

Параметры отверстий приведены в таблице 1.  

5 Печатные проводники, переходные отверстия и контактные 

площадки не показаны. 

6 Обработка контура платы - по данным слоя M1 Board из данных 

проектирования с допусками ±IT13/2 по ГОСТ 30893.1. 

7 Шероховатость обрабатываемых поверхностей не контролировать. 

8 Покрытие проводящего рисунка - горячее лужение (HASL). 

9 Остальные технические требования по ОСТ4 ГО.070.014. 
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1. Отличия в заполнении граф рамки: 

– обозначение изделия – выбранное в п. 4 из 5.1; 

– наименование изделия – указанное в схеме Э3; 

– графу «Лит.» оставить пустой; 

– графу «Перв. примен.» оставить пустой или поставить прочерк (см. [1, 

рис. 22.3, с. 594]). 

2. Если дополнительное задание № 7 не выполнялось, то для ПП в раз-

делах «Документация» и «Детали» записать обозначение, составленное по 

модифицированному объектно-ориентированному способу (см. п. 4 из 5.1), а 

форматы документов – по [1, рис. 18.5, с. 511]. 

3. После раздела «Прочие изделия» добавить раздел «Материалы» с 

проволокой ММЛ 0,4 ТУ 16-505.850-75 для перемычек. Пример заполнения 

раздела показан на рис. И.15. 
Рис. И.15 

 

 
Рис. И.15 

Необходимую длину проволоки посчитать по файлу трассировки ПП с 

добавлением 10 % к общему результату. Длина каждой перемычки складыва-

ется из расстояния между отверстиями, в которые она устанавливается, дли-

ны ее концов над поверхностью печатной платы (не более 1,5 мм каждый) и 

удвоенной толщины ПП. 

Запись количества материалов – по [1, п. 1.17, с. 505]. 

Пример спецификации для изделия с рис. 1.1 показан на рис. К.5. Другие 

примеры этого документа приведены на [1, с. 511–513, 594, 595]. 

И.9. Сборочный чертеж 

Дополнительное задание № 9 выполняется перед этапом монтажа ком-

понентов на ПП (см. разд. 10) и заключается в разработке КД – сборочного 

чертежа изделия. 

Требования к содержанию отчета указаны в 9.2. 

Задание выполняется по [1, разд. 19.3, с. 527] следующим образом: 

1. Убедиться, что КОМПАС-3D был настроен по [1, разд. 6.2, с. 170]. 
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2. Открыть 3D-модель изделия из дополнительного задания № 4. Если 

оно не выполнялось, то проделать пп. 1–4 из прил. И.4. 

3. Добавить новую ориентацию 3D-модели на поверхность с проводя-

щим рисунком по [1, п. 2, с. 527]. 

4. Создать новый чертеж и задать настройки по [1, п. 3, с. 528]. 

5. Сохранить чертеж (Ctrl+S) и проверить это по [1, п. 12, с. 185]. 

6. Убедиться в том, что включены глобальные привязки, задан шаг сетки 

и включено ее отображение по [1, пп. 4 и 5, с. 178]. 

7. Добавить главный вид, для чего запустить команду Произвольный 

вид (см. [1, рис. 7.6, с. 206]) и указать путь к 3D-модели изделия. 

Затем в Панели свойств на вкладке Параметры выполнить следующее: 

– в поле Ориентация главного вида выбрать Главный; 

– в поле Масштаб вида выбрать масштаб 2:1. 

После этого щелчком ЛКМ разместить вид в левой части листа. 

8. Получить с главного вида вид снизу (вид на изделие сбоку): 

8.1. Запустить команду Стрелка взгляда (см. [1, п. 13.1, с. 547]) и раз-

местить вид в масштабе 1:1 в правом верхнем углу листа (стрелка взгляда 

будет расположена под изображением главного вида и направлена на него).  

Виду автоматически присвоится обозначение А. 

8.2. Так как масштаб вида А отличается от записанного в основной 

надписи, то добавить его обозначение к названию вида: 

– в Дереве чертежа выполнить команду ПКМ ⇒ Параметры вида; 

– в Панели свойств на вкладке Надпись вида включить опцию Мас-

штаб. 

8.3. На виде А скрыть элемент питания: 

– в Дереве чертежа раскрыть группу с батарейным отсеком (найти по 

позиционному обозначению со схемы Э3); 

– на детали CR2032 выполнить команду ПКМ ⇒ Скрыть. 

9. Через Менеджер документа по [1, разд. 7.1, с. 203] добавить второй 

лист: вертикальный А4 с оформлением Чертеж констр. Посл. листы. 

ГОСТ 2.104-2006. 

10. Получить с вида А вид сзади: 

10.1. Запустить команду Стрелка взгляда (см. [1, п. 13.1, с. 547]) и раз-

местить вид в масштабе 1:1 на втором листе (стрелка взгляда будет располо-

жена под изображением вида А и направлена на него).  

Виду автоматически присвоится обозначение Б. 
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10.2. На виде Б добавить обозначение масштаба (см. п. 8.2).  

10.3. На виде Б скрыть элемент питания (см. п. 8.3). 

11. Сохранить чертеж (Ctrl+S). 

12. Получить с вида Б выносной элемент и отметить на нем перемычки: 

12.1. С помощью команды Выносной элемент из ПИ Компактная па-

нель ⇒ Обозначения разместить под видом Б изображение области изделия 

с перемычками (форма области – любая из доступных; масштаб – 2:1). 

Последовательность работы с командой описана в [1, п. 23.2, с. 483]. 

12.2. Разрушить выносной элемент (см. п. 12 из И.7). 

12.3. В выносном элементе удалить все отверстия и контуры батарейно-

го отсека и переключателя (при наличии). 

12.4. Добавить отверстия:  

– открыть FRW-файл, созданный в 7.1; 

– выделить все объекты в файле и отзеркалить их относительно горизон-

тальной оси командой Симметрия из ПИ Компактная панель ⇒ Редакти-

рование (см. [1, рис. 6.20, с. 183]) с выбранным в Панели свойств режимом 

Удалять исходные объекты; 

– выполнить команду Выделить ⇒ Слой ⇒ Выбором; 

– в появившемся окне выбрать слой Holes и нажать OK; 

– скопировать выделенные объекты относительно начала координат; 

– вставить объекты из буфера в выносной элемент; 

– открыть FRW-файл без сохранения изменений. 

12.5. Отрезками со стилем линии Утолщенная соединить центры отвер-

стий, между которыми будут установлены перемычки. 

12.6. Добавить номер позиции перемычки по [1, п. 20, с. 534], изменив 

окончание линии-выноски с точки на стрелку. 

12.7. Командой Ввод текста из ПИ Компактная панель ⇒ Обозначе-

ния (см. [1, рис. 6.41, с. 194]) добавить надпись «Батарейный отсек _ не пока-

зан» с размещением По центру, при этом: 

– надпись должна быть расположена между обозначением выносного 

элемента и изображение; 

– вместо нижнего подчеркивания необходимо добавить ссылку на пози-

цию перемычек из спецификации; 

– при наличии переключателя скорректировать текст. 

Результат на данном этапе для изделия с рис. 1.1 показан на рис. И.16. 

13. Заполнить графы рамки по [1, п. 8, с. 528], при этом: 
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Рис. И.16 

 
Рис. И.16 

– обозначение изделия в основной надписи и в графе «Перв. примен.» – 

выбранное в п. 4 из 5.1; 

– наименование изделия – указанное в схеме Э3; 

– графу «Лит.» оставить пустой; 

– в графу «Масса» внести результат расчета массы изделия по п. 7 из И.4 

без учета батарейки. Если дополнительное задание № 4 не выполнялось, то 

графу оставить пустой. 

14. Отключить синхронизацию данных в основной надписи по [1, п. 9, 

с. 530]. 

15. Сохранить чертеж (Ctrl+S). 

16. Разрушить главный вид (см. п. 12 из И.7). 

В результате виды А и Б также будут автоматически разрушены. 

17. Закрыть 3D-модель изделия без сохранения изменений. 

18. На главном виде: 

18.1. Удалить все графические элементы, кроме контура ПП и крепеж-

ных отверстий, если такие есть. 

18.2. Обозначить центры крепежных отверстий по [1, п. 13, с. 530] (при 

наличии). 

18.3. Добавить контуры компонентов и их позиционные обозначения: 

– экспортировать информацию слоев M1 Board и M3 Top Assy из файла 

трассировки ПП в формат DXF по [1, п. 14, с. 530]; 

– открыть DXF-файл в КОМПАС-3D; 
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– изменить свойства надписей по [1, п. 14.8, с. 532]; 

– изменить свойства заливок по [1, п. 14.10, с. 532]; 

– обратить внимание на цвет контура ПП; 

– выделить все объекты (Ctrl+A); 

– выполнить команду Выделить ⇒ Исключить ⇒ По стилю кривой; 

– в появившемся окне выбрать стиль кривой контура ПП и нажать OK; 

– скопировать выделенные объекты (Ctrl+C), указав базовую точку в 

любой вершине контура ПП; 

– вставить скопированные объекты (Ctrl+V) относительно такой же ба-

зовой точки на главный вид сборочного чертежа; 

– выделить объекты главного вида и задать стиль линии Основная; 

– отключить опцию Прерывать штриховки и линии в меню Сервис ⇒ 

Параметры ⇒ Текущий чертеж ⇒ Перекрывающиеся объекты; 

– расставить позиционные обозначения компонентов. 

Комментарии по размещению: 

– позиционные обозначения могут располагаться как в очертаниях кон-

туров компонентов, так и около них (предпочтительно сверху или справа); 

– перемещение надписи осуществляется зажатой ЛКМ за среднюю ха-

рактерную точку, появляющуюся после ее выбора; 

– при необходимости можно временно отключить привязки; 

– при нехватке места для размещения отдельных надписей можно ис-

пользовать линию-выноску; 

– при острой нехватке места можно использовать выносные элементы 

для отдельных областей с большим масштабом или уменьшить размер шриф-

та всех надписей. 

18.4. Добавить номер позиции ПП по [1, п. 20, с. 534]. 

19. Сохранить чертеж (Ctrl+S). 

20. Добавить ТТ по [1, п. 25, с. 486] в соответствии с шаблоном, приве-

денным на рис. И.17. 

Комментарии к шаблону: 

– на чертеже все размеры будут справочными, поэтому звездочку ста-

вить ни в первом пункте ТТ, ни у размерных чисел не нужно [1, п. 2, с. 946]. 

– вместо нижних подчеркиваний необходимо вставить ссылки на соот-

ветствующие позиции на чертеже (команда ПКМ ⇒ Вставить ссылку с 

настройками Обозначение позиции и Только номер позиции); 

– при наличии переключателя скорректировать седьмой пункт. 
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Рис. И.17 

 
Рис. И.17 

21. На виде А: 

21.1. Упростить изображение по [1, п. 21, с. 535]. 

Зазор между батарейным отсеком и ПП можно удалить, продлив конту-

ры отсека до нижней поверхности ПП. 

21.2. Под обозначением вида разместить надпись «Перемычки поз. _ не 

показаны» со ссылкой на соответствующую позицию вместо нижнего под-

черкивания. 

21.3. Добавить размер с высотой изделия – см. [1, пп. 16 и 17, с. 479]. 

22. На виде Б: 

22.1. Удалить все отверстия, кроме крепежных. 

22.2. Обозначить центры крепежных отверстий по [1, п. 13, с. 530] (при 

наличии). 

22.3. Упростить контуры батарейного отсека и переключателя (при 

наличии). 

1 Размеры для справок. 

2 Паять ПОС 61 ГОСТ 21930-76 (или аналог). 

3 Позиционные обозначения элементов показаны условно и 

маркировке не подлежат. 

4 Закрашенными областями условно отмечены катоды светодиодов. 

5 Компоненты для поверхностного монтажа устанавливать 

симметрично группам контактных площадок, при этом каждый вывод 

должен оказаться на соответствующей контактной площадке посадочного 

места без перекоса. 

6 Перемычки поз. _ устанавливать с нижней стороны печатной платы 

поз. _ вплотную к ее поверхности, паять с верхней ее стороны в двух 

точках, длина выступающих концов - не более 1,5 мм. Общую длину 

каждой перемычки определять по месту установки. 

7 Батарейный отсек установить с нижней стороны печатной платы 

поз. _ до упора в предназначенную для этого группу контактных площадок 

после монтажа всех остальных компонентов и перемычек. Паять выводы с 

верхней стороны печатной платы. 

8 Количество точек пайки должно совпадать с количеством контактов 

компонентов и концов перемычек. 

9 Остальные технические требования по ОСТ4 Г0.070.015. 
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22.4. Добавить позиционные обозначения батарейного отсека и пере-

ключателя (при наличии). 

23. На любом из подходящих видов добавить два габаритных размера 

изделия – ширину и длину. 

24. Если место на первом листе позволяет разместить все изображения, 

то переместить вид Б и выносной элемент со второго листа, а последний уда-

лить через Менеджер документа. 

25. Сохранить чертеж (Ctrl+S). 

26. Сохранить чертеж в формате PDF по [1, разд. 17.3, с. 499]. 

27. Проверить формат чертежа, записанный в спецификации по допол-

нительному заданию № 8 (см. прил. И.8), и при необходимости скорректиро-

вать его с повторным сохранением основного КД в формате PDF. 

Пример сборочного чертежа для изделия с рис. 1.1 показан на рис. К.4. 

Другие примеры этого документа приведены на [1, с. 540, 541, 609]. 
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К. Примеры КД 

В данном приложении приведены примеры КД для изделия с рис. 1.1:  

1. Схема Э3 (рис. К.1) – результат этапа № 5 (см. 5.1).  

В схеме все поместилось на один лист формата А4, поэтому был изме-

нен шаблон на A4-1-ИДРЭС-AD.SchDot с выбором в окне Update Template 

опции Add new parameters that exist in the template only (добавить отсутству-

ющие в заменяемой рамке параметры). 

Также у компонентов была отключена видимость атрибута Comment: 

– запускается команда ПКМ ⇒ Find Similar Objects на любом из компо-

нентов (подробнее о команде – см. [1, прил. Г.6, с. 755]); 

– в появившемся окне для опций Object Kind и Show Designator выбира-

ется настройка Same и нажимается OK; 

– в панели SCH Inspector нажимается ссылка Part Comment; 

– после перехода в группу редактирования параметров данного атрибута 

ставится галочка у опции Hide. 

Однако оставление у компонентов только позиционных обозначений во 

многих случаях не приветствуется из-за усложнения работы со схемой. 
Рис. К.1 

 
Рис. К.1 
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Рис. К.2 

 
Рис. К.2 
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Рис. К.3 

 
Рис. К.3 
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Рис. К.4 

 
Рис. К.4 
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Рис. К.5 

 
Рис. К.5 
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2. Перечень ПЭ3 (рис. К.2) – результат этапа № 5 (см. 5.2). 

3. Удостоверяющий лист для данных проектирования (рис. К.2) – ре-

зультат дополнительного задания № 7 (см. прил. И.7). 

4. Чертеж ПП (рис. К.3) – результат дополнительного задания № 7 (см. 

прил. И.7). 

5. Сборочный чертеж (рис. К.4) – результат дополнительного задания 

№ 9 (см. прил. И.9). 

6. Спецификация (рис. К.5) – результат дополнительного задания № 8 

(см. прил. И.8). 

Обозначения в КД записаны по обезличенному способу, но с указанием 

в классификационных характеристиках только номеров классов. Остальные 

части скрыты символом «Х», чтобы не раскрывать ответы на дополнитель-

ные задания № 3 и 7 (прил. И.3 и И.7 соответственно). 



138 

Л. Примеры работ 

В данном приложении приведены примеры работ, выполненных студен-

тами группы 0114 (факультет РТ, кафедра РЭС): 

1. Изделие «Елка». Автор – Колобов А. А. 

Использованы красные и синие светодиоды типоразмера 0603, мигаю-

щие с небольшой частотой двумя группами в виде отдельных частей гирлян-

ды: сначала – четные, а затем – нечетные (рис. Л.1). На поверхность ПП до-

бавлен элемент декора в виде объемной текстуры, сделанной припоем. 
 Рис. Л.1 Рис. Л.2 

   
 Рис. Л.1 Рис. Л.2 

2. Изделие «Кунай». Автор – Женарь А. В. 

Использованы красные и синие светодиоды типоразмеров 0603 и 0805. В 

первой фазе светятся дальние красные и ближние синие светодиоды (относи-

тельно центра), а во второй – дальние синие и ближние красные (рис. Л.2). 

На одном из длинных лучей предусмотрено отверстие для крепления. 

3. Изделие «Мини-светильник “Солнце”». Автор – Мартынова А. С. 

Использованы желтые светодиоды типоразмеров 0603 и 0805, при этом 

мигают попарно только средние 4, а все остальные светятся постоянно (рис. 

Л.3). В топологию добавлены элементы декора в виде печатных проводни-

ков. Контур ПП получен обрисовкой изображения из сети Интернет. 

4. Изделие «Снежинка». Автор – Залогин Д. Б. 

Использованы белые и синие светодиоды типоразмера 0603. Первые 

светятся постоянно, а вторые с достаточно высокой частотой мигают, созда-

вая эффект искрения: в первой фазе – дальние (относительно центра), а во 

второй – ближние (рис. Л.4). 
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 Рис. Л.3 Рис. Л.4 

   
 Рис. Л.3 Рис. Л.4 

5. Изделие «Волк». Автор – Балабинский А. М. 

Использованы светодиоды типоразмера 0805, при этом мигают только 

синие двумя группами по 4 шт. (расположены по периметру справа и снизу), 

а красные и желтый светятся постоянно (рис. Л.5). В топологию добавлены 

элементы декора в виде печатных проводников. 
 Рис. Л.5 Рис. Л.6 

   
 Рис. Л.5 Рис. Л.6 

6. Изделие «Светильник декоративный Ктулху». Автор – Денисов М. А. 

Использованы оранжевые, синие, красные и фиолетовые светодиоды ти-

поразмеров 0603 и 0805. Первые светятся постоянно, а остальные собраны в 
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группы по цвету и подключены к выходам трехсекционного мультивибрато-

ра, в результате чего создается эффект бегущей тени (рис. Л.6). 

7. Изделие «Игрушка елочная». Автор – Перевертайлов А. О. 

Использованы белые светодиоды типоразмера 0805, которые с неболь-

шой частотой мигают группами: в первой фазе – на длинных лучах, а во вто-

рой – на коротких (рис. Л.7). В изделие добавлены элементы декора в виде 

фигурных отверстий. 
 Рис. Л.7 Рис. Л.8 

   
 Рис. Л.7 Рис. Л.8 

8. Изделие «Игрушка новогодняя». Автор – Сметанин А. С. 

Использованы синие светодиоды типоразмера 0805, при этом ближай-

шие к центру светятся постоянно, а внешние с небольшой частотой мигают 

через одного (рис. Л.8). На одном из лучей предусмотрено отверстие для 

крепления. 
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